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Abstract
This guide is intended to assist SEs/CSEs and PSEs/PSCs in migrating data using a fivephase data migration process designed to handle the most complex migration scenarios while
heeding specific customer needs and making sure the right migration strategy is executed for
each specific environment.
The document describes the steps necessary for a successful SAN data migration from EMC
®
®
®
CX700 storage on Windows , Linux , and Solaris hosts to NetApp storage.
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1 Introduction
The Data Migration program was established to create data migration solutions that make it easier for
customers to migrate to NetApp storage. The program enhances productivity by providing necessary
tools, products, and service collateral required for successful data migration. By providing the proper skills
and knowledge to perform heterogeneous data migrations, this program aims to accelerate the adoption
of NetApp technologies by enterprise customers. This program also enables selling NetApp products to
third-party accounts. The goal of this program is to drive the product and services revenue and help
increase NetApp SAN and NAS market share.

1.1

Audience

This document is for customers of the NetApp heterogeneous storage area network (HeSAN) Migration
Service and NetApp sales engineers (SEs), consulting sales engineers (CSEs), Professional Services
engineers (PSEs), Professional Services consultants (PSCs), and channel partner engineers.

1.2

Data Migration Defined

Data migration is process of transferring data from a third-party source to a NetApp destination. The data
is copied during the migration; at the time of the migration cutover, the existing systems are redirected to
the new data location in the NetApp storage. The migration cutover is a managed event designed to
minimize the disruption to applications during the reconfiguration process.

Data Migration Challenges
Some of the challenges posed by data migration are extended downtime, potential risk, scarce resources,
and inadequate expertise. Data availability requirements have become increasingly demanding and
downtime unacceptable, such that business operations drive the data migration process. Risk factors
such as performance impacts on production systems, potential data corruption, or loss are a constant
concern in any data migration process. In-house resources have day-to-day responsibilities and cannot
cater to data migration demands. With challenges such as these, it is no surprise data migration gives IT
reasons to pause.

Data Migration Solution
NetApp Professional Services uses a time-tested methodology to guide a migration through all major
phases. State-of-the-art technologies such as NetApp DTA2800 and third-party data migration software
along with proficiency in data migration allow NetApp Professional Services to execute data migrations
projects successfully worldwide. By utilizing NetApp Professional Services, customers free up internal
resources, minimize downtime, and abate risk.

1.3

NetApp Data Migration Service

The Data Migration Service for heterogeneous SAN environments was created to provide NetApp
Professional Services with comprehensive migration solutions. The goal is to provide tools, products,
software, and services to reduce error, increase productivity, and promote consist delivery of data
migrations.

Methodology
The data migration process consists of five phases:


Discover. Information about hosts, storage, and fabrics in the environment is collected.



Analyze. Collected data is examined, and the appropriate migration approach for each host or
storage array is determined.
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Plan. Migration plans are created, destination storage is provisioned, and migration tools are
configured.



Execute. Data is migrated, and host remediation is assisted.



Verify. New system configurations are validated, and documentation is provided.

1.4

NetApp Data Migration Service Tools

This section provides an overview of the service tools and peripheral collateral required for data
migration. These tools provide a standardized method for scoping and documenting a data migration
engagement.

Level of Effort (LoE) Generator
®

The Level of Effort generator (LoE) is a Microsoft Excel-based effort estimation tool. The LoE generator
estimates the amount of consulting hours required to deliver a migration. The estimates are broken down
into the five phases of a typical migration and provide guidance on tasks that are typically performed after
normal business hours. The LoE tool provides common tasks and time estimates that should be edited at
the user‘s discretion.
Note:

The LoE tool should be used as a guideline.

The LoE generator can be downloaded from https://tech.netapp.com/migration.
Support Note
Project management effort and license costs associated with the migration engagement are not
included in the estimate.

HeSAN Migration Site Survey and Plan
The Site Survey and Plan (SS&P) is an Excel-based repository for data migration project information. The
SS&P includes a questionnaire and system configuration worksheet. The worksheet provides a single
collection point for data migration project information. This Site Survey and Plan.xls is used extensively in
the methodology covered in this document.
The SAN migration site surveys and plans can be downloaded from https://tech.netapp.com/migration.

1.5

NetApp Data Migration Tool Chest

The tools listed in this section are used at different phases of the migration process. A comprehensive set
of discovery and analysis tools provides an efficient means to collect information about the customer‘s
environment.

nSANity Data Collector
nSANity Data Collector is NetApp‘s primary tool to collect configuration information from hosts, storage,
and fabric devices. nSANity is designed to perform remote data collection utilizing a variety of network
®
protocols and native authentication mechanisms. nSANity binaries are available for Windows, Mac OS
X, and Linux platforms. Mac OS X and Linux versions of nSANity cannot collect data from Windows
hosts. Windows version of nSANity can communicate with all component types without exception.
nSANity generates gzip‘d XML files that contain the output of commands run against local or remote
components (hosts, switches, NetApp storage).
nSANity can be downloaded from http://support.netapp.com/NOW/download/tools/nsanity/.

10

DTA Migrations Using NetApp DTA2800 Methodology

nSANity Best Practice
Only Windows systems can collect data from other Windows hosts.

NetApp Data Center Planner (NDCP)
NetApp Data Center Planner provides a simple mechanism to extract configuration information from
several data collection formats. The primary NDCP inputs used for data migration purposes are nSANity
and EMC SP Collect output files. NDCP provides an easy way to determine host configuration information
such as HBAs, LUNs, and file systems as well as in-depth information about storage and fabrics.
NetApp Data Center Planner can be downloaded from
http://support.netapp.com/NOW/download/tools/ndcp/.

Solaris Relabeler
Solaris Relabeler is a command line utility that provides the ability to update the ―ASCII label‖ on VTOC
disks postmigration. During the initial VTOC disk initialization routines, the Solaris format command
performs a SCSI inquiry against the disk and writes vendor-specific information (manufacturer, product,
and revision) to the disk label. All further inquiries are directed to the disk label and not to the actual
device. Block-level migration copies this disk label to the new disk and old SCSI inquiry data is still visible
in system tools and logs. The relabeler updates disks postmigration with new inquiry data.
The Solaris Relabeler utility can be downloaded from
http://support.netapp.com/NOW/download/tools/solaris_relabeler/.

Space Reclamation Utility (SRU)
DTA2800 supports space reclamation during migration. This functionality provides the ability to migrate
from a thick-provisioned environment to a thin-provisioned environment (logical presented space exceeds
physical capacity). SRU allows the user to regain free file system space and to prepare a thickprovisioned LUN to migrate into a thin-provisioned LUN. (Free space refers to the free data blocks
present in the file system that might contain stale data.) This utility is intended to be used before migration
of a LUN to a thin-provisioned destination and while the file system is not under heavy load. A platformspecific binary is provided for all supported platforms.
Space Reclamation Binaries can be downloaded from http://support.netapp.com/NOW/cgibin/software?product=Data+Migration+Appliance+DTA2800&platform=Space+Reclamation+Utilities.

NetApp DTA Manager
NetApp DTA Manager provides a GUI to manage DTA2800. Multiple DTA systems can be managed from
a single instance of the application. DTA Manager is available for Windows, Linux, and Mac OS.
DTA Manager software can be downloaded from http://support.netapp.com/NOW/cgibin/software?product=Data+Migration+Appliance+DTA2800&platform=DTA+Manager.

NetApp DTA Remote CLI (RCLI)
NetApp DTA Remote CLI (RCLI) enables you to perform a variety of DTA management tasks through a
management workstation.
All commands supported by Remote CLI accept all required inputs from the same command line that runs
the program. This ability allows you to use any scripting language that can run a command line, including
Microsoft batch files, Linux shell scripts, and higher-level scripting languages such as Perl or Python.
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DTA Remote CLI software can be downloaded from
http://support.netapp.com/NOW/download/software/dta_remotecli/3.3.2/.

2 NetApp DTA2800 Overview
NetApp DTA2800 is a purpose-built data migration appliance. Its high-availability feature set and fast
performance provide an easy method to deliver block-level data migrations. All DTA migrations operate at
the LUN level. File, record, NFS, and CIFS-based migrations are not supported.
DTA Basics


Fibre Channel and iSCSI only



All migrations are at the LUN level

2.1

Hardware Overview

The DTA2800 chassis includes two hot-swappable blades and two hot-swappable power supply units
(PSUs). Each base blade contains two 8Gb FC ports and two 1Gb iSCSI ports with an additional two 8Gb
FC ports provided by an add-on card in each blade, as shown in Figure 1.
Figure 1) DTA2800 front view.

DTA Hardware Notes


Remote migrations are currently not supported.



Each blade is equipped with four 8Gb FC ports.

2.2

Features

DTA2800 provides the following features and functionality:


Multiple blades, each of which supports the running of multiple jobs in parallel.



Operating system independence. Block-level data migration does not rely on volume managers or OS
utilities.



Fibre Channel fabric independence. Fully compatible with Brocade, Cisco , McData, and NetApp FC
fabrics.



Supports most Fibre Channel storage arrays. The support matrix is available at
http://support.netapp.com/NOW/products/interoperability/.



GUI/CLI/RCLI-based remote management.



Simple drag-and-drop interfaces for job configuration.



Source array bandwidth throttling.



Native multipath and load-balancing support.



Data migration job failover and failback.



Supports NetApp clustered Data ONTAP migrations.

12

®

®

DTA Migrations Using NetApp DTA2800 Methodology



Supports NetApp E-Series.

2.3

Licensing

Licenses are generated against either the chassis serial number or either of the DTA blades. All licenses
are consumable (shared) by both blades.
Licensing Notes


A data migration license is required for any job 5GB or larger.



Licenses are shared between the blades.



Time-based licenses cannot be shared between DTAs using License Server.

Capacity-Based Licenses (per TB)
Capacity (per-TB) licenses operate like a fuel tank. Additional capacity licenses can be compared to
adding fuel to a vehicle. Like how fuel addition enables the vehicle to travel longer distances, additional
capacity licenses increase the licensed capacity.
The DTA maintains a counter of the total licensed capacity. Performing migrations reduces licensed
capacity by the size of the migration job.
Capacity licenses have the following attributes:


Capacity (per-TB) licenses are available in 1TB–100TB capacities.



Each time a data migration job is configured, the available capacity is reduced by an amount equal to
the size of the source LUN being migrated. Incomplete, failed, and/or stop/removed migration jobs do
not consume licenses. Licenses are consumed when the migration job is in ―Complete‖ status.



DTA2800 does not allow configuration of jobs in excess of the available capacity.



Capacity-based migration license usage is tracked in GB of data migrated.



DTA maintains the license capacity counter at the chassis level. Replacing blades does not affect
licensing.



Both blades can consume licenses simultaneously from the chassis-level counter.



Licenses never expire.
Support Note
The migration job cannot be configured or scheduled if there are insufficient capacity licenses.

Array-Based (Unlimited) Licenses (UAB)
Array-based licenses allow the migration of unlimited amounts of data to and from a licensed array. Arraybased licenses are typically used to migrate large amounts of data to a single destination array or to
consolidate multiple-source arrays to a single destination array.
Support Note
All array controller ports are initially identified as targets by the DTA2800. After a single-data LUN is
detected on the target, DTA creates an entity called an array.
A specific LUN seen through multiple Fibre Channel target ports or IQN targets is grouped under a
single array.
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Array-based licenses have the following attributes:


Array-based licenses are locked to specific discovered target ports for an array entity. If a LUN is
presented using addition target ports, as long as that LUN is also presented through a licensed port,
the additional ports are automatically licensed.



A maximum of 8 target ports can be licensed under one specific array.



Each single-array license is tied to a specific array.



The licensed array may be used as either a source or a destination array.



Capacity-based licenses are not consumed for a given job if either the source or the destination array
has an array-based license applied.



Both blades can use the same array-based license simultaneously.



Licenses do not expire.

Time-Based Licenses (TBL)
Time-based licenses allow unlimited migrations from an unlimited number of arrays for a fixed amount of
time on a single DTA2800.
Time-based licenses maintain and manage counters including expiration date, total duration of issued
TBL, and the duration remaining.
Support Note
Data migration TBL availability is checked when a migration job is configured. After a migration job is
validated and configured, a migration can be completed successfully even though the DM TBL duration
is expired. Data migration jobs that are already configured before applying DM TBL will not be affected
after applying a DM TBL. The data migration job will use the same license that was used at the time
the migration job was configured.
Time-based licenses have the following attributes:


Time-based licenses expire after the period for which the license was issued expires.



You can extend the time duration for availability of feature by adding another TBL key for that feature.



TBL licenses are valid for one year but can be extended in 3-month or 6-month increments.



Data migration jobs will no longer consume any capacity-based licenses after a data migration TBL is
available.

Clustered Data ONTAP Licenses (CDOL)
Clustered Data ONTAP licenses provide additional flexibility for migrations to clustered Data ONTAP
systems. UAB licenses are not available for use with clustered Data ONTAP. If used, migration will be
enabled to only a single Vserver. Clustered Data ONTAP licenses provide up 250TB of migration to an
unlimited number of Vservers, although only 16 Vservers can be associated with each cluster at any
given time. This license is applied to a clustered Data ONTAP array object in the DTA and enables the
user to associate the cluster‘s Vservers (detected as arrays on the DTA) to the license.
Support Note
This key is only for use with NetApp storage systems running clustered Data ONTAP. This license is
consumed as data is migrated to or from the clustered Data ONTAP array. The clustered Data ONTAP
license is not World Wide Port Name (WWPN) bound, but it is based on the serial number of the
management node of the cluster.
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Clustered Data ONTAP licenses have the following attributes:


On applying a license to a clustered Data ONTAP array object, 250TB is added to the Data Migration
capacity of that array.



If the same-clustered Data ONTAP array object (having same cluster serial number) was already
licensed and an additional CDOL (250TB) will be added to the array object, the Data Migration
feature counter of the clustered Data ONTAP array will increase by 250TB.



Up to four clusters can be licensed at the same time.



CDOL support clusters with an unlimited number of Vservers but only 16 can be associated with each
cluster at any given time.



If the Vserver (array) is not associated with a clustered Data ONTAP array object it will continue to
work as a normal array and the jobs configured on that array will consume the normal capacity
licenses.
Support Note
To associate a Vserver/array to the licensed clustered Data ONTAP, the user needs to use the ―set
array‖ interface to identify the clustered Data ONTAP array, and then provide authentication credentials
for it.

Common License Server
DTA‘s enterprise license server feature provides a single, independent server that can be accessed by
multiple client DTAs. This configuration allows the DTAs in a network environment to share data migration
licenses available on the server.
Support Note
Capacity licenses are checked in or checked out in TBs. Licensed FC or iSCSI target ports are shared
between server and client DTAs using the ―set array‖ or ―lic_client sync‖ command on the client DTA.
Time-based licenses cannot be shared using a license server.
Common License Server operates in the following manner:
1. The client DTA is responsible for making check-in and check-out requests from the license server.
2. The client DTA checks out either a capacity-based or array-based license as needed, and then sends
back (checks in) unused licenses to the server.
3. After the Fibre Channel or iSCSI storage array is licensed, the list of target ports associated with that
array is updated on the license server.
4. The License Key Server function is typically used in a large migration environment in which more than
one DTA is installed within the same network space. This allows the sharing of license keys between
different DTAs within the environment.
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2.4

Supported Configurations

This section provides guidance on supported array types, migration methods, and Fibre Channel fabric
requirements. Making sure that the DTA is deployed in a supported manner is essential for proper
operation and support.

Storage Arrays
DTA2800 supports data migration from the majority of block-based Fibre Channel and iSCSI storage. For
a list of supported arrays, refer to the NetApp Interoperability Matrix Tool.
Support Note
NetApp is the only supported destination storage. Migrations to third-party storage are not supported.

Migration Methods
Offline Migration
During offline migration, the user will not have access to application and host is shut down.
A typical offline migration involves the following steps:
1. Install DTA in the production fabric by connecting both blades‘ FC1 and FC2 ports to each fabric.
2. Perform DTA to source and destination storage zoning in production fabric.
3. Collect the host discovery information on host.
4. Shut down the application and host.
5. Unmap source LUNs from the host.
6. Map source and destination LUNs to the DTA.
7. Schedule offline migration jobs and perform migration.
8. Unmap source LUNs and destination LUNs from DTA.
9. Zone the host to destination storage.
10. For SAN boot LUN migration, map boot LUN first on single path, perform required recovery steps,
and configure multipathing on boot LUN.
11. For local boot LUN migration, configure multipathing on local boot LUN.
12. Map data LUNs to the host.
13. Mount the file systems and bring up services and applications.

Online Migration
Online migration is performed differently for physical machines and virtual machines (LPAR, blade
servers, which use shared HBA using NPIV).
For a physical machine migration, a separate migration fabric is used. In this migration fabric, DTA spoofs
the source-array target ports. Source LUNs are simultaneously mapped to the client and the DTA. The
initiator-to-LUN mapping present in the source array is duplicated in the DTA. The DTA remaps the same
set of LUNs on the target ports in the migration fabric. The migration host‘s HBA ports are logically or
physically moved to the migration fabric. Because the LUN is simultaneously available directly to both the
initiator on the production fabric as well as through the spoofed ports on the migration fabric, the fabric
move appears to the host as a series of path failures. These are handled as normal MPIO events. Note
that both physical and virtual migration fabrics are supported (dedicated switches, Cisco VSANs or
Brocade vFabrics). After the host is cut over to the migration fabric, the destination LUNs are mapped to
the DTA, and the migration begins.
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For migration of a virtual machine (for example, LPAR), only the production fabric is used. In short, the
DTA presents additional paths to the source storage. The host is zoned to see that these new paths and
the direct paths from the initiator to the target are swapped out for paths through the DTA. After the host
is utilizing the targets presented through the DTA, destination LUNs can be mapped, and migration
begins.
Online migrations are invisible to the host. After the DTA is brought in-line, the migration occurs as
follows:
1. The DTA begins copying blocks from the source LUN to the destination LUN.
2. Incoming writes to regions, which have already been copied, are split synchronously to both the
source and destination LUNs.
3. Incoming writes to regions not copied are forwarded to the source.
4. Reads are always processed by the source LUN.
5. In the event that the destination LUN goes away or experiences severe latencies, a ―dirty region log‖
(DRL) is created to track block ranges that are out of sync. The DTA continually tries to clear out the
DRL to keep the LUNs in sync.
6. After the copy has completed for all LUNs, the host can be reconfigured to utilize the destination
storage.
A typical online migration includes the following steps:
1. Install DTA by connecting FC1 and FC2 on each blade to the production fabric. For physical machine
migration, connect FC3 and FC4 on each blade to the migration fabric. Zone the DTA to the source
and destination storage in the production fabric using FC1 and FC2.
2. Collect the host discovery information on host.
3. Verify multipathing on host.
4. Map source and destination LUNs to the DTA.
5. Add initiators (host HBA WWPN) to the DTA.
6. Mask the source LUNs to the initiator in the DTA. Remap each LUN to the same LUN ID on the host.
This step is required for host to discover the source LUN through DTA ports.
7. Create presented targets (spoofed versions of the source target ports):


For physical server migrations, create presented target on FC3 and FC4 using the same WWPN
as source array target WWPN (For example, PT WWPN on BL1 FC3 is the same as Ctrl1 0a
WWPN).



For virtual server migrations, create presented target on FC1 and FC2 with a different WWPN
mapped to each source array target WWPN. (For example, PT WWPN on BL1 FC1 is the same
as DTA BL1 FC1 WWPN with 64 as second octet.)

8. Create and activate zones from the host to the DTA presented target ports/WWPNs depending on
whether the migration is on a physical or a virtual server:


For physical server migrations, create host zones in the migration fabric using the spoofed target
ports (FC3 and FC4). Port zones are typically utilized to reduce the amount of zoning work in the
migration fabric. Initiator records in the DTA prevent LUNs from being presented to the wrong
hosts.



For virtual server migrations, zone the host to the newly created presented target WWPNs.

9. Perform DTA insertion in source and host path:
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For physical server migrations, move (logically or physically) the host HBA cables from production
fabric to the migration fabric.



For virtual server migrations, remove the direct zone from source storage to the host.



Verify host multipathing and make sure that there is no direct access from host to source storage.
All host I/O is routed through DTA.
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10. Schedule online migration jobs and perform migration.
Note:

Do not acknowledge the job.

11. Perform cutover:
a. Shut down the application and host.
b. Unmask the source LUNs to initiator on DTA.
c.

Acknowledge the migration job.

d. For physical server migrations, move the host HBA cable from the migration fabric back to the
production fabric.
e. For virtual server migrations, remove DTA presented target to host zones.
12. Unmap source LUNs and destination LUNs from DTA.
13. Unmap source LUNs from the host.
14. Zone the host to destination storage.
15. For SAN boot LUN migration, map only the boot LUN on single path. Perform required recovery
steps, uninstall third-party multipathing software, and configure supported multipathing on boot LUN.
16. For local boot LUN migration, uninstall the third-party multipathing software and configure supported
multipathing on local disk.
17. Map data LUNs to the host.
18. Mount the file systems and bring up services and applications.

Fibre Channel Fabric Topologies
Offline and Virtual Server Online Migration
Each blade of the DTA2800 should be wired into the FC fabrics as if it were a host. Ideally, each blade is
dual attached with at least one connection to multiple fabrics. Figure 2 shows the most common offline
configuration.
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Figure 2) DTA2800 connected to dual fabrics.

Physical Server Online Migration
Each DTA blade connects to both the production and migration fabric. All storage arrays have at least
one primary path per fabric. FC1 and FC2 ports are connected to the production fabric, and FC3 and FC4
ports are connected to the migration fabric. Note that the migration fabric is used only for physical server
migration. Figure 3 shows the preferred online configuration for a physical server.
Figure 3) DTA2800 connected to dual production and migration fabrics.
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DTA supports simultaneous connections to multiple switch vendors at the same time (FC1 and FC2 on
blades can be connected to Brocade switches, while FC3 and FC4 on blades are connected to Cisco
switches). For information on additionally supported fabric topologies, refer to DTA2800 Migration User‘s
Guide.

2.5

Fabric Requirements

Depending on the configuration of the Fibre Channel fabric, the DTA FC ports may not log in to the fabric
unless either NPIV is enabled or the switch port supports fabric-loop (FL) mode.
Refer to Table 1 for the proper combination of switch port and DTA FC port settings.
Table 1) DTA FC port setting and NPIV support mapping.

DTA 2800 FC
Port Setting

FC Switch Port Setting

NPIV Supported/Enabled
F-Port + FLPort (P2P or
Loop)

F-Port
(P2P
Only)

Loop preferred
(default)

Supported

Loop only
P2P only

NPIV Not Supported/Disabled
FL-Port (loop
Only)

F-Port + FLPort (P2P or
Loop)

F-Port
(P2P
Only)

Supported Supported
(loop mode)

Supported
(loop mode)

Not
Supported
supported (loop mode)

Supported
(loop mode)

Not
supported

Supported
(loop mode)

Not
Supported
supported (loop mode)

Supported

Supported Not supported

Connect
(offline only)

Connect
(offline
only)

Supported
(loop mode)

FL-Port (Loop
Only)

Not supported

3 DTA Concepts
This chapter provides an overview of several key DTA2800 concepts. Understanding the implementation
of these concepts helps with proper operation and a decrease in the initial configuration effort.

3.1

Array Objects

DTA automatically discovers all Fibre Channel target ports zoned to DTA initiator ports. If LUNs are not
presented to the DTA2800, the target (array) ports appear in the NetApp DTA Manager GUI and CLI as
―FC Discovered Targets‖ (Figure 4).
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Figure 4) DTA Manager, FC discovered targets.

An array object is formed when at least one data LUN is presented to the DTA2800 from that array.
Before mapping the first LUN from each array, the target ports belonging to each storage system are
shown individually. After the LUNs are mapped to the DTA and a DTA refresh is performed, array objects
are created. In Figure 5, the LUNs have been presented from each of the four storage systems, and array
objects are automatically formed.
Figure 5) DTA Manager, array display.

DTA identifies target ports that belong to a given array by identifying LUNs with same serial numbers on
multiple paths. The list of target ports belonging to an array can be obtained from the ―Information‖ tab in
DTA Manager (Figure 6) or by using the show array CLI command.
Figure 6) DTA Manager, target port list.

DTA2800 <1> #> show array
Array Information
----------------Symbolic Name EVA4100
State
Online
Vendor ID
HP
Product ID
HSV200
Target Type
Src+Dest
Path Domain
FC
WWPN
50:00:1f:e1:50:0b:85:d8
Port ID
4e-00-06
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State
Online
Path Domain
FC
WWPN
50:00:1f:e1:50:0b:85:dc
Port ID
4e-00-07
State
Online
Path Domain
FC
WWPN
50:00:1f:e1:50:0b:85:dd
Port ID
4e-00-06
State
Online
Path Domain
FC
WWPN
50:00:1f:e1:50:0b:85:d9
Port ID
4e-00-07
State
Online
Array Bandwidth Available Bandwidth
Load Balancing Enabled
Array License Local Migration
LunInfo Display Lun Id

Arrays must be configured as source, destination, or source and destination array types before LUNs can
be configured as part of a migration job. This setting can be changed later but is required to prevent
accidental overwriting of source LUNs due to selection errors.
LUN Mapping Best Practice
Always perform a ―target rescan‖ after presenting a new LUN.

3.2

Data LUNs

DTA uses the worldwide unique LUN name (WWULN) to identify LUNs. This value usually corresponds to
the PG83 serial number of the LUN, as shown in Figure 7. LUN information is displayed differently
depending on the source array type.
Figure 7) DTA Manager, LUN information (FAS).
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As shown in Figure 7, a LUN from a NetApp FAS6080 is displayed. The ALUA path status is visible in the
LUN Path Info section. Both the PG80 and PG83 serial numbers are displayed (these can be obtained in
Data ONTAP by using the lun serial <lun_path> and lun serial –x <lun_path>
commands).
Figure 8) DTA Manager, LUN information (EMC CX700).

As shown in Figure 8, a LUN from an EMC CX700 is displayed. The path status shown differs from a FAS
system because of a different system architecture and MPIO implementation. The LUN shown earlier is
mapped to an initiator record configured as a ―CLARiiON Open‖ host type.
DTA supports native MPIO for each supported array. Detailed instructions on configuring the appropriate
initiator record (host entry) for each array type are available in appendix B in the DTA 2800 DTA Migration
Planning Guide.
Best Practice
Always verify that multiple paths are visible to each LUN and the displayed path states are correct.

3.3

Controller LUNs

Some storage arrays utilize special ―controller‖ or ―pseudo‖ LUNs. These special devices typically work
with the host-side software to provide in-band management of LUN states and provide a communications
channel between hosts and arrays.
Controller LUNs can be difficult to identify due to unique vendor implementations (NetApp does not utilize
controller LUNs). Controller LUNs are typically mapped to LUN ID 0 or 254 unless a host (or the DTA) has
a LUN presented at that LUN ID. For example, if a DTA is connected to an EMC CX700 and a LUN is
mapped to HLU 0 (host LUN 0), the controller LUN will not be visible. If no LUN is mapped to LUN ID 0, a
controller LUN is automatically mapped to the DTA.
Many arrays that implement controller LUNs ―reuse‖ the same LUN for all hosts. In the CX700 example in
Figure 9, the LUN‘s PG83 serial number matches the array WWN. This same LUN is mapped by the
array to the hosts that require controller LUNs.
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Figure 9) EMC CX700 controller LUN.

In Figure 9, the LUN displays several attributes that are unique to an EMC controller LUN:


VPD product ID of ―LUNZ‖



No size (0 bytes)



WWULN set to the array WWN



WWULN beginning with ―50-‖ (EMC UUIDs for data LUNs always begin with ―60‖)



Path status of ―Passive‖ for all paths
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Figure 10) HP EVA4100 controller LUN.

In Figure 10, the LUN displays several attributes that are unique to an HP EVA controller LUN:


No size (0 bytes)



WWULN set to the array WWN

3.4

Virtual Port Groups

Some storage arrays limit the number of LUNs exposed to a host to 256 LUNs. The DTA utilizes virtual
port groups (VPGs) to allow a single DTA to appear as multiple hosts to storage devices. Each DTA2800
supports up to four VPGs, enabling the storage arrays to present up to 1,024 LUNs per blade.
As shown in Figure 11, only VPG1 is enabled by default, from DTA firmware version 3.3.0.2.
Figure 11) Default: single VPG enabled.
21:00:00:c0:dd:19:4c:56
BL1_FC1_VPG1
INIT

21:00:00:c0:dd:19:4c:57
BL1_FC2_VPG1
INIT

BL1_FC1

21:00:00:c0:dd:19:4c:60

21:00:00:c0:dd:19:4c:61

BL2_FC1_VPG1
INIT

BL1_FC2

BL2_FC2_VPG1
INIT

BL2_FC1

Blade 1

BL2_FC2
Blade 2

DTA2800

With only a single port enabled by default, the switch reports a single F_Port login for each DTA FC port.
The following listing shows the output, in this example, DTA‘s FC1 port.
DM-Cisco9506-1# show flogi database
--------------------------------------------------------------------------INTERFACE VSAN FCID
PORT NAME
NODE NAME
--------------------------------------------------------------------------fc3/1
10 0x4e0042 21:00:00:c0:dd:19:4c:56 20:00:00:c0:dd:19:4c:56
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Enabling additional VPGs presents additional virtual (by using NP_IV) initiators to the fabric on each FC
port (Figure 12). Each virtual initiator has a unique WWPN with the second octet identifying the VPG
index.
Figure 12) WWPN listing, multiple VPGs enabled.
21:03:00:c0:dd:19:4c:56

BL1_FC1_VPG4
INIT

BL1_FC2_VPG4
INIT

21:03:00:c0:dd:19:4c:57

21:02:00:c0:dd:19:4c:56

BL1_FC1_VPG3
INIT

BL1_FC2_VPG3
INIT

21:02:00:c0:dd:19:4c:57

21:01:00:c0:dd:19:4c:56

BL1_FC1_VPG2
INIT

BL1_FC2_VPG2
INIT

21:01:00:c0:dd:19:4c:57

21:00:00:c0:dd:19:4c:56

BL1_FC1_VPG1
INIT

BL1_FC2_VPG1
INIT

21:00:00:c0:dd:19:4c:57

BL1_FC1

BL1_FC2

BL2_FC1

Blade 1
DTA2800

VPG status can be obtained from the NetApp DTA Manager GUI (see Figure 13) or by using the show
vpgroups CLI command.
Figure 13) DTA Manager, multiple VPGs enabled on FC1.

The following listing shows the output, in this example the FC1 port on Blade1 of the DTA. Note that
multiple F_Ports have logged into the same switch port.
DM-Cisco9506-1# show flogi database
--------------------------------------------------------------------------INTERFACE VSAN FCID
PORT NAME
NODE NAME
--------------------------------------------------------------------------fc3/1
10 0x4e0042 21:00:00:c0:dd:19:4c:56 20:00:00:c0:dd:19:4c:56
fc3/1
10 0x4e0064 21:01:00:c0:dd:19:4c:56 20:01:00:c0:dd:19:4c:56
fc3/1
10 0x4e0065 21:02:00:c0:dd:19:4c:56 20:02:00:c0:dd:19:4c:56
fc3/1
10 0x4e0066 21:03:00:c0:dd:19:4c:56 20:03:00:c0:dd:19:4c:56
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Virtual Port Group Best Practices


The same VPGs must be enabled on both blades.



Multiple VPGs are required for migrations only if more than 1,024 LUNs need to be mapped at the
same time.



Each VPG should reside in a unique igroup (storage group, host group, initiator record, or host
record).



All ports from both blades in a given VPG must reside in the same igroup.

3.5

Presented Targets

For online data migration, the server must access the source LUN through the DTA2800. To allow this
access, you must first create a virtual presentation of the source array target port. This virtual
presentation is referred as a presented target.
Global Presentation
When more than 256 LUNs from a single storage array are mapped to a server, you must present these
LUNs across multiple VPGs. Each VPG on the DTA can ―see‖ 256 LUNs. To reduce the steps required to
create presented targets that represent the same target ports across multiple VPGs, the DTA allows you
to create a global presented target that spans all virtual port groups (VPG1, VPG2, VPG3, and VPG4). If
you need to map a source array target port across more than one VPG, NetApp recommends that you
create a global presented target in the Target Map Wizard.
Global presentation of targets spans all VPGs, as does target mapping for both Fibre Channel and iSCSI
ports. Global presentation, like virtual presentation, is common for all VPGs. A single source array‘s target
port can have a single global and virtual presentation that functions for all VPGs.
Global Presented Target Best Practices
Do not use global presentation and LUN masking together. To use global presentation, issue the
lunremap command to mask LUNs. For the lunmask add command, use VPG-specific presentation,
rather than global presentation.

3.6

LUN Mapping

LUN mapping provides the access for the LUN to the host from the DTA through a presented virtual or
global target. LUN mapping is required as a part of the process of inserting the DTA in the host I/O path.
Make sure that the entire host I/O is routed through the DTA and that there is no direct access to any
source controller ports from the host during migration.
LUN Mapping Best Practices


LUN mapping is required only for online data migration for Fibre Channel initiators (iSCSI initiators
are not supported).



LUN mapping is not required for offline data migration.



For HP-UX initiators, set the host type to HP-UX in the DTA. For all other initiators, leave the host
type set to Windows, the default.



For arrays that have a dedicated controller LUN (for example, LUN-0 on HP EVA arrays), make
sure that LUN-0 is also presented to the Fibre Channel initiators hosts with the actual data LUNs.
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3.7

Space Reclamation

The Space Reclamation Utility (SRU) is provided to prepare host LUNs for space reclamation during the
migration. By default, SRU takes a file system mount point as input and runs the zeroing process in the
foreground. The SRU process can also run it in the background as a daemon by specifying a log file
name. Even though this utility operates on the active file system, it avoids any interruption in the normal
activity (write or read I/Os) of the file system.
SRU works by creating a balloon file that consumes large amounts of file system free space. It then fills
the balloon file with zeros, deletes the balloon file, and then repeats this process several times. Later,
during the actual DTA LUN migration, if jobs are configured for space reclamation, DTA does not transfer
I/O-sized chunks of data containing only zeros. Standard SCSI implementations for thin-provisioned
LUNs return zeros for logical block addresses (LBAs) that do not contain data. DTA utilizes this behavior
by not writing out empty chunks of data to thin-provisioned destination LUNs. The net effect is the same
whether the NetApp storage is returning all zeros for empty LBAs or whether it is returning LBAs that
actually contain zeros.
Using this method does not alter the use of ―undelete‖ functions present in many file systems. Undelete
typically relies on the fact that data is not zeroed out on the disk postdeletion, but that the file system
blocks used by a deleted file are simply deallocated. These files can be ―restored‖ by restoring the extent
map as long as the blocks have not been overwritten. Assume that the SRU will overwrite all unused file
system blocks in an effort to reclaim the most space. In short, undelete still works, but no files are
available for undeletion due to the overwriting of all free file system blocks.
The SRU allows you to reserve some percentage of free space for file system activities. The default value
of the reserved free space is 10% of the available free space, although a different percentage can be
specified by using a CLI command argument. If the free space exceeds the reserved space threshold
limit, the utility exits immediately and deletes the balloon file.
Figure 14 illustrates a simple simulation of the file system and the underlying storage behavior during a
space reclamation operation.
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Figure 14) Space reclamation example.

Space Reclamation Utility Best Practices


Run SRU before migrating a LUN to a thin-provisioned destination.



Run SRU when the file system is not operating under heavy I/O load.



Run SRU during off-peak hours to maximize the amount of space reclaimed.



Do not run SRU if migrating from a thin-provisioned source LUN.
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Although NetApp recommends running the SRU utility under a light I/O load, SRU is also capable of
reclaiming stale file system space in a high I/O load environment.
The following notes apply to the data migration space reclamation utility:


The utility is designed for a thick-provisioned to thin-provisioned data migration environment. The
source LUNs are not thin-provisioned, and the destination LUNs are thin-provisioned.



If the reserved free space is set to zero, all free blocks are reclaimed until the utility reaches the outof-space error. Space reclamation might require a substantial amount of time to complete, and it
requires monitoring.



You can interrupt the utility at any time by pressing Ctrl+C. When interrupted, the utility cleans up and
prints statistics of the currently reclaimed blocks.



On some Linux operating systems, you might need to run this utility as a superuser.



If you reboot the system while the utility is running, you must restart the utility.



The utility creates a temporary directory, space_reclamation_dir, in the mount point. If you
manually delete this directory before the utility cleanup process can delete it, the utility behavior
becomes undefined because the temporary directory is no longer valid.

4 Implementation Basics
The initial configuration of the DTA prepares the environment for migration. This chapter provides an
overview of the physical wiring, zoning, and initiator record creation steps that are performed for each
new migration engagement.

4.1

Physical Wiring

Offline and Online Migration Wiring in Production
Each DTA blade should be wired into the fabric in the same manner as a normal Fibre Channel host
(Figure 15). Each blade should have at least one connection per fabric. The majority of installations only
require the use of two of the four 8GB Fibre Channel ports present on each DTA blade. Additional ports
typically do not provide additional performance and can complicate zoning and initiator record
management.
Figure 15) DTA2800 physical wiring to production fabric.
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The storage arrays used during migration must have a primary path from each controller (in use) present
in both fabrics. In Figure 16, both the EMC CX700 and NetApp FAS3270 have a primary (active) path
present in both fabrics.
Figure 16) Storage wiring for dual fabrics.

Physical Server Online Migration in Migration Fabric
An additional migration fabric is required only for physical server online migrations. To allow
access to source LUNs through the DTA to a host, presented targets are created on the DTA. Since we
create a presented target on FC ports 3 and 4 using the same WWPN as the source storage, we connect
only these ports of the DTA to the migration fabric. This makes sure that no other hosts can see them
(see Figure 17). The migration fabric can be a separate fabric or a separate VSAN in the same switch. Do
not connect DTA FC ports 3 and 4 to the production fabric where the source storage is connected.
Figure 17) DTA2800 physical wiring to migration fabric (physical server migration).
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Wiring Best Practices


The FC1 port on both blades should always connect to Production Fabric A.



The FC2 port on both blades should always connect to Production Fabric B.



The FC3 port on both blades should always connect to Migration Fabric A (physical server
online migration only).



The FC4 port on both blades should always connect to Migration Fabric B (physical server
online migration only).



Each storage array must have a primary path present to each controller in both fabrics.

4.2

Zoning

Although each DTA blade is wired as a single host, both blades of the DTA should be zoned as a single
entity. The following example utilizes an HP EVA4100 as the source array and a NetApp FAS3270 as the
destination array. Both arrays are wired into the fabric in the prescribed manner (an active path to each
controller is present in both fabrics). Both blades must be zoned to the same target ports (and reside in
the same initiator records) to prevent the DTA from putting an array in an offline state.
Note:

For physical server online migrations only.
Migration fabric zones are required only for physical server online migration. For migrating
virtual/LPAR and blade server environments, use only the production fabric. Zoning involves the
following steps:

1. Create presented target zones in the migration fabric from DTA to host.
2. Create port-based zones.
3. Host to DTA zones in migration fabric are created and activated before moving the host ports
from the production fabric to the migration fabric.
A standard offline migration scenario using DTA2800 requires six distinct zones:


Zone 1: DTA to source storage (Production Fabric A)



Zone 2: DTA to source storage (Production Fabric B)



Zone 3: DTA to destination storage (Production Fabric A)



Zone 4: DTA to destination storage (Production Fabric B)



Zone 5: Host to destination storage (Production Fabric A)



Zone 6: Host to destination storage (Production Fabric B)

A standard physical server online migration scenario using DTA2800 requires four additional
distinct zones:


Zone 7: DTA Blade 1 FC3 port number to Host port 1 (Migration Fabric A)



Zone 8: DTA Blade 2 FC3 port number to Host port 1 (Migration Fabric A)



Zone 9: DTA Blade 1 FC4 port number to Host port 2 (Migration Fabric B)



Zone 10: DTA Blade 2 FC4 port number to Host port 2 (Migration Fabric B)

A standard virtual server online migration scenario using DTA2800 requires two additional distinct
zones:


Zone 11: DTA Blade 1 FC1 PT WWPN, Blade 2 FC1 PT WWPN to Host HBA 1 WWPN (Production
Fabric A) (virtual server online only)



Zone 12: DTA Blade 1 FC2 PT WWPN, Blade 2 FC2 PT WWPN to Host HBA 1 WWPN (production
fabric B) (virtual server online only)
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Zoning Best Practices


Limit the number of zones to increase manageability; creating a separate zone for each DTA
initiator port is not required.



Do NOT mix storage arrays in the same zone.



Both blades MUST be zoned to the same target ports.



Do NOT mix production fabric and migration fabric.



Create separate presented target zones for each host.

Zone 1: DTA to Source Storage (Production Fabric A)
Zone 1 should contain all VPG1 initiators on all the DTA FC ports and all the source storage target ports
in fabric A (see Figure 18 and Table 2).
Figure 18) Offline and online zoning, zone 1.

Table 2) Offline and online zone 1 members.

Zone

Members

Zone 1

BL1_FC1_VPG1_INIT
BL2_FC1_VPG1_INIT
EVA4100 – Ctrl1 – FP1 (Port1)
EVA4100 – Ctrl2 – FP1 (Port1)
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Zone 2: DTA to Source Storage (Production Fabric B)
Zone 2 should contain all VPG1 initiators on all the DTA FC ports and all the source storage target ports
in fabric B (Figure 19 and Table 3).
Figure 19) Offline and online zoning, zone 2.

Table 3) Offline and online zone 2 members.

Zone

Members

Zone 2

BL1_FC2_VPG1_INIT
BL2_FC2_VPG1_INIT
EVA4100 – Ctrl1 – FP2 (Port2)
EVA4100 – Ctrl2 – FP2 (Port2)
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Zone 3: DTA to Destination Storage (Production Fabric A)
Zone 3 should contain all VPG1 initiators on all the DTA FC ports and all the destination storage target
ports connected to fabric A (Figure 20 and Table 4).
Figure 20) Offline and online zoning, zone 3.

Table 4) Offline and online zone 3 members.

Zone

Members

Zone 3

BL1_FC1_VPG1_INIT
BL2_FC1_VPG1_INIT
FAS3270 – Ctrl1 – Port 0c
FAS3270 – Ctrl2 – Port 0c
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Zone 4: DTA to Destination Storage (Production Fabric B)
Zone 4 should contain all VPG1 initiators on all the DTA FC ports and all the destination storage target
ports connected to fabric B (Figure 21 and Table 5).
Figure 21) Offline and online zoning, zone 4.

Table 5) Offline and online zone 4 members.

Zone

Members

Zone 4

BL1_FC2_VPG1_INIT
BL2_FC2_VPG1_INIT
FAS3270 – Ctrl1 – Port 0d
FAS3270 – Ctrl2 – Port 0d

Zone 5: Host to Destination Storage (Production Fabric A)
Zone 5 should contain the Host HBA port 1 and the destination controller ports in Production Fabric A.

Zone 6: Host to Destination Storage (Production Fabric B)
Zone 6 should contain the Host HBA port 2 and the destination controller ports in Production Fabric B.
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Zone 7: DTA to Host (Migration Fabric A) (Physical Server Online Only
Zone 7 should contain the Blade 1 FC3 port number and the Host HBA port 1 connected to Migration
Fabric A. The Host HBA port 1 is not moved into the migration fabric/VSAN until the DTA is actually
inserted into the data path. Zone 7 can be created in advance and includes Blade 1, FC3 (Figure 22 and
Table 6).
Support Note
Create port-based zone.
Figure 22) Physical server online zoning, zone 7.

Table 6) Physical server online zone 7 members.

Zone

Members

Zone 7

BL1_FC3 Port Number
Host HBA 1 Port Number
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Zone 8: DTA to Host (Migration Fabric A) (Physical Server Online Only)
Zone 8 should contain the Blade 2 FC3 port number and the Host HBA port 1 connected to Migration
Fabric A. The Host HBA port 1 is not moved into the migration fabric/VSAN until the DTA is actually
inserted into the data path. Zone 8 can be created in advance and includes Blade 2, FC3 (Figure 23 and
Table 7).
Support Note
Create port-based zone.
Figure 23) Physical server online zoning, zone 8.

Table 7) Physical server online zone 8 members.

Zone

Members

Zone 8

BL2_FC3 Port Number
Host HBA 1 Port Number
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Zone 9: DTA to Host (Migration Fabric B) (Physical Server Online Only)
Zone 9 should contain the Blade 1 FC4 port number and the Host HBA port 2 connected to Migration
Fabric B. The Host HBA port 2 is not moved into the migration fabric/VSAN until the DTA is actually
inserted into the data path. Zone 9 can be created in advance and includes Blade 1, FC4 (Figure 24 and
Table 8).
Support Note
Create port-based zone.
Figure 24) Physical server online zoning, zone 9.

Table 8) Physical server online zone 9 members.

Zone

Members

Zone 9

BL1_FC4 Port Number
Host HBA 2 Port Number
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Zone 10: DTA to Host (Migration Fabric B) (Physical Server Online Only)
Zone 10 should contain the Blade 2 FC4 port number and the Host HBA port 2 connected to Migration
Fabric B. The Host HBA port 2 is not moved into the migration fabric/VSAN until the DTA is actually
inserted into the data path. Zone 10 can be created in advance and includes Blade 2, FC4 (see Figure 25
and Table 9).
Support Note
Create port-based zone.
Figure 25) Physical server online zoning, zone 10.

Table 9) Physical server online zone 10 members.

Zone

Members

Zone 10

BL2_FC4 Port Number
Host HBA 2 Port Number
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Zone 11: DTA to Host (Production Fabric A) (Virtual Server Online Only)
Zone 11 should contain Blade 1 FC1 PT WWPN, Blade 2 FC1 PT WWPN, and Host HBA port 1 WWPN
connected to Production Fabric A (see Figure 26 and Table 10).
Support Note
Create WWPN-based zone.
Figure 26) Virtual server online zoning, zone 11.

Table 10) Physical server online zone 11 members.

Zone

Members

Zone 11

BL1_FC1 PT WWPN
BL2_FC1 PT WWPN
Host HBA 1 WWPN
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Zone 12: DTA to Host (Production Fabric B) (Virtual Server Online Only)
Zone 12 should contain Blade 1 FC2 PT WWPN, Blade 2 FC2 PT WWPN, and Host HBA port 2 WWPN
connected to Production Fabric B (see Figure 27 and Table 11).
Support Note
Create WWPN-based zone.
Figure 27) Virtual server online zoning, zone 12.

Table 11) Physical server online zone 12 members.

Zone

Members

Zone 12

BL1_FC2 PT WWPN
BL2_FC2 PT WWPN
Host HBA 2 WWPN

4.3

Initiator Group Configuration

Proper configuration of initiator records is critical for correct operation. All initiator ports (on both blades) in
VPG1 must reside in the same initiator record. This makes sure that LUN mapping is consistent across
both blades.
Initiator groups go by different names depending upon the vendor and product. For example:


Hitachi Data Systems (HDS) uses ―host group‖



NetApp E-Series uses ―host entry‖



EMC uses ―initiator record‖ or ―storage group‖



NetApp uses ―igroup‖
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Regardless of nomenclature, the purpose of an initiator group is to identify initiators (by WWPN) that
share the same LUN mappings.
A single initiator group should be created for each enabled VPG. This makes sure that both blades have
the same LUN and target port visibility.
Figure 28) igroup membership for VPG1.
21:00:00:c0:dd:19:4c:56

igroup 1

BL1_FC1_VPG1
INIT

21:00:00:c0:dd:19:4c:57
BL1_FC2_VPG1
INIT

BL1_FC1

21:00:00:c0:dd:19:4c:60

21:00:00:c0:dd:19:4c:61

BL2_FC1_VPG1
INIT

BL1_FC2

BL2_FC2_VPG1
INIT

BL2_FC1

Blade 1

BL2_FC2
Blade 2
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As shown in Figure 28, all VPG1 initiator ports on both blades would belong to the same igroup.
The following listing shows the Data ONTAP command required to create an appropriate igroup for the
example configuration:
igroup create -t windows -f DTA_VPG1 21:00:00:c0:dd:19:4c:56 21:00:00:c0:dd:19:4c:57
21:00:00:c0:dd:19:4c:60 21:00:00:c0:dd:19:4c:61
igroup set DTA_VPG1 alua yes

If multiple VPGs are required, multiple igroups should be utilized, as shown in Figure 29.
Figure 29) Utilizing multiple igroups and VPGs.
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A second igroup is created to support the second VPG, as shown in the following listing:
igroup create -t windows -f DTA_VPG2 21:01:00:c0:dd:19:4c:56 21:01:00:c0:dd:19:4c:57
21:01:00:c0:dd:19:4c:60 21:01:00:c0:dd:19:4c:61
igroup set DTA_VPG2 alua yes

To define initiator groups, refer to the extensive procedures in appendix B of the DTA Migration Planning
Guide.
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Best Practices


All ports from both blades in a given VPG must reside in the same igroup.



All initiator ports must have the same LUN and target port visibility (same zoning and LUN
mapping).



Always enable ALUA on DTA igroups for NetApp arrays.



Always use a ―windows‖ host type when creating initiator groups.

5 LUN Alignment
After the data has been migrated to NetApp storage, proper LUN alignment with the underlying storage
system is required for optimal performance. Performance problems associated with misalignment include
increased I/O latency, poor deduplication, and a general reduction in maximum IOPS for the aggregate
containing the misaligned LUNs.
Each layer of storage between the file system and data on disk is organized into blocks, or ―chunks,‖ to
make storage access more efficient. The size and the starting offset of each of these blocks can be
different at each layer. Although a different block size across the storage layers does not require any
special attention, the starting offset does. For optimal performance, the starting offset of a file system
should align with the start of a block in the next lower layer of storage. For example, an NTFS file system
that resides in a LUN should have an offset that is divisible by the block size of the storage array
presenting the LUN. Misalignment of block boundaries at any one of these layers of storage can result in
performance degradation.
Disks use geometry to identify themselves and their characteristics to the upper layer operating system.
The upper layer operating system uses the disk geometry information to calculate the size of the disk and
partitions the disk into predetermined addressable blocks. Similar to physical disks, logical disks (LUNs)
report disk geometry to the host (physical host, virtualization host, or VM, depending on the mode of
usage) to calculate space and partition the LUN into addressable blocks.
For background information on cylinder-head-sector concepts, refer to
http://en.wikipedia.org/wiki/Cylinder-head-sector.
Historically, hard drives (LUNs) presented the OS with a physical geometry. This information would then
be used to partition and format the disk in an efficient manner. Disk geometry today is virtual and
fabricated by the disk firmware. Operating system partitioning programs such as fdisk use the emulated
disk geometry to determine where to begin a partition. Unfortunately, some partitioning programs invoked
during OS setup create disk partitions that do not align to underlying block boundaries of the disk. In
addition, the more notable tools such as GNU fdisk found on many Linux distributions and Microsoft
DiskPart, found in Windows 2000 and Windows 2003 by default, also create disk partitions that do not
align to underlying block boundaries of the disk.
By default, many operating systems, including most versions of Windows, attempt to align the first sector
on a full track boundary. The installer/setup routine requests the CHS information. The CHS information
describes the disk from the BIOS (PC firmware that manages disk I/O at a low level) or, in the case of
many virtual machines, an emulated BIOS. The issue is that the CHS data has not actually corresponded
to anything physical since the late 1980s (even in physical machines). In larger LUN sizes (usually 8GB
or more), the S number (sectors per track) is always reported as 63, so the partitioning routine sets a
starting offset of 63 sectors in an attempt to start the partition on a track boundary.
Although this might be correct for a single physical disk drive, it does not line up with any storage vendor's
logical block size. A block is the smallest unit of data that can be used to store an object on a storage
device. For optimal storage capacity and performance, data should reside optimally in the blocks.
Physical disk blocks always have 512 (usable/visible) bytes, but, for efficiency and scalability reasons,
storage devices use a logical block size. The logical block size is some number of physical blocks, usually
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a power of 2. For example, NetApp unified storage arrays have a logical block size of 4K (that is, 8 disk
blocks). EMC Symmetrix storage arrays have a logical block size of 64KB.
Write operations can consume no less than a single 4KB block and can consume many 4KB blocks
depending on the size of the write operation. Ideally, the guest/child OS should align its file system(s)
such that writes are aligned to the storage device's logical blocks. The problem of unaligned LUN I/O
occurs when the partitioning scheme used by the host OS does not match the block boundaries inside the
LUN. Figure 30 shows an example of a LUN without file system alignment.
Figure 30) Misaligned I/O.

If the file system is not aligned, it might become necessary to read or write twice as many blocks of
storage as the guest actually requested, since any guest file system block actually occupies at least two
partial storage blocks. As a simple example, assuming only one layer of file system and that the allocation
unit is equal to the storage logical block size (4K or 4,096 bytes), each guest block (technically an
"allocation unit") would occupy 512 bytes of one block and 3,584 bytes (4,096 – 512) of the next. This
results in inefficient I/O because the storage controller must perform additional work such as reading
extra data to satisfy a read or write I/O from the host.
By default, many operating systems, including Windows 2000 and 2003, and various Linux distributions
start the first primary partition at sector (logical block) 63. The reasons for this are historically tied to disk
geometry. This behavior leads to misaligned file systems since the partition does not begin at a sector
that is a multiple of eight.
Misalignment might cause an increase in per-operation latency. It requires the storage array to read from
or write to more blocks than necessary to perform logical I/O.
Figure 31) Properly aligned I/O.
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Figure 31 shows an example of LUN with file system alignment. In Figure 31, the LUN with aligned file
system uses four 4KB blocks on the LUN to store four 4KB blocks of data generated by a host.
The second scenario, as depicted in Figure 30 and Figure 31, shows that where there is misalignment,
the NetApp storage controller has to use five blocks to store the same 16KB of data. This is an inefficient
use of space, and performance suffers when the storage array has to process five blocks to read or write
what should only be four blocks of data. This results in inefficient I/O, because the storage array is doing
more work than is actually requested.
Performance Overhead of Unaligned I/O


Increased latency



Reduced maximum IOPS



Deduplication inefficiency

5.1

LUN Data Streams

LUNs presented to hosts are stored as special files in Data ONTAP. These LUN files have unique
characteristics that allow the user to create properly aligned LUNs at the time of creation. NetApp LUN
files are a logical concatenation of three data ―streams‖: the prefix, LUN, and suffix streams. A stream is
similar in function to a file system fork as implemented in many modern file systems.
For background information about file system forks, refer to
http://en.wikipedia.org/wiki/Fork_(file_system).
All three streams are seamlessly presented to the host and addressable in order. The beginning of each
stream is aligned with a 4KB WAFL® boundary. The LUN alignment methodology presented in this
document takes advantage of the separate data streams and manipulates the length of the prefix to align
the large data stream to the primary partition offset of each LUN. Because the length of the prefix is
configurable, it can be set to a value that causes the file system blocks to be aligned on a 4KB WAFL
boundary (see Figure 32).
Figure 32) LUN streams in a NetApp LUN.

5.2

LUN Type

The ostype flag determines the length (size) of the prefix stream during LUN creation. The procedures in
later sections provide a mechanism to override the default values. The default values used by Data
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ONTAP are applicable for new installations that follow the platform-specific SAN implementation guides
but are not always appropriate when migrating from third-party storage where default file system and
partitioning schemes were not used (see Table 12).
Table 12) LUN OS type prefixes.

LUN OS Type

Prefix Size in Bytes

windows

32,256

windows_gpt

17,408

windows2008

0

linux

0

solaris

Based on LUN size

solaris_efi

17,408

5.3

Partition Table Analysis

Platform-specific methods can be used to determine the partition offset for a given LUN. Figure 33 shows
the partition offset for a LUN as displayed by the msinfo32 command.
Figure 33) W2K3, unaligned offset: 32,256 / 4,096 = 8, remainder 3,584 bytes.

NetApp Data Center Planner (NDCP) automates the discovery of partition offsets for all LUNs for
supported platforms.
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5.4

Custom Prefix

To determine the proper prefix size, obtain the partition starting offset of the disk and then use this
formula: partition offset in mod (bytes, 4096) = prefix size (bytes). The size of prefix is configurable at
LUN creation. This value cannot be modified after LUN creation and should be used with caution.
If NDCP is used for planning purposes, a lun create command utilizing a custom prefix is generated
for all Windows LUNs. Detailed examples of creating LUNs with custom prefixes are provided in later
sections of this guide.
Support Note
The prefix value will always be one of only eight values (eight sectors in a 4KB block): 0, 512, 1,024,
1,536, 2,048, 2,560, 3,072, or 3,584.

5.5

Alignment Heuristic Checks

Data ONTAP provides commands to determine LUN alignment that use automated calculations based on
I/O patterns. Table 13 lists the Data ONTAP commands to check LUN alignment to reset internal
counters. LUN alignment can be verified postmigration using the steps provided in this section.
Following a migration, LUN stats should be cleared for migrated LUNs. The alignment histograms can be
checked after a period of normal host activity to determine proper alignment. It is common for LUNs to be
reported as misaligned if the stats are not cleared postmigration due to the I/O pattern of the DTA.
Table 13) Data ONTAP commands to check LUN alignment and to reset internal counters.

Data ONTAP Command

Purpose

lun stats –z

Resets internal counters.

lun show –v

Displays LUN alignment. Possible values are aligned, misaligned,
indeterminate.

lun alignment show

Displays LUN alignment and histogram percentage of write and read ―buckets.‖

stats show

Displays histogram of read and write ―buckets.‖

*> lun stats -z

*> lun show -v /vol/luns/my_windows_lun
/vol/luns/my_windows_lun
1.0g (1077511680)
Serial#: C4dAFJfXW5Fp
Share: none
Space Reservation: enabled
Multiprotocol Type: windows
Maps: sanboot-b9rtp8=1
Occupied Size: 432.7m (453726208)
Creation Time: Fri Sep 30 09:04:50 EDT 2011
Alignment: indeterminate

(r/w, online, mapped)

*> lun alignment show /vol/luns/my_windows_lun
Multiprotocol type: linux
Alignment: misaligned
Write alignment histogram percentage: 0, 0, 0, 0, 0, 0, 0, 100
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Read alignment histogram percentage: 0, 0, 0, 0, 0, 0, 0, 100
Partial writes percentage: 0
Partial reads percentage: 0

*> stats show lun
lun:/vol/luns/my_windows_lun-C4dAFJfXWk8C:read_ops:120/s
lun:/vol/luns/my_windows_lun-C4dAFJfXWk8C:write_ops:2691/s
lun:/vol/luns/my_windows_lun-C4dAFJfXWk8C:read_align_histo.0:0%
lun:/vol/luns/my_windows_lun-C4dAFJfXWk8C:read_align_histo.1:0%
lun:/vol/luns/my_windows_lun-C4dAFJfXWk8C:read_align_histo.2:0%
lun:/vol/luns/my_windows_lun-C4dAFJfXWk8C:read_align_histo.3:0%
lun:/vol/luns/my_windows_lun-C4dAFJfXWk8C:read_align_histo.4:0%
lun:/vol/luns/my_windows_lun-C4dAFJfXWk8C:read_align_histo.5:0%
lun:/vol/luns/my_windows_lun-C4dAFJfXWk8C:read_align_histo.6:0%
lun:/vol/luns/my_windows_lun-C4dAFJfXWk8C:read_align_histo.7:100%
lun:/vol/luns/my_windows_lun-C4dAFJfXWk8C:write_align_histo.0:0%
lun:/vol/luns/my_windows_lun-C4dAFJfXWk8C:write_align_histo.1:0%
lun:/vol/luns/my_windows_lun-C4dAFJfXWk8C:write_align_histo.2:0%
lun:/vol/luns/my_windows_lun-C4dAFJfXWk8C:write_align_histo.3:0%
lun:/vol/luns/my_windows_lun-C4dAFJfXWk8C:write_align_histo.4:0%
lun:/vol/luns/my_windows_lun-C4dAFJfXWk8C:write_align_histo.5:0%
lun:/vol/luns/my_windows_lun-C4dAFJfXWk8C:write_align_histo.6:0%
lun:/vol/luns/my_windows_lun-C4dAFJfXWk8C:write_align_histo.7:100%

6 Overview of Migrations
This chapter provides a high-level overview of a migration. Phase-specific information and in-depth
walkthroughs are provided in the later sections.
The steps presented in Offline Migration overview and Online Migration overview align with NetApp‘s fivephase methodology for migrations as shown in Figure 34. These phases provide a general framework to
help identify where common tasks are performed throughout the entire migration process.
Figure 34) Migration phases.

6.1

Offline Migration Overview

This section provides a brief overview of the offline migration process. Swim lane charts indicate the tasks
that can be performed in parallel in each of the five major components of migration: host, fabric, DTA
configuration, destination storage, and source storage.
Tables 14 through 18 and Figures 35 through 39 break down the major tasks performed in a typical offline
migration utilizing the DTA2800 and the NetApp service methodology.
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Discover Phase
The discover phase focuses on collecting information used for host remediation and creating migration
plans in later steps. The collection of most information is automated using the nSANity data collection tool
(see Figure 35 and Table 14).
Figure 35) Discover workflow.

Table 14) Discover tasks.

Component

Tasks

Host

1. Identify HBA WWPNs (used for zone creation).
2. Identify LUN information (size, serial numbers, partition layouts, and offsets).
3. Identify third-party MPIO configuration.

Fabric

1. Identify host to source storage zones (will be removed postmigration).

DTA

1. Obtain the list of VPG1 WWPNs (used for zone creation and initiator record
creation).

Destination storage

1. Identify WWPNs (used for zone creation).

Source storage

1. Identify WWPNs (used for zone creation).
2. Identify LUNs mapped to the host.
3. Identify initiator records for the host.

Analyze Phase
The analyze phase focuses on items that must be addressed before migration planning (see Table 15).
Proper alignment of each destination LUN must be determined, and host configuration specifics that fall
outside of the NetApp Interoperability Matrix (IMT) must be identified.
For each host, a target configuration (postmigration) is identified and a ―gap analysis‖ is performed to
identify specific components that are not supported. The host analysis should be shared with the
customer immediately upon completion. Required updates might break compatibility with applications
running on each host.

50

DTA Migrations Using NetApp DTA2800 Methodology

Required host changes are typically not made until the actual migration event. This is due to the common
need to schedule maintenance windows. In addition, system updates are frequently done in coordination
with application updates utilizing the same maintenance events. Typically, any changes made to the
MPIO configuration before migration will affect the support of the current storage as well. For example,
removing PowerPath from a host and reconfiguring it to use native MPIO (dm-mp and ALUA on Linux)
might not be supported by the current storage configuration.
Delaying MPIO reconfiguration until after the migration simplifies the process for ―rollback‖ if required. All
plans presented in this document make modifications to the MPIO stack postmigration.
Table 15) Analyze tasks.

Component

Tasks

Host

1. Determine a target configuration (postmigration) for each host (OS configuration,
MPIO, HBA details, Host Utility Kit version).
2. Determine additional NetApp product requirements (SnapDrive®, SnapManager®).
3. Perform a ―gap analysis‖ for each host. Identify required hot fixes/patches, OS
updates, HBA driver, and firmware upgrades required to match the selected target
configuration on the NetApp IMT. In addition, requirements for other NetApp software
to be installed on this host (SnapDrive, SnapManager) should be taken into
consideration.
4. Determine the proper LUN creation steps for properly aligned destination LUNs.
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Plan and Prepare Phase
The plan and prepare phase focuses on tasks required to create detailed migration plans and to make
sure that everything is ready for the actual migration (see Table 16 and Figure 36). The majority of
migration prework is performed during this phase. Initial DTA installation, configuration, and zoning are
performed in this phase. After the end-to-end connectivity is verified, a test migration is performed to
make sure everything is properly configured before beginning production migrations.
Figure 36) Plan and prepare workflow.
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Table 16) Plan and prepare tasks.

Component

Tasks

Fabric

1. Back up the existing zonesets.
2. Zone the DTA to the source storage.
3. Zone the DTA to the destination storage.

DTA

1. Physically install and wire the DTA.
2. Set IP address for both DTA blades.
3. Install license keys.
4. Rescan arrays to discover storage.
5. Verify array connectivity on both blades.
6. Configure arrays (set array type, configure load balancing, set LUN ID style).
7. Verify LUN visibility for test LUNs on both the source and destination storage
(size, paths, and path states).
8. Perform a test migration and verification between source and destination test
LUNs.
9. Apply array-based license (if applicable).

Destination storage

1. Create initiator records for DTA.
2. Create test LUN (1GB).
3. Assign (map/mask) test LUN to DTA igroup.

Source storage

1. Create initiator records for DTA.
2. Create test LUN (1GB).
3. Assign (map/mask) test LUN to DTA igroup.

Execute Phase
The execute phase focuses on the actual LUN migration (see Table 17) Execute tasks. (see Figure 37
and Figure 38). The hosts are rebooted to make sure that there are no underlying issues with the hosts
before major reconfiguration occurs. After the host reboots, it is shut down in preparation for the
migration. After the source and destination LUNs are visible on the DTA, migration jobs can be created
and executed. After migrations are complete, the host is zoned to the destination storage; new LUNs are
mapped; and host remediation can begin for drivers, multipath software, and any other updates that have
been identified in the analyze phase.
When migration and remediation are complete, hosts can be brought up connected to the new destination
storage, and the applications can be verified by end users. A Snapshot™ copy is created at this point to
make sure that the current state is available for rollback if warranted.
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Figure 37) Execute workflow.
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Figure 38) Execute workflow (continued).
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Table 17) Execute tasks.

Component

Tasks

Host

1. Run space reclamation utilities on the volumes to be migrated (if applicable).
2. Reboot the host and verify that all file systems mount, all LUN paths are
available, and services start.
3. Prepare and shut down the host.
4. Bring up the host.
5. Configure the HBA to use new SAN boot LUN (SAN boot only).
6. Uninstall third-party MPIO.
7. Install NetApp MPIO.
8. Verify all paths to SAN boot LUN are healthy (SAN boot only).
9. Update system files and configuration to reflect new devices.
10. Verify all paths to all LUNs are healthy.
11. Reenable all services and reboot host (verify host comes back up, all file
systems mount, all services start).
12. Configure the HBA with the second path to new SAN boot LUN (SAN boot only).

Fabric

1. Create host to destination storage zone.
2. Unzone the host from the source storage.

DTA

1. Rescan arrays to discover new LUNs.
2. Create the migration job.
3. Execute the migration job.
4. Acknowledge the migration job.

Destination storage

1. Create initiator record for host.
2. Create and assign destination LUNs to DTA.
3. Remove destination LUNs from DTA.
4. Create a Snapshot copy to enable rollback of destination LUN.
5. Limit connectivity to a single path (SAN boot only).
6. Assign SAN boot LUN to host; do not assign data LUNs at this point (SAN boot
only).
7. Verify all host ports are logged in.
8. Create periodic Snapshot copies to enable rollback of destination SAN boot LUN
(SAN boot only).
9. Enable all paths to SAN boot LUN (SAN boot only).
10. Assign data LUNs to host.
11. Create final migration Snapshot copy.

Source storage

1. Assign source LUNs to DTA.
2. Remove the source LUNs from DTA.
3. Remove the source LUNs from host.
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Verify Phase
The verify phase focuses on postmigration clean-up process and confirming the accuracy of the
execution of the migration plan (see Table 18 and Figure 39). Older LUNs are removed from the source
storage along with the original host and DTA migration zones. Initiator records on the source and
destination zones are modified as required.
Figure 39) Verification and cleanup flowchart.

Table 18) Verification, cleanup, and postmigration tasks.

Component

Tasks

Host

1. Customer performs application testing.

Fabric

1. Remove host to source storage zones from zoneset.
2. Remove DTA to source storage zones.
3. Remove DTA to destination zones.
4. Back up new zoneset.

DTA

1. Collect migration reports.
2. Clear migration reports.
3. Remove offline arrays from DTA Manager.
4. Reset DTA.

Destination storage

1. Remove DTA initiator groups.
2. Remove manually created Snapshot copies used during the migration process.
3. Verify LUN alignment.
4. Document final configuration.
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Component

Tasks

Source storage

5. Remove host initiator groups.
6. Remove DTA initiator groups.
7. Remove host LUNs.

6.2

Online Migration Overview

This section provides a brief overview of the online migration process. Swim lane charts indicate the tasks
that can be performed in parallel in each of the five major components of migration: host, fabric, DTA
configuration, destination storage, and source storage.
Note: Migration fabric is used only for physical server migration. For virtual server migration, use
production fabric to create presented targets.

Discover
The discover phase focuses on collecting information used for host remediation and creating migration
plans in later steps (see Figure 40 and Table 19). The collection of most information is automated by
using the nSANity data collection tool.
Figure 40) Discover workflow.

Table 19) Discover tasks.

Component

Tasks

Host

1. Identify HBA WWPNs (used for zone creation).
2. Identify LUN information (size, serial numbers, partition layouts, and
offsets).
3. Identify third-party MPIO configuration.

Production fabric

1. Identify host to source storage zones (will be removed postmigration).
2. Identify switch port number to which host HBA is connected.

DTA
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Component

Tasks

Destination storage

1. Identify WWPNs (used for zone creation).

Source storage

2. Identify WWPNs (used for zone creation).
3. Identify LUNs mapped to the host.
4. Identify initiator records for the host.

Analyze
The analyze phase focuses on items that must be addressed before migration planning (see Table 20).
Proper alignment of each destination LUN must be determined, and host configuration specifics that fall
outside of the NetApp Interoperability Matrix (IMT) must be identified.
For each host, a target configuration (postmigration) is identified, and a ―gap analysis‖ is performed to
identify specific components that are not supported. The host analysis should be shared with the
customer immediately upon completion. Required updates might break compatibility with applications
running on each host.
Required host changes are typically not made until the actual migration event. This is due to the common
need to schedule maintenance windows. In addition, system updates are frequently done in coordination
with application updates utilizing the same maintenance events. Typically, any changes made to the
MPIO configuration before migration will affect the support of the current storage as well. For example,
removing PowerPath from a host and reconfiguring it to use native MPIO (dm-mp and ALUA on Linux)
might not be supported by the current storage configuration.
Delaying MPIO reconfiguration until after the migration simplifies the process for ―rollback‖ if required. All
plans presented in this document make modifications to the MPIO stack postmigration.
Table 20) Analyze tasks.

Component

Tasks

Host

1. Determine a target configuration (postmigration) for each host (OS configuration,
MPIO, HBA details, Host Utility Kit version).
2. Determine additional NetApp product requirements (SnapDrive, SnapManager).
3. Perform a ―gap analysis‖ for each host. Identify required hot fixes/patches, OS
updates, HBA driver, and firmware upgrades required to match the selected
target configuration on the NetApp IMT. In addition, requirements for other
NetApp software to be installed on this host (SnapDrive, SnapManager) should
be taken into consideration.
4. Determine the proper LUN creation steps for properly aligned destination LUNs.
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Plan and Prepare
The plan and prepare phase focuses on tasks required to create detailed migration plans and to make
sure that everything is ready for the actual migration (Table 21 and Figure 41). The majority of migration
prework is performed during this phase. Initial DTA installation, configuration, and zoning are performed
in this phase. After end-to-end connectivity is verified, a test migration is performed to make sure
everything is properly configured before beginning production migrations.
Figure 41) Plan and prepare workflow.

Table 21) Plan and prepare tasks.

Component

Tasks

Production fabric

1. Make sure NPIV is enabled in the production fabric.
2. Back up existing zonesets.
3. Zone the DTA to the source storage (Zone 1, Zone 2).
4. Zone the DTA to the destination storage (Zone 3, Zone 4).
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Component

Tasks

DTA

5. Physically install and wire the DTA to production and migration fabric Blade 1
and 2, FC ports 1–4).
6. Set IP address for both DTA blades.
7. Install license keys.
8. Rescan arrays to discover storage.
9. Verify array connectivity on both blades.
10. Configure arrays (set array type, configure load balancing, set LUN ID style).
11. Verify LUN visibility for test LUNs on both the source and destination storage
(size, paths, path states).
12. Perform a test migration and verification between source and destination test
LUNs.
13. Apply array-based license (if applicable).

Destination storage

1. Create initiator records for DTA.
2. Create test LUN (1GB).
3. Assign (map/mask) test LUN to DTA igroup.

Source storage

1. Create initiator records for DTA.
2. Create test LUN (1GB).
3. Assign (map/mask) test LUN to DTA igroup.

Execute
The execute phase focuses on the actual LUN migration tasks (Table 22, Figure 42, and Figure 43).
Individual tasks include:
1. Map source and destination LUNs to DTA.
2. Present the source LUNs to the host through DTA removing direct access from source storage.
3. Perform migration steps and configure online migration job while the host is up.
4. After copy is complete, shut down the host and acknowledge the job.
5. After the migrations are complete, the host is zoned to the destination storage; new LUNs are
mapped; and the host remediation for drivers, multipath software, and any other updates identified in
the analyze phase can begin.
When migration and remediation are complete, hosts can be brought up connected to the new destination
storage, and the applications can be verified by end users. A Snapshot copy is created at this point to
make sure the current state is available for rollback if warranted.
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Figure 42) Execute workflow.
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Figure 43) Execute workflow - cont'd.
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Figure 44) Execute workflow - cont'd.
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Table 22) Execute tasks.

Component

Tasks

Host

Premigration

1. Run space reclamation utilities on the volumes to be migrated (if applicable).
Migration

1. Verify that all file systems mount and all LUN paths are available and running
application services.
2. Verify all paths to all LUNs are healthy and running applications (after moving
host HBA to migration fabric from production fabric).
3. Prepare and shut down host.
Postmigration

1. Bring up host.
2. Configure HBA to use new SAN boot LUN (SAN boot only).
3. Uninstall third-party MPIO.
4. Install NetApp MPIO.
5. Verify all paths to SAN boot LUN are healthy (SAN boot only).
6. Update system files and configuration to reflect new devices.
7. Verify all paths to all LUNs are healthy.
8. Reenable all services and reboot host (verify host comes back up, all file
systems mount, all services start).
9. Configure HBA with second path to new SAN boot LUN (SAN boot only).
Migration fabric
(physical server
migration)

Physical Server Migration
Premigration

1. Make sure NPIV is enabled in the migration fabric.
2. Back up existing zonesets.
3. Create port zone using DTA FC3 and FC4 port number and the host HBA
port number (Zone 7, Zone 8, Zone 9, and Zone 10). Do not move host
HBA to migration fabric yet but create the zone using the port number.
4. Add port zone to zoneset or zoneconfig and activate.
Migration:
5. Move host connection from Production Fabric A to Migration Fabric A.
6. Move host connection from Production Fabric B to Migration Fabric B.
Postmigration
1. Move host connection from Migration Fabric A to Production Fabric A.
2. Move host connection from Migration Fabric B to Production Fabric B.
Production fabric

Physical Server Migration
Postmigration

1. Unzone host from source storage.
2. Create host to destination storage zone.
Virtual Server Migration
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Component

Tasks
Premigration

1. Create WWPN zone using DTA PT WWPNs and host HBA WWPN in both the
fabrics.
2. Add zones to zoneset or zoneconfig and activate.
Migration:
3. Remove direct path from host to source storage. (Unzone host from source
storage.)
Postmigration
1. Unzone host to DTA PT zones.
2. Create host to destination storage zone
DTA

Premigration

1. Rescan arrays to discover new LUNs.
2. Create initiator (host) records on the DTA for each host on each blade.
3. Create a LUN mask for each LUN for each initiator on both blades.
Physical Server
1. Create a presented target (mapped target) for each source storage port on
both the blades. (Spoof source storage ports in migration fabric.)
2. Presented target WWPN is same as source storage target WWPN (for
example, PT WWPN on BL1 FC3 is same as Ctrl1 0a WWPN):
BL1 FC3 <-> Ctrl1 0a
BL1 FC4 <-> Ctrl2 0b
BL2 FC3 <-> Ctrl2 0a
BL2 FC4 <-> Ctrl1 0b
Virtual Server

1. Create a presented target (mapped target) for each source storage port on
both the blades. (Spoof source storage ports in production fabric.)
2. Presented target WWPN is different from source storage target WWPN (for
example, PT WWPN on DTA BL1 FC1 is same as DTA BL1 FC1 VPG1
WWPN with 64 as second octet):
BL1 FC1 <-> Ctrl1 0a
BL1 FC2 <-> Ctrl2 0b
BL2 FC1 <-> Ctrl2 0a
BL2 FC2 <-> Ctrl1 0b
Migration

1. Create online migration job.
2. Execute and monitor migration job.
3. Verify migration job completion. Do NOT acknowledge the job at this time.
4. Remove LUN masks (unpresent LUNs from the DTA to the host). Verify LUNs
are not presented to the initiator (host).
5. Acknowledge migration job.
6. Configure verify job (optional).
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Component

Tasks
Postmigration

1. Remove initiator records from DTA.
2. Remove presented targets.
Destination storage

1. Create initiator record for host.
2. Create and assign destination LUNs to DTA.
3. Remove destination LUNs from DTA.
4. Create Snapshot copy to enable rollback of destination LUN.
5. Limit connectivity to a single path (SAN boot only).
6. Assign SAN boot LUN to host, do not assign data LUNs at this point (SAN
boot only).
7. Verify all host ports are logged in.
8. Create periodic Snapshot copies to enable rollback of destination SAN boot
LUN (SAN boot only).
9. Enable all paths to SAN boot LUN (SAN boot only).
10. Assign data LUNs to host.
11. Create final migration Snapshot copy.

Source storage

1. Assign source LUNs to DTA.
2. Remove source LUNs from host.
3. Remove source LUNs from DTA.

Verify
The verify phase focuses on the postmigration clean-up process and confirming the accuracy of the
execution of the migration plan (see Figure 45 and Table 23). Older LUNs are removed from the source
storage along with original host and DTA migration zones. Initiator records on the source and destination
zones are modified as required.
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Figure 45) Verification and cleanup flowchart.

Table 23) Verification, cleanup, and postmigration tasks.

Component

Tasks

Host

1. Customer performs application testing.

Production fabric

1. Remove host to source storage zones from zoneset.
2. Remove DTA to source storage zones.
3. Remove DTA to destination zones.
4. Back up new zoneset.

Migration fabric (physical
server migration)

1. Remove DTA to host zones.

DTA

1. Collect migration reports.
2. Clear migration reports.
3. Remove offline arrays from DTA Manager.
4. Reset DTA.

Destination storage

1. Remove DTA initiator groups.
2. Remove manually created Snapshot copies used during the migration
process.
3. Verify LUN alignment.
4. Document final configuration.

Source storage

1. Remove host initiator groups.
2. Remove DTA initiator groups.
3. Remove host LUNs.
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6.3

Supported Operating Systems

The list of supported operating systems changes as engineering qualifies configurations in the lab. Refer
to the NetApp Interoperability Matrixif you have any concerns regarding support of a specific
configuration.


All NetApp supported configurations (per the IMT) are supported as destination MPIO (for example,
Windows 2008 supported destination MPIO configurations include MSDSM and Data ONTAP DSM).



The data migration program will provide support for the configurations in the NetApp Interoperability
Matrix.



Additional MPIO stacks will be supported in the future.



Additional MPIO configurations might work, but migration plans are not available, and configurations
might not have been tested.



Customer environments vary greatly; the configurations in the NetApp Interoperability Matrix should
be used as a guideline.



Boot from SAN is supported on all configurations unless specifically noted.
Data Migration Best Practice
NetApp recommends that all configurations be tested in a customer test environment before migrating
of production data.

7 NetApp Five-Phase Methodology for Offline and Online Migrations
This chapter provides an in-depth walkthrough of an offline and online migration. Specific details are
presented for an EMC CX700 source array and Windows 2003, Linux RHEL5, and Solaris 10 hosts with
both local boot and boot from SAN scenarios.
The steps follow NetApp‘s five-phase methodology for migrations (Figure 46).
Figure 46) NetApp’s five-phase migration methodology.

Support Note


Discover, analyze, plan, and verify phases are common for offline and online migrations.



Execute phase varies for offline and online migrations.

7.1

Discover Phase

The discover phase collects specifics of the customer environment to provide information necessary for
successful planning and execution of the migration.
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Gather Information Using nSANity
nSANity Diagnostic and Configuration Data Collector (nSANity) is used primarily to collect data for
migrations that use the DTA2800. nSANity runs a series of predefined remote commands against a
variety of possible components gathering diagnostics and configuration data. The collected data is stored
as a gzip XML file and may be viewed and/or parsed using NetApp Data Center Planner (NDCP).
Note:

For more information regarding the list of supported components, consult the readme file included
as part of the software distribution.

The syntax used for collection of Windows, Linux, and Solaris hosts; Cisco and Brocade switches; and
NetApp storage is as follows:


Windows Syntax

nsanity windows://[[domain|host\]username[:password | *]@]windows_server



Linux Syntax

nsanity linux://username:password@linux_server_ip_address



Solaris Syntax

nsanity solaris://username:password@solaris_server_ip_address



Cisco Syntax

nsanity cisco://username:password@cisco_switch_ip_address



NetApp Syntax

nsanity ontap://username:password@NetappController_switch_ip_address



Windows Host Example


Using plain text password:

nsanity windows://netapp\administrator:migrate@10.61.187.35



Prompting for password:

nsanity windows://netapp\administrator:*@10.61.187.35

Support Note


nSANity remotely performs data collection from the components.



Mac OS X and Linux binaries cannot collect Windows component data.



nSANity can be run locally on a Windows host using loopback address 127.0.0.1.



nSANity should be run against at least one switch in each fabric and all hosts included in the
migration scope.

Run EMC SP Collect with EMC CX700
SP Collect provides configuration and diagnostic information for the storage system similar to NetApp
AutoSupport™. Frame configuration information such as model, FLARE release, disk layout, LUN
mappings, and storage groups is necessary for data migration planning and execution. After collected,
the files are parsed with NDCP.
To create and transfer an SP collect file, complete the following steps:
1. Log in to Navisphere as an administrator.
Expand the frame on which the information is to be collected, then right-click each SP and select
SPCollect. At the prompt, click Yes.
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Note:

It might take 5–10 minutes for SP Collect to complete.

2. Right-click SP Collect and select File Transfer Manager.

3. Expand the Name column and sort the files by date and search for a file with a current date that is
named <frame SID>_<SP#>_<date>_data.zip.
4. Browse to the destination directory, select the preceding file in the Files on SP window, and click
Transfer. At the prompt, click Yes.
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Note:

Individual transfer operations cannot be aborted. The Cancel button is provided to stop a batch
operation.

The transferred file can be viewed in the NDCP Parser screen.

NetApp Data Center Planner (NDCP)
NetApp Data Center Planner (NDCP) is an application suite composed of utilities that assist in data
migration. The application GUI consists of the Viewer and Parser tabs. The Viewer tab is used to view
details of nSANity files. The left pane provides a tree view of the top-level nodes corresponding to the
loaded file, and the right pane shows the details of the node selected in the left pane. The Parser tab is
used to parse nSANity or SPCollect files and present the parsed content in a tabular format. The parsed
content can be exported to formats such as csv, xls, yaml, and json.

Open nSANity Files in the NDCP Viewer Tab
To open nSANity files in the NDCP Viewer tab, complete the following steps:
1. In the Viewer tab, select File > Open and select the required nSANity file.
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2. Select the gzip XML file to open.

Note:

Use the Shift key to select multiple files.

3. From the left pane, expand the tree view of a loaded file and select an item. The details of this item
are displayed in the right pane.

Open nSANity Files in the NDCP Parser Tab
To open nSANity and SPCollect files in the NDCP Parser tab, complete the following steps:
1. In the Parser tab, click File > Open. Select File or Directory. Select nsanity or spcollect and click Next.
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2. Select the file or directory to open.

Note:

Use the Shift key to select multiple files.

3. Each tab in the right pane represents different elements of the components selected in the left pane.
This information will be used to complete the Site Survey and Plan document associated with the
data migration project.
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Migration Site Survey and Plan
The HeSAN Migration Site Survey and Data Migration Plan document provides a centralized repository of
detailed information for hosts, storage, and fabric components.
The Site Survey and Plan document‘s Questionnaire tab (Figure 47) contains a survey that should be
used to gather high-level knowledge about the customer‘s environment.
Figure 47) Site survey and plan - questionnaire.

The following subsections provide an overview for each tab of the Site Survey and Plan document, and,
where necessary, the information to complete each sheet can be retrieved using NDCP Parser.

Host Information
Figure 48 and Table 24 provide an overview of the Hosts tab.
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Figure 48) Hosts tab.

Table 24) Hosts tab input from NDCP Parser output.

Hosts Tab
Site Survey Column

NDCP ParserTab

NDCP ParserColumn

Hostname

Host

hostname

IP Address

Host

collection target

OS Version

Host

os_major_rev

Platform

Host

cpu_type

Architecture

Host

cpu_desc

Service Pack

Cluster

os_minor_rev

Host

is_clustered
cluster_name
cluster_members

Volume Manager

FS List

File System

FS List

MPIO

Host

Adapter

HBA List

parent_os_dev
type
mpio/dsm

manuf
model

Driver

HBA List

driver

Firmware

HBA List

fw

Note:

Enter the information for each of the hosts in the migration in the ―Hosts‖ tab.

Switch Information
Figure 49 and Table 25 provide an overview of the Switches tab.
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Figure 49) Switches tab.

Table 25) Switches tab input from NDCP Viewer output.

Switch Tab
Site Survey Column

NDCP Viewer Element

Hostname

show switchname

Vendor

show hardware

Firmware

show module

Support Note


Switch details can be gathered by running nSANity against a switch. The nSANity file can then be
imported into NDCP Viewer to obtain the required switch information.



A minimum of a single "primary" path is required to each controller owning a LUN that will be
included in the migration. Additional paths through other controllers provide a degree of resiliency
in the event of a fabric or storage controller outage.

HBA and Zone Information
Figure 50 and Table 26 provide an overview of the HBA and Zone tab.
Figure 50) HBA and Zone Information tab.

Table 26) HBA and Zone Information tab input from NDCP Parser output.

HBA and Zone Information
Site Survey Column
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NDCP Parser Column

HBA and Zone Information
Hostname

HBA List

hostname

WWPN

HBA List

Wwpn

HBA Port Number in Fabric

NDCP Viewer element
show flogi database

Cross-referenced by WWPN

Fabric Name

NDCP Viewer element
show flogi database

Cross-referenced by WWPN

Pre-migration Zone Membership

NDCP Viewer element
show zoneset active

Cross-referenced by WWPN

Post-migration Zone Membership

Host to Destination Zone Name

Note:

Premigration zones must be identified so they may be replaced postmigration.

Source LUN Information
Figure 51 and Table 27 provide an overview of the Source LUNs tab.
Figure 51) Source LUNs tab.

Table 27) Source LUNs tab input from NDCP Parser output.

Source LUNs
Site Survey Column

NDCP Parser Tab

NDCP Parser Column

Storage Group Name

SP Collect output – Storage Maps

Storage Group Name

Host LUN ID

SP Collect output – Storage Maps

Array LUN ID

SP Collect output – Storage Maps
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ALU mapped to HLU mapped to LUN UUID
(to the right of -> symbol, see Figure 52 and
Figure 53).
ALU mapped to HLU mapped to LUN UUID (to
the left of -> symbol, see Figure 53)

Source LUNs
LUN UUID

SP Collect output – CX LUNs List

LUN UUID (cross-referenced by Array LUN ID)

LUN Name

SP Collect output – CX LUNs List

LUN Name (cross-referenced by Array LUN ID)

Figure 52 and Figure 53 illustrate the host and array LUN IDs in NDCP Parser output.
Figure 52) Host LUN ID in NDCP Parser output.

Figure 53) Array LUN ID in NDCP Parser output.

Figure 54 and Table 28 provide LUN alignment information by OS type and procedures.
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Figure 54) LUN alignment information.

Table 28) LUNs alignment details from NDCP Viewer output.

LUN Alignment Details
OS Type

Procedure

Windows

Partition offset can be found in the nSANity data using SANView or NDCP Viewer; open the
SAN and select the Win32_DiskPartition element.
Partition Offset = StartingOffset (see Figure 55)

Linux

Starting sector can be found in the nSANity data using SANView or NDCP Viewer; select the
sfdisk –uS –l element.
Starting sector = Start (see Figure 56)
Partition Offset = Start sector * 512

Solaris

Starting sector can be found in the nSANity data using SANView or NDCP Viewer; select
the prtvtoc element.
Starting sector = First Sector (see Figure 57)
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Figure 55) Windows LUN starting offset in NDCP Viewer output.

Figure 56) Linux LUN start sector in NDCP Viewer output.
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Figure 57) Solaris LUN first sector in NDCP Viewer output.

Note:

Alignment needs to be reviewed for all LUNs on which a partition exists, including disks that are
RDMs or part of an LVM volume group.

Storage Group Information
Figure 58 and Table 29 provide an overview of the Storage Groups tab.
Figure 58) Storage Groups tab.
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Table 29) Storage Groups tab input from NDCP Parser output.

Storage Groups
Site Survey Column

NDCP Parser Tab

NDCP Parser column

Hostname

SP Collect output – Storage Maps

Server name

Storage Group Name

SP Collect output – Storage Maps

Storage Group Name

WWPN

HBA List

wwpn (cross-referenced by Hostname)

Igroup commands

Igroups

igroup command (cross-referenced by
Hostname)

Note:

Information for the DTA also should be added to the Storage Groups tab and igroup commands
created. Gathering of this information is covered in the DTA information section.

LUN Details Information
Figure 59 and Table 30 provide an overview of the LUN Details tab.
Figure 59) LUN Details tab.

Table 30) LUN Details tab input from NDCP Parser output.

LUN Details
Site Survey Column

NDCP Parser Tab

NDCP Parser Column

Host Name

SP Collect output – Storage Maps

hostname

Storage Group

SP Collect output – Storage Maps

Storage Group Name

Operating System

Hosts

os_major_rev

Clustered

Hosts

is_clustered

Storage Controller

SP Collect output – Storage-Controller List

Controller Name

Mount Point

FS List

mount_point

Physical Drive Number

LUN List

os_dev

Port

LUN List

port

Bus

LUN List

bus

Target

LUN List

target
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LUN Details
LUN

LUN List

lun_id

PG80 SN

LUN List

pg80 sn

PG83 SN/UID

LUN List

pg83 sn

LUN Size (GB)

LUN List

size

Starting Offset

Partition List

offset

LUN Type

LUN List

alignment_lun_type

Alignment Information

LUN List

alignment_info

Custom Prefix

LUN List

commands (-P option value, see
Figure 60).

Figure 60 highlights custom prefixes in NDCP Parser output.
Figure 60) Custom prefix in NDCP Parser output.

Storage System Information
Figure 61 and Table 31 provide an overview of the Storage Devices tab.
Figure 61) Storage Devices tab.
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Table 31) Storage Devices tab from NDCP Parser output.

Storage System
Site Survey Column

NDCP Parser Tab

NDCP Parser Column

Hostname

SP Collect output — Storage-Controller
List

Array Name

IP Address

Navisphere

Vendor

SP Collect output—Components

system_type

Array Model

SP Collect output—Storage-Controller List

Controller Model

Microcode FW/Data ONTAP

SP Collect output—Storage-Controller List

Controller HW

Controller/Node

SP Collect output: Storage-Controller List

Controller HW

SP Collect output: Storage-Array List

Base WWN

Port Name

See Table 32.

Cross-referenced by 4th octet of
WWPN

WWPN

NDCP Viewer element
show flogi database

Cross-referenced by Base WWN

Fabric Name

NDCP Viewer element
show flogi database

cross-referenced by Base
WWPN

Target Type

Array may be a source or destination
during migration

Support Note
NetApp controller information can be gathered using nSANity and viewed using NDCP Viewer.

Table 32 provides the mapping information for EMC CX ports.
Table 32) EMC CX port mapping.

Clariion Port WWN Map
SP Name

SPB

4th Octet of WWPN

SP Port ID

7

6F

SP Port ID

6

6E

SP Port ID

5

6D

SP Port ID

4

6C

SP Port ID

3

6B

SP Port ID

2

6A

SP Port ID

1

69

SP Port ID

0

68
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Clariion Port WWN Map
SP Name

SPA

4th octet of WWPN

SP Port ID

7

67

SP Port ID

6

66

SP Port ID

5

65

SP Port ID

4

64

SP Port ID

3

63

SP Port ID

2

62

SP Port ID

1

61

SP Port ID

0

60

Support Note
This conversion is for EMC Clariion frames only.
Example
WWN for SP B7 Port: 50:06:01:6F:3B:20:47:8C, 4th octet is 6F, this relates to SPB, port 7 in Table 32.

DTA Information
Figure 62 and Table 33 provide an overview of the DTAs tab.
Figure 62) DTAs tab.

Table 33) NetApp DTA systems tab from DTA CLI output.

NetApp DTA Systems
Site Survey Column

Data Location

Hostname

Host name to be used for DTA
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NetApp DTA Systems
Chassis Serial Number

show chassis

Blade

connected to a blade, ―show system‖

Port

connected to a blade, ―show fc‖

IP Address

connected to a blade, ―show mgmt‖

WWPN

connected to a blade, ―show fc‖

Fabric Name

Switches flogi database cross-referenced by WWPN

Support Note
Information may also be gathered for the DTA using the serial connection as the guest user. If you
have problems gaining serial port access, refer to NetApp KB article 1013261.
To access a DTA using the serial port, complete the following steps:
1. Connect each blade‘s serial port using terminal emulation software such as PuTTY.
2. In the Category pane, select serial and set options controlling local serial lines.

3. Log in to DTA using the credentials username: guest, password: password.
4. Connect to blade by typing "blade 1" or "blade 2" and then execute necessary commands.
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DTA Setup Notes
The information collected determines the proper physical wiring for the DTA.


Will one or both DTA blades be utilized?



What migration topology is used?



If SAN attached:



Is the fabric single or dual?



Identify available ports close to the storage for the DTA.



Identify ports on the same switch and blade for highly oversubscribed switches.

7.2

Analyze

The analyze phase focuses on items that must be addressed before proceeding with the migration
activities. The proper alignment of each destination LUN must be determined, and host configuration
information must be compared to supported configurations documented in the NetApp Interoperability
Matrix.

Determine Proper Destination LUN Alignment
A LUN may be configured with multiple partitions. A custom prefix is used to align a single partition. The
data or most I/O-intensive partition is the one that should be analyzed for alignment.
Table 34 provides alignment information by OS and LUN type.
Table 34) Alignment information in LUN details tab of site survey and plan.

Alignment Information
OS Type

LUN Type

Partition Offset

Windows

windows_2008

MOD(partition offset, 4096)
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Alignment Information
Linux

linux

MOD(partition offset, 4096)

Solaris

solaris or solari_efi

default offset

Note:

Custom prefix for Windows is provided by NDCP Parser. See the LUN Details Information sheet
in Migration Site Survey and Plan.

Table 35 provides alignment information for Solaris LUN type.
Table 35) Solaris LUN type.

Alignment Information
LUN Type

LUN Size

File System

solaris

< 990GB

UFS

solaris_efi

> 990GB

UFS

solaris

Any

VxVm and VxFS

solaris

Any

ZFS

Host Compatibility Check
NetApp Interoperability Matrix (IMT) is a web-based utility that enables searching for information about
configurations for NetApp products that work with third-party products and components qualified by
NetApp.
IMT contains both supported and certified NetApp configurations. Supported configurations are those
qualified by NetApp. Certified configurations are those qualified by a third-party company to work with
NetApp components.
You can download the Interoperability Matrix Tool User's Guide from
http://support.netapp.com/matrix/help-cms/pdf/User%20Guide.pdf.
IMT Best Practice


Enter the NetApp IMT recommendations for required software and upgrades into the ―Switches‖
and ―Hosts‖ tabs of the Site Survey and Plan document.



Start by entering static information, such as Data ONTAP OS, protocol, and CF mode, into the
IMT. Then, using the Site Survey as a filter guide, enter host OS, Volume Manager, and HBA
information.



Do not be so specific as to have no results returned; it is better to view multiple returned results
and choose the best fit.



Host HBAs are sometimes reported on the OEM part number and will need to be cross-referenced
before they are entered into the IMT.

Note:

Check each host against the IMT for supportability.

Create the Gap Analysis Report
The gap analysis is a report of the customer‘s current and NetApp recommended environment. It
presents all recommended upgrades to the customer‘s environment that will need to take place
postmigration. PVRs might need to be submitted if the customer‘s environment is not able to support the
recommended upgrades.
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The target configuration (postmigration) includes details for each host (OS configuration, MPIO, HBA
details, Host Utility Kit version, and so on). Information about additional NetApp required products, such
as SnapDrive and SnapManager, is also available.
Changes required are typically not made until the actual migration event, because of the usual need to
schedule maintenance windows. Typically, any changes made to the MPIO configuration before migration
will affect the support of the current storage as well.
The completed NetApp Recommended section in the Hosts tab of the Site Survey and Plan document will
serve as the gap analysis report (Figure 63). The gap analysis must be completed for every host included
in the migration project. The completed gap analysis report must be reviewed with the customer.
Figure 63) Gap analysis report.

7.3

Plan and Prepare

The plan and prepare phase focuses on tasks required to create detailed migration plans and prepare the
customer environment for actual migration. A test migration is performed during this phase to verify the
installation and setup of the DTA.

Insert and Configure DTA
Wire the DTA into the fabric based on your planning information and recommended best practices (Figure
64 and Figure 65).
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Figure 64) Fabric connectivity of DTA in production fabric for offline and virtual server online migration.

Figure 65) Fabric connectivity of DTA in migration fabric for physical server online migration only.
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DTA Wiring Best Practice



Each DTA blade is wired as a separate host.
Migration fabric is used for physical server online migration only.



Fibre Channel port FC1 on each blade connects to Production Fabric A, and Fibre Channel port
FC2 on each blade connects to Production Fabric B.



Fibre Channel port FC3 on each blade connects to Migration Fabric A, and Fibre Channel port FC4
on each blade connects to Migration Fabric B.



Do not move host HBA cables to migration fabric until host insertion step in execution phase.

To configure the IP address on the DTA, complete the following steps:
1. Connect to the blade1 serial port using terminal emulation software such as PuTTY.
2. In the Category pane, select Serial, and set the options to control the local serial lines.

3. Log in to DTA using these credentials: username: guest, password: password.
4. Connect to blade 1 and type blade 1.
5. Enter Admin Session, and type admin start, password: config.
6. Set management port information and type set mgmt.
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7. Repeat the IP address configuration steps on blade 2.

Install License Keys
To install the license keys, complete the following steps:
1. Launch the DTA Manager and connect using the IP address of Blade 1.

2. Select Blade 1 from the left pane.
3. Select the Features tab from the right pane and click Add. Enter license key and click OK.
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4. Repeat the license key installation on Blade 2 using the appropriate license keys.
Note:

Array license keys will be associated with an array in later steps.

Configure Switch Zone
To create required zones on the SAN switches for connecting the source storage to the DTA, complete
the following steps:
Note:

Use migration fabric zones only for physical server online migration.

1. Back up the existing zonesets on each switch in the production and migration fabric.


Brocade Fabric

configUpload -all -local save



Cisco Fabric

copy running-config save

2. Zone the source storage and DTA as shown in Figure 66.
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Figure 66) DTA and source storage zoning.

ZNE_DTA10_FC1_CX700_P0
21:00:00:c0:dd:19:48:e6 (DTA10 BL1 FC1 in Production Fabric A)
21:00:00:c0:dd:19:48:f0 (DTA10 BL2 FC1 in Production Fabric A)
50:06:01:60:30:60:0e:b6 (CX700 SPA P0 in Production Fabric A)
50:06:01:68:30:60:0e:b6 (CX700 SPB P0 in Production Fabric A)

ZNE_DTA10_FC2_CX700_P1
21:00:00:c0:dd:19:48:e7 (DTA10 BL1 FC2 in Production Fabric B)
21:00:00:c0:dd:19:48:f1 (DTA10 BL2 FC2 in Production Fabric B)
50:06:01:61:30:60:0e:b6 (CX700 SPA P1 in Production Fabric B)
50:06:01:69:30:60:0e:b6 (CX700 SPB P1 in Production Fabric B)


Brocade Fabric
a. Create the zone and add it to the zoneset in production fabric A.

zoneCreate "DTA10_VPG1_CX700", "21:00:00:c0:dd:19:48:e6"
zoneAdd "DTA10_VPG1_CX700", "21:00:00:c0:dd:19:48:f0"
zoneAdd "DTA10_VPG1_CX700", "50:06:01:60:30:60:0e:b6"
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zoneAdd "DTA10_VPG1_CX700", "50:06:01:68:30:60:0e:b6"
cfgAdd "PROD_LEFT", "DTA10_VPG1_CX700"

b. Activate the zoneset in fabric A.
cfgEnable "PROD_LEFT"
cfgSave

c.

Create the zone and add it to the zoneset in production fabric B.

zoneCreate "DTA10_VPG1_CX700", "21:00:00:c0:dd:19:48:e7"
zoneAdd "DTA10_VPG1_CX700", "21:00:00:c0:dd:19:48:f1"
zoneAdd "DTA10_VPG1_CX700", "50:06:01:61:30:60:0e:b6"
ZoneAdd "DTA10_VPG1_CX700", "50:06:01:69:30:60:0e:b6"
cfgAdd "PROD_RIGHT", "DTA10_VPG1_CX700"

d. Activate the zoneset in production fabric B.
cfgEnable "PROD_RIGHT"
cfgSave



Cisco Fabric
a. Create the zone and add it to the zoneset in production fabric A.

conf t
zone name DTA10_VPG1_CX700 vsan 10
member pwwn 21:00:00:c0:dd:19:48:e6
member pwwn 21:00:00:c0:dd:19:48:f0
member pwwn 50:06:01:60:30:60:0e:b6
member pwwn 50:06:01:68:30:60:0e:b6
zoneset name PROD_LEFT vsan 10
member DTA10_VPG1_CX700
exit

b. Activate the zoneset in production fabric A.
zoneset activate name PROD_LEFT vsan 10
end
copy running-config startup-config

c.

Create the zone and add it to zoneset in production fabric B.

conf t
zone name DTA10_VPG1_CX700 vsan 10
member pwwn 21:00:00:c0:dd:19:48:e7
member pwwn 21:00:00:c0:dd:19:48:f1
member pwwn 50:06:01:61:30:60:0e:b6
member pwwn 50:06:01:69:30:60:0e:b6
zoneset name PROD_RIGHT vsan 10
member DTA10_VPG1_CX700
exit

d. Activate the zoneset in production fabric B.
zoneset activate name PROD_RIGHT vsan 10
end
copy running-config startup-config

3. Zone the destination storage and DTA as shown in Figure 67.

96

DTA Migrations Using NetApp DTA2800 Methodology

Figure 67) DTA and destination storage zoning.

ZNE_DTA_FC1_FAS6080_0b
21:00:00:c0:dd:19:48:e6 (DTA10 BL1 FC1 in Production Fabric A)
21:00:00:c0:dd:19:48:f0 (DTA10 BL2 FC1 in Production Fabric A)
50:0a:09:85:87:39:a5:80 (FAS6080 C1 0b in Production Fabric A)
50:0a:09:85:97:39:a5:80 (FAS6080 C2 0b in Production Fabric A)

ZNE_DTA_FC2_FAS6080_0d
21:00:00:c0:dd:19:48:e7 (DTA10 BL1 FC2 in Production Fabric B)
21:00:00:c0:dd:19:48:f1 (DTA10 BL2 FC2 in Production Fabric B)
50:0a:09:83:87:39:a5:80 (FAS6080 C1 0d in Production Fabric B)
50:0a:09:83:97:39:a5:80 (FAS6080 C2 0d in Production Fabric B)


Brocade Fabric
a. Create the zone and add it to the zoneset in production fabric A.

zoneCreate "DTA10_VPG1_FAS6080", "21:00:00:c0:dd:19:48:e6"
zoneAdd "DTA10_VPG1_FAS6080", "21:00:00:c0:dd:19:48:f0"
zoneAdd "DTA10_VPG1_FAS6080", "50:0a:09:85:87:39:a5:80"
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zoneAdd "DTA10_VPG1_FAS6080", "50:0a:09:85:97:39:a5:80"
cfgAdd "PROD_LEFT", "DTA10_VPG1_FAS6080"

b. Activate the zoneset in production fabric A.
cfgEnable "PROD_LEFT"
cfgSave

c.

Create the zone and add it to the zoneset in production fabric B.

zoneCreate "DTA10_VPG1_FAS6080", "21:00:00:c0:dd:19:48:e7"
zoneAdd "DTA10_VPG1_FAS6080", "21:00:00:c0:dd:19:48:f1"
zoneAdd "DTA10_VPG1_FAS6080", "50:0a:09:83:87:39:a5:80"
zoneAdd "DTA10_VPG1_FAS6080", "50:0a:09:83:97:39:a5:80"
cfgAdd "PROD_RIGHT", "DTA10_VPG1_FAS6080"

d. Activate the zoneset in production fabric B.
cfgEnable "PROD_RIGHT"
cfgSave



Cisco Fabric
a. Create the zone and add it to the zoneset in production fabric A.

conf t
zone name DTA10_VPG1_FAS6080 vsan 10
member pwwn 21:00:00:c0:dd:19:48:e6
member pwwn 21:00:00:c0:dd:19:48:f0
member pwwn 50:0a:09:85:87:39:a5:80
member pwwn 50:0a:09:85:97:39:a5:80
zoneset name PROD_LEFT vsan 10
member DTA10_VPG1_FAS6080
exit

b. Activate the zoneset in fabric A.
zoneset activate name PROD_LEFT vsan 10
end
copy running-config startup-config

c.

Create the zone and add it to the zoneset in production fabric B.

conf t
zone name DTA10_VPG1_FAS6080 vsan 10
member pwwn 21:00:00:c0:dd:19:48:e7
member pwwn 21:00:00:c0:dd:19:48:f1
member pwwn 50:0a:09:83:87:39:a5:80
member pwwn 50:0a:09:83:97:39:a5:80
zoneset name PROD_RIGHT vsan 10
member DTA10_VPG1_FAS6080
exit

d. Activate the zoneset in production fabric B.
zoneset activate name PROD_RIGHT vsan 10
end
copy running-config startup-config

Verify Source Array Connectivity in DTA Manager
To verify connectivity to the source array, complete the following steps:
1. Connect to the DTA using NetApp DTA Manager.
2. In left pane, expand Blade 1, expand FC Discovered Targets, and verify that all WWPNs associated
with the source storage array are visible. If all target WWPNs are not shown, verify the zoning.
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3. Repeat the verification of source storage array connectivity on Blade 2. Both arrays should have
identical target port visibility.

Verify Destination Array Connectivity in DTA Manager
To verify connectivity to the destination array, complete the following steps:
1. Connect to the DTA using NetApp DTA Manager.
2. In left pane, expand Blade 1, expand FC Discovered Targets, and verify that all WWPNs associated
with the destination storage array are visible.
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3. Repeat the verification of destination array connectivity on Blade 2. Both arrays should have identical
target port visibility.
Note:

You might need to rescan and refresh if the targets are not visible. To do this, right-click FC
Discovered Targets and select Rescan or Refresh.

Configure Source Array
To configure the source array storage, a host entry for the DTA needs to be created on the source array.
Note that the DTA initiator record should contain FC1 and FC2 ports from both blades. To create the host
storage group, register the following router Fibre Channel WWPNs from the same virtual port group
(VPG) as a single ―host entry‖ in the storage array:


BL1_FC1_VPG1



BL1_FC2_VPG1



BL2_FC1_VPG1



BL2_FC2_VPG1

Note:

This information can be retrieved from the Storage Groups tab of the Site Survey and Plan
document.

To configure source array, complete the following steps:
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1. Log in to Navisphere as an administrator.
2. Create a hosts device for the DTA.
a. Right-click the appropriate frame and select Connectivity Status.
Note:

This example utilizes an EMC CX700 as the source array. Configuration steps for other storage
are available in the appendix.

Figure 68) Navisphere, connectivity status.

b. Click Group Edit.
Figure 69) Navisphere, connectivity status window.

c.

Select all WWPNs associated with the DTA (all ports on both blades) and click the right arrow to
move them to the Selected pane.

d. Complete the Group Edit Initiators dialog box and click OK.
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Initiator Type box = CLARiiON Open



Host Information = DTA Name and IP address



Failover Mode = 4
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Figure 70) Navisphere, Group Edit Initiators window.

3. Create a storage group and add the newly registered DTA device.
a. Expand the frame, right-click Storage Groups, and select Create Storage Group.
Figure 71) Navisphere, create storage group.

b. Enter the name for the DTA storage group in the Storage Group Name and click OK.
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Figure 72) Navisphere, create storage group window.

4. Add the DTA host entity into the newly created DTA storage group.
a. Expand the frame, expand Storage Groups, right-click the newly created DTA storage group, and
select Connect Hosts.
Figure 73) Navisphere, connect hosts.

b. Select the DTA Hosts device from the Available Hosts pane and click the right arrow to move
them to the Hosts to be Connected pane. Click OK.
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Figure 74) Navisphere, storage group properties, add host connection.

Configure Destination Array
This section provides steps to create an initiator record on the destination storage. In this example, we
utilize a FAS system running clustered Data ONTAP 8.2. The following Data ONTAP commands will
create an igroup for the DTA containing all initiators present in VPG1 on both blades. The igroup will be
created with a "windows" type, and ALUA will be enabled.
B9CModeCluster::> igroup create -vserver vserverdm1 -igroup DTA10_VPG1 -protocol fcp -ostype
windows –initiator 21:00:00:c0:dd:19:48:e6 21:00:00:c0:dd:19:48:e7 21:00:00:c0:dd:19:48:f0
21:00:00:c0:dd:19:48:f1
B9CModeCluster::> igroup set -vserver vserverdm1 -igroup DTA10_VPG1 -attribute alua -value true
B9CModeCluster::> igroup show -vserver vserverdm1 -igroup DTA10_VPG1

To create the same initiator group using NetApp OnCommand® System Manager, complete the following
steps:
1. Connect to the appropriate storage system.
2. From the left pane, expand the appropriate controller, expand Storage, and select LUNs. From the
right pane, select the Initiator Groups tab and click Create.
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Figure 75) OnCommand System Manager, initiator groups > create.

3. In the Create Initiator Group window, do as follows:
a. In the General tab, enter a name for the DTA initiator group. From the Operating System dropdown list, select Windows. Under Type, select FC/FCoE. Under ALUA, select the Enable ALUA
checkbox.
Figure 76) OnCommand System Manager, create initiator group.
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b. In the Initiators tab, click Add. Enter the WWPNs for the initiators present in VPG1 on both
blades.

c.

Click OK > Create.

4. Verify the initiator group by selecting the initiator group in the Initiator Groups tab and reviewing the
WWPNs in the Initiators section.
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Figure 77) OnCommand System Manager, initiator groups.

Support Note
All DTA igroups should be created on both controllers in an HA configuration. This is done to simplify layout
and creation of LUNs, allowing either controller to be used as a destination array.

Test Migration: EMC CX/AX
A test migration is performed before production migration to verify proper DTA and storage configuration.
Support Note
The test migration should be performed for a minimum of one week prior to beginning the production data
migrations. This will allow enough time to resolve possible issues such as access, storage connectivity, and
licensing.

To perform test migration, complete the following steps:
1. Create a 1GB test LUN on the source array.
a. Log in to Navisphere as an administrator.
b. To locate a RAID group that has available space, expand RAID Groups, right-click each RAID
group, and select Properties.
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Figure 78) Navisphere, RAID group properties.

c.

Examine the Largest Contiguous Free Space entry to determine the available space on the RAID
group.

Figure 79) Navisphere, RAID group properties window.

2. Create a LUN using the selected RAID group.
a. Right-click the appropriate RAID group and select Bind LUN.
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Figure 80) Navisphere, bind LUN.

b. Enter the following information in the Bind LUN window and click Apply.


LUN ID



Default owner



LUN size of 1GB

Note:

Make sure that you are following the customer‘s best practices while creating a LUN.

3. Add the LUN to the DTA storage group.
a. Expand Storage Groups. Right-click the DTA storage group and select ―Select LUNs‖ to view a
list of available LUNs.
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Figure 81) Navisphere, select LUNs.

b. From the Show LUNs drop-down list, select Not in other Storage Groups. In the Available LUNs
section, expand the default owner SP and select the checkbox next to the recently created LUN.
In the Selected LUNs pane, select the recently created LUN and set the host ID. Click OK.
Figure 82) Navisphere, Storage Group Properties windows.

4. Verify creation and mapping of source test LUN to DTA.
a. Rescan the storage array to force LUN path discovery. Expand FC Discovered Targets, right-click
the WWPN of the source storage array, and select Rescan.

110

DTA Migrations Using NetApp DTA2800 Methodology

Figure 83) DTA Manager arrays rescan, source array.

b. Refresh the DTA Manager to force configuration change discovery. Right-click the DTA and
select Refresh.
Figure 84) DTA Manager refresh.

c.
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Verify that the source array exists in the Arrays listing, the LUN assignment is correct, and all
paths are available.
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Figure 85) DTA Manager, source LUN.

Note:

You need to verify that the LUN is visible on both blades. If it is only available on one blade, make
sure all initiator ports from both blades are in the initiator record.

5. Create a destination 1GB test LUN.
a. Create the destination LUN with the lun create command on the NetApp storage system.
B9CModeCluster::> vol create -vserver vserverdm1 -volume test_lun_vol -aggregate aggr1 -size 2g
B9CModeCluster::> lun create -vserver vserverdm1 -path /vol/test_lun_vol/test_lun -size 1g ostype windows_2008

b. Map the test LUN to the DTA igroup with the lun map command on the NetApp storage system.
B9CModeCluster::> lun map -vserver vserverdm1 -path /vol/test_lun_vol/test_lun -igroup DTA10_VPG1
-lun-id 200
c.
Verify the creation and mapping of destination test LUN to DTA.
B9CModeCluster::> lun show -v -vserver vserverdm1 -path /vol/test_lun_vol/test_lun

To create the LUN using NetApp OnCommand System Manager, complete the following steps:
1. Connect to the appropriate storage system.
2. From the left pane, select Storage. From the right pane, click Create LUN.
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3. Click Next in the Welcome to Create LUN Wizard screen.
4. In the General Properties screen, enter the LUN name. Under Type, select Windows. Under Size,
enter 1GB. Select Thin Provisioned and click Next.

5. In the LUN Container screen, create the LUN container by selecting ―Create a new flexible volume
in.‖ Under Aggregate Name, enter the aggregate name. Under Volume Name, enter the volume name
and click Next.
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6. In the Initiators Mapping screen, map the LUN to the DTA initiator group by selecting Map of the
Initiator Group Name created previously. Enter a LUN ID and click Next.

7. Review the LUN summary. Click Next > Finish.
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8. From the left pane, expand the appropriate controller. Expand Storage and select LUNs. From the
right pane, select the LUN Management tab and the LUN name created previously. Review the
Details and Initiator Groups tabs.

9. Using the DTA Manager, rescan the storage array to force LUN path discovery. Expand FC
Discovered Targets, right-click the WWPN of the destination storage array, and select Rescan.
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Figure 86) DTA Manager arrays rescan, destination array.

10. Refresh DTA Manager to force configuration change discovery. Right-click the DTA and select
Refresh as shown in Figure 84.
Figure 87) DTA Manager, destination LUN.

11. Verify that the destination array exists in Arrays, the LUN assignment is correct, and all paths are
available.
Note:

In the DTA console, to view a list of all LUNs without details, execute the show luns command.
To display all DTA2800 LUNs, sizes, and path information, connect to a blade and execute the
show luninfo command.

DTA2800 <1> (miguser) #> show luninfo
DTA2800 (miguser) #> show luns
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Support Note
Verify that the LUN is visible on both blades. If it is only available on one blade, make sure the initiator ports
from both blades are in the initiator record.

12. Set the array type of available arrays:
a. In DTA Manager, expand the blade and expand Arrays to view all FC storage arrays detected.
b. Select the source array. In the Information pane, from the Target Type drop-down list, select
Source. Click Save.
Figure 88) DTA Manager, destination array.

c.

Select the destination array. In the Information pane, from the Target Type drop-down list, select
Destination. Click Save.

13. Create the migration job:

117

DTA Migrations Using NetApp DTA2800 Methodology

a. Start the data migration wizard. At the prompt, enter the data migration user password in the Data
Migration Security dialog box (default password is migration) and click OK.
b. Use the Wizards menu and select Configure Migration Jobs.
Figure 89) DTA Manager, wizards > configure migration jobs.

c.

Open the Services window, right-click the Data Migration jobs node, and select Configure
Migration Jobs.

Figure 90) DTA Manager, configure migration jobs, services tab.

14. Select the source and destination LUNs for the migration job.
Note:

The Create Data Migration Job dialog box displays arrays configured with a type (Source,
Destination, or Src+Dest) in the right pane. These arrays are available to be used when creating
migration jobs.

a. Expand a source array and a VPGROUP. Click the source LUN for data migration and drag the
LUN from the right pane to the left pane, and drop the LUN to the source LUN.
Figure 91) DTA Manager, select LUNs for migration job.

118

DTA Migrations Using NetApp DTA2800 Methodology

b. Expand a destination array and a VPGROUP. Click the destination LUN for data migration and
drag the LUN from the right pane to the left pane, and then drop the LUN to the destination LUN.

Note:

If an array is missing in the Create Data Migration Job window, confirm that the type has been set
for the array.

Support Note
NetApp DTA Manager will not allow a LUN from a source array in the right pane to be dropped to the
destination LUN in the left pane.
If a LUN of a smaller size from a source array in the right pane is dropped onto destination LUN in the
left pane, the size discrepancy will produce an error message.
15. Configure the migration job.
In the Data Migration Jobs Options screen (Figure 92), do as follows:
a. Select Migration Type of Offline (Local/Remote) to schedule a data migration job in which the
servers affected by the migration jobs are down/offline.
b. Select Scheduling Type of Configure Only to configure the migration job without any start time or
priority.
c.

In the TP settings pane select ―Yes, and no TP Validation‖ to verify thin-provisioned bits on the
source LUN contain a zero on the destination LUN.

d. Select Verify Data after Migration Finished to perform a block-level byte-for-byte comparison of
the source and destination LUNs after the copy.
e. Click Apply > OK > Close.
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Figure 92) DTA Manager, data migration jobs options.

16. Start the migration job.
a. In the Services window, from the left pane, select Data Migration Jobs. From the right pane,
select Active Data Migration Jobs tab. Right-click Data Migration Jobs and select Start Job.
Figure 93) DTA Manager, start job.

b. Under Scheduling Type, select Start Now. Click Apply to start migration job immediately. At the
prompt, enter the data migration user password in the Data Migration Security Check dialog box
(default password is migration) and click OK.
Figure 94) DTA Manager, data migration job start options.

17. Monitor the migration job status.
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a. In the Services window, from the left pane, select Data Migration Jobs. From the right pane,
select the Active Data Migration Jobs tab. The Status and % Completed columns are
automatically updated as the job runs.
Figure 95) DTA Manager, active data migration jobs.

Note:

To see details of an active or completed migration job (Status, Migration State, Migration
Performance, Delta Time), from the left pane of the Services window, expand Data Migration
Jobs and expand Group. Select the data migration job. The details will be displayed in the right
pane.

18. Acknowledge the migration job.
a. In the Services window, from the left pane, select Data Migration Jobs. From the right pane, click
the Completed Data Migration Jobs tab. Notice the Status column shows Completed and %
Completed column shows 100%. Select the migration job, right-click, and select Acknowledge
Completed Data Migration. At the prompt, enter the data migration user password in the Data
Migration Security Check dialog box (default password is migration) and click OK.
Figure 96) DTA Manager, completed data migration jobs.

19. Remove the source LUN.
a. Log in to Navisphere as an administrator.
b. Expand the frame, expand Storage Groups, right-click the DTA Migration storage group, and
select ―Select LUNs.‖ From the Show LUNs drop-down list, select All to view a list of all LUNs
assigned to that storage group (see Figure 97).
c.
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Figure 97) Navisphere, storage group properties window, removal.

d. Expand the RAID Group. Right-click appropriate LUN and select Unbind LUN to unbind the test
LUN.
Figure 98) Navisphere, unbind LUN.
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20. Remove the destination LUN.
a. Unmap the test LUN from the DTA igroup with the lun unmap command by on the NetApp
storage system.
B9CModeCluster::> lun unmap -vserver vserverdm1 -path /vol/test_lun_vol/test_lun -igroup
DTA10_VPG1

b. Offline the test LUN with the lun offline command on the NetApp storage system.
B9CModeCluster::> lun offline -vserver vserverdm1 -path /vol/test_lun_vol/test_lun

c.

Destroy the test LUN with the lun destroy command on the NetApp storage system.

B9CModeCluster::> lun destroy -vserver vserverdm1 -path /vol/test_lun_vol/test_lun

d. Offline the test volume with the vol offline command on the NetApp storage system.
B9CModeCluster::> vol offline -vserver vserverdm1 -volume test_lun_vol

e. Destroy the test volume with the vol destroy command on the NetApp storage system.
B9CModeCluster::> vol destroy -vserver vserverdm1 -volume test_lun_vol

To destroy the LUN using NetApp OnCommand System Manager, complete the following steps:
1. Connect to the appropriate storage system.
2. From the left pane, expand the appropriate controller, expand Storage, and select LUNs. From the
right pane, select the LUN Management tab, right-click the test LUN, and select Offline.
Figure 99) OnCommand System Manager, LUN management > offline.

3. Click Offline in the Confirm Offline LUNs dialog box.

4. Right-click the test LUN and select Delete.
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Figure 100) OnCommand System Manager, LUN management > delete.

5. Click Delete the LUNs and all its data checkbox and then click Delete to confirm LUN deletion.

6. From the left pane, select Volumes. From the right pane, right-click the test volume, select Status and
Offline. Click Offline in the Offline Volume dialog box.
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Figure 101) OnCommand System Manager, volumes > offline.

7. Right-click the test volume and select Delete. Select the OK to delete volume(s) and all its data
checkbox and click Delete in the Delete Volume dialog box.
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Figure 102) OnCommand System Manager, volumes > delete.

Support Note
A test migration should be performed on all combinations of source and destination arrays before
proceeding with the production migrations.

Apply Array License Keys (If Applicable)
To apply array license keys, complete the following steps:
1. In the NetApp DTA Manager main window, click the DTA Manager tab.
2. In the Wizards menu, click License an Array.
3. From the left pane, under Arrays, click the name of the array to which the license will be applied.
4. In the License Array dialog box, select the array for which you want to apply the license, and click OK.
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Figure 103) DTA Manager, license an array.

5. Confirm that the selected array shows the Array License status as Licensed.
Figure 104) DTA Manager, licensed array.
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Map Migration Storage
To map migration storage, complete the following steps:
1. Create a mapping of source and destination LUNs by entering the storage mapping information for
each storage array in the LUNs Details tab of the Site Survey Planner document.
2. Create a complete NetApp design with associated deployment commands and documentation by
using NetApp Storage Design Studio (SDS).
3. Export the CLI commands.
4. Enter the SDS CLI command output for each storage array into the SDS CLI Scripts tab of the Site
Survey Planner document by importing data from the CLI script text files.
Figure 105) Site survey and plan, SDS CLI Scripts tab.

7.4

Execute

In the execution phase, the production LUN migrations are performed by using the information from the
discovery, analyze, and plan phases.
Support Note


Premigration steps include SRU, host path verification, generation of online migration plan using
NDCP Planner, and executing DTA online configuration commands.



Postmigration steps are common for offline and online migration.



Refer to the offline migration section for migrating host offline.



Note separate physical and virtual server online migrations steps in online migration section.

Premigration
During premigration, space reclamation is performed on the hosts, hosts are rebooted for validation,
source LUN paths are verified, and destination LUNs are presented to the DTA.
For online migration, host reboots are not performed for validation.

Run Space Reclamation Utility (SRU)
The NetApp Data Migration Space Reclamation Utility (SRU) helps you regain free file system space and
to prepare a thick-provisioned LUN to migrate into a thin-provisioned LUN. Free space refers to the free
data blocks present in the file system that might contain stale data.
The utility can be used in the following instances:
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When the file system is not operating under a heavy I/O load

For more information about SRU, refer to Data Migration Space Reclamation Utility User‘s Guide.
To run the Space Reclamation Utility, complete the following steps:
1. Select the appropriate binary for your OS, platform, and vendor. Use FTP or download it from the web
to the server or host. NetApp suggests that you create a directory named "SRU" on the server or host
to contain the binary files for the utility.
2. Download the utility from
http://support.netapp.com/NOW/download/software/dta_spacereclamation/1.9/.
3. Execute the utility.


Windows Host

Windows (x86): netapp_sru_win_<x.x>_x86.exe
netapp_sru_win_1.9_x86.exe -p D:\ -I 5



Linux Host

Linux (x86): netapp_sru_linux__<x.x>_x86_i686.bin
Linux (x64): netapp_sru_linux__<x.x>_x86_64.bin
Linux (ia64): netapp_sru_linux__<x.x>_ia64_64.bin

a. Add execute permission to the file and rename it.
chmod +x netapp_sru_linux_1.9_ x86_i686.bin
mv netapp_sru_linux_1.9_ x86_i686.bin
SRU

b. Run the Space Reclamation Utility.
./sru --path /fs2 --reserve=10 --threadcount=4 --iosize=3 --interval=5



Solaris Host

Solaris (x86): netapp_sru_solaris__<x.x>_x86.bin
Solaris (SPARC): netapp_sru_solaris__<x.x>_sparc.bin

a. Add execute permission to the file and rename it.
chmod +x netapp_sru_ solaris _1.9_ x86.bin
mv netapp_sru_ solaris _1.9_ x86.bin
SRU

b. Run the Space Reclamation Utility.
./sru -p /fs2 -r 10 -t 4 -U 3 -i 5

Support Note
After running SRU:
1. Select TP Validation in the Data Migration Job Options dialog box if you are uncertain about the
data on the destination LUN, or if the destination LUN was used earlier for storing any other data.
Enabling validation makes sure that no corruption exists because of stale data in the destination
LUN. Enabling validation provides additional processing overhead. Typically, validation is not
required for a LUN newly created for data migration.
2. Do not select TP Validation in the Data Migration Job Options dialog box when the destination LUN
is known to be thin-provisioned storage and is newly created.
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Validate Host Reboot (Offline Migration Only)
Migration hosts are rebooted prior to making any changes to their configuration. Before proceeding with
migration, verify that the system is in a known good state. To verify that the server configuration is
persistent and pristine across reboots, complete the following steps:
1. Shut down all your open programs.
2. Reboot the host.
3. Review the logs for errors.


Windows Host


In Windows 2008, at the command prompt, type:

shutdown –r –t 0
eventvwr



In Windows 2003, at the command prompt, type:

/r /t:0
eventvwr



Linux Host

/sbin/shutdown –r
more /var/logs/messages



Solaris Host

/usr/sbin/shutdown –r
more /var/adm/messages

Verify Host LUN Path
To verify that the server multipath is configured and functioning correctly, complete the following steps:
Note:

Verify that all available paths to LUNs are active.

Windows Host
To verify that EMC PowerPath multipath is configured and functioning correctly on a Windows host,
complete the following steps:
1. Click Start > All Programs > EMC > PowerPath > PowerPath Administrator.
2. Expand Path Management and then expand Disks.
3. Review Path Metric.

Linux Host
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1. To verify that DM-MP multipath is configured and functioning correctly on a Linux host, run the
following commands:
multipath –ll
mpath0 (360060160ee851100af26248cae8adf11) dm-0 DGC,RAID 5
[size=10G][features=1 queue_if_no_path][hwhandler=1 emc][rw]
\_ round-robin 0 [prio=2][active]
\_ 0:0:0:0 sda 8:0
[active][ready]
\_ 1:0:0:0 sdg 8:96 [active][ready]
\_ round-robin 0 [prio=0][enabled]
\_ 0:0:1:0 sdd 8:48 [active][ready]
\_ 1:0:1:0 sdj 8:144 [active][ready]
mpath1 (360060160ee851100d7f855b41e34e011) dm-5 DGC,RAID 5
[size=2.0G][features=1 queue_if_no_path][hwhandler=1 emc][rw]
\_ round-robin 0 [prio=2][active]
\_ 0:0:0:1 sdb 8:16 [active][ready]
\_ 1:0:0:1 sdh 8:112 [active][ready]
\_ round-robin 0 [prio=0][enabled]
\_ 0:0:1:1 sde 8:64 [active][ready]
\_ 1:0:1:1 sdk 8:160 [active][ready]
mpath2 (360060160ee8511001bef0e472034e011) dm-6 DGC,RAID 5
[size=3.0G][features=1 queue_if_no_path][hwhandler=1 emc][rw]
\_ round-robin 0 [prio=2][active]
\_ 0:0:0:2 sdc 8:32 [active][ready]
\_ 1:0:0:2 sdi 8:128 [active][ready]
\_ round-robin 0 [prio=0][enabled]
\_ 0:0:1:2 sdf 8:80 [active][ready]
\_ 1:0:1:2 sdl 8:176 [active][ready]

Solaris Host
1. To verify EMC PowerPath multipath is configured and functioning correctly on a Solaris host, run the
following commands:
powermt display dev=all
Pseudo name=emcpower0a
CLARiiON ID=APM00044302045 [SG_dm-rx200s6-30]
Logical device ID=60060160EE8511007B1663FA138ADF11 [bootlun_solx86_ppath_user10]
state=alive; policy=CLAROpt; priority=0; queued-IOs=0
Owner: default=SP A, current=SP A
==============================================================================
---------------- Host --------------- Stor -- I/O Path - -- Stats --### HW Path
I/O Paths
Interf.
Mode
State Q-IOs Errors
==============================================================================
3072 pci@0,0/pci8086,3410@9/pci1077,15d@0,1/fp@0,0 c4t5006016130600EB6d0s0 SP A1
alive
0
0
3072 pci@0,0/pci8086,3410@9/pci1077,15d@0,1/fp@0,0 c4t5006016930600EB6d0s0 SP B1
alive
0
0
3077 pci@0,0/pci8086,3410@9/pci1077,15d@0/fp@0,0 c7t5006016030600EB6d0s0 SP A0
0
0
3077 pci@0,0/pci8086,3410@9/pci1077,15d@0/fp@0,0 c7t5006016830600EB6d0s0 SP B0
0
0
Pseudo name=emcpower2a
CLARiiON ID=APM00044302045 [SG_dm-rx200s6-30]
Logical device ID=60060160EE8511001C3830E0CF35E011 [solaristestlun1]
state=alive; policy=CLAROpt; priority=0; queued-IOs=0
Owner: default=SP A, current=SP A
==============================================================================
---------------- Host --------------- Stor -- I/O Path - -- Stats --### HW Path
I/O Paths
Interf.
Mode
State Q-IOs Errors
==============================================================================
3072 pci@0,0/pci8086,3410@9/pci1077,15d@0,1/fp@0,0 c4t5006016130600EB6d1s0 SP A1
alive
0
0
3072 pci@0,0/pci8086,3410@9/pci1077,15d@0,1/fp@0,0 c4t5006016930600EB6d1s0 SP B1
alive
0
0
3077 pci@0,0/pci8086,3410@9/pci1077,15d@0/fp@0,0 c7t5006016030600EB6d1s0 SP A0
0
0
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active
active
active

alive

active

alive

active
active
active

alive

3077 pci@0,0/pci8086,3410@9/pci1077,15d@0/fp@0,0 c7t5006016830600EB6d1s0 SP B0
0
0
Pseudo name=emcpower1a
CLARiiON ID=APM00044302045 [SG_dm-rx200s6-30]
Logical device ID=60060160EE8511000AE03471D135E011 [solaristestlun2]
state=alive; policy=CLAROpt; priority=0; queued-IOs=0
Owner: default=SP A, current=SP A
==============================================================================
---------------- Host --------------- Stor -- I/O Path - -- Stats --### HW Path
I/O Paths
Interf.
Mode
State Q-IOs Errors
==============================================================================
3072 pci@0,0/pci8086,3410@9/pci1077,15d@0,1/fp@0,0 c4t5006016130600EB6d2s0 SP A1
alive
0
0
3072 pci@0,0/pci8086,3410@9/pci1077,15d@0,1/fp@0,0 c4t5006016930600EB6d2s0 SP B1
alive
0
0
3077 pci@0,0/pci8086,3410@9/pci1077,15d@0/fp@0,0 c7t5006016030600EB6d2s0 SP A0
0
0
3077 pci@0,0/pci8086,3410@9/pci1077,15d@0/fp@0,0 c7t5006016830600EB6d2s0 SP B0
0
0

active

alive

active
active
active

alive

active

alive

Configure Destination Array
The initiator groups for the migration hosts should be created on the destination storage prior to starting
the migration. To configure the destination array, complete the following steps:
1. Create host igroups.
Support Note
All DTA igroups should be created on both controllers in an HA configuration. This is done to simplify
layout and creation of LUNs, allowing either controller to be used as a destination array.
2. Review the igroup create commands in the Storage Groups tab of the Site Survey and Plan.xls:
B9CModeCluster::> igroup create -vserver vserverdm1 -igroup DM-RX200S6-25 -protocol fcp -ostype
windows –initiator 21:00:00:24:ff:30:16:ce 21:00:00:24:ff:30:16:cf

3. Enable ALUA on the host group.
Review igroup set commands that are in the Storage Groups tab of the Site Survey and Plan.xls.
B9CModeCluster::> igroup set -vserver vserverdm1 -igroup DM-RX200S6-25 -attribute alua -value
true

Note:

Refer to Destination Array Configuration for details about OnCommand System Manager.

4. Implement the storage layout.
Review CLI scripts that are in the SDS CLI Scripts tab in the Site Survey and Plan.xls, then execute
using rsh, exclude igroup, and lun creation commands.
5. Present LUNs from the destination array to the DTA.
6. Review lun create and lun comment commands that are in the LUN Details tab in the Site
Survey and Plan.xls, then execute using rsh.
Note:

In order to create the custom prefix in clustered Data ONTAP (-p switch in 7-Mode), you will need
to go into advanced mode and use the ‗-prefix-size‘ switch.

B9CModeCluster::> set advanced
Warning: These advanced commands are potentially dangerous; use them only when
directed to do so by NetApp personnel.
Do you want to continue? {y|n}: y
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B9CModeCluster::*> lun create -vserver vserverdm1 -path /vol/DM_RX200S6_25/dm25_data1_lun -size
1086063616 -ostype windows_2008 -prefix-size 3584
B9CModeCluster::*> lun comment -vserver vserverdm1 -path /vol/DM_RX200S6_25/dm25_data1_lun comment "LUN created with custom prefix”

7. Identify the PG80 LUN serial number of the NetApp LUNs.
B9CModeCluster::*> lun serial -vserver vserverdm1 -path /vol/DM_RX200S6_25/dm25_data1
Vserver
Path
Serial Number
--------- ----------------------------------------------- --------------vserverdm1
/vol/DM_RX200S6_25/dm25_data1_lun
1ka52?CJDmCI
B9CModeCluster::*>

8. Record PG80/83 SN in the LUN Details tab of the Site Survey and Plan.xls.
Figure 106) Site survey and plan, destination LUN details.

9. Verify the creation and mapping of destination LUNs to DTA.
a. Rescan the storage array to force LUN path discovery. Expand FC Discovered Targets, right-click
the WWPN of the destination storage array, and select Rescan (see Figure 86).
b. Refresh the DTA Manager to force configuration change discovery. Right-click the DTA and
select Refresh (see Figure 84).
Note:

In the DTA CLI, to view a list of all LUNs without details, execute show luns. To display all
DTA2800 LUNs, sizes, and path information, connect to a blade and execute show luninfo.

DTA2800 <1> (miguser) #> show luninfo
DTA2800 (miguser) #> show luns

Support Note
Verify that the LUN is visible on both blades. If it is only available on one blade, make sure the initiator
ports from both blades are in the initiator record.
c.
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Verify that the destination array exists in Arrays, array type is set to Destination, LUN assignment
is correct, and all paths are available (see Figure 87).

DTA Migrations Using NetApp DTA2800 Methodology

Create Online Migration Plan using NDCP Planner (Online Migration Only)
Create online migration plan using NDCP Planner using the information available in the Site Survey
Sheet. The NDCP Online Planner creates a detailed migration plan by using inputs provided by the user.
A migration plan is generated at the end, which can then be used to carry out the actual online migration.
Host Type
In the Host Type tab, the user has to choose the host type. Choose host type as Physical if migrating a
physical server and choose virtual if migrating a virtual server.
For a physical machine migration, a separate migration fabric is used. In this migration fabric, the DTA
spoofs the source array target ports. Source LUNs are simultaneously mapped to the client and the DTA.
The initiator-to-LUN mapping present in the source array is duplicated in the DTA. The DTA remaps the
same set of LUNs on the target ports in the migration fabric. The migration host is physically moved onto
the migration fabric. Because the LUN is simultaneously available directly to the initiator on the production
fabric as well as through the spoofed ports on the migration fabric, the fabric move appears to the host as
a series of path failures, which are handled as normal MPIO events. Note that both physical and virtual
migration fabrics (dedicated switches, Cisco VSANs, or Brocade virtual fabrics) are supported. After the
host is cut over to the migration fabric, the destination LUNs are mapped to the DTA, and the migration
begins.
For migration of a virtual machine (for example, LPAR), only the production fabric is used. In short, the
DTA presents additional paths to the source storage. The host is zoned to see these new paths, and the
direct paths from the initiator to the target are swapped out for paths through the DTA. After the host is
utilizing the targets presented through the DTA, destination LUNs can be mapped, and migration begins.
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Fabrics
In the Fabrics tab, the user has to provide information about fabrics to be used for online migration. By
default, the Fabrics tab is populated by four fabrics for physical server migration, two of which are marked
as production fabrics and two of which are marked as migration fabrics. The setup of two production
fabrics and two migration fabrics is necessary for physical server online migration. The user can edit the
fabrics details as per their network details. This is done by double-clicking the cells.
For virtual server online migration, use only production fabric. Migration fabric is not used and shown for
the virtual server host type.
Note:

In DTA Online Planner, table cells with column headings in blue are editable. To edit a cell,
double-click the cell and make the changes.

After parsing the nSANity files in the Parser, click DTA Online Planner.
Figure 107) Fabrics tab for physical server host type.
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Figure 108) Fabrics tab for virtual server host type.

To add parsed fabric, complete the following steps:
1. Click Add Parsed Fabric.
Note:

This button is available only if the parsed nSANity files that contain FC switch information have
been opened in the NDCP planner Parser tab.

2. In the Add Parsed Fabric window, select the switch details and click OK.

3. The Fabric Name, Active Zoneset Name, VSAN/Domain ID, and Fabric Vendor fields display the
switch details obtained from the Parser.
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4. If Add Parsed Fabric button is unavailable, edit the Name, Active Zoneset Name, VSAN/Domain ID,
and Fabric Vendor columns of the table and provide information specific to the fabrics at your setup.
Note:

In DTA Online Planner, table cells with column headings in blue are editable. To edit a cell,
double-click the cell and make the changes.

5. Click File>Save Session or press Ctrl+S to save the current session with a unique name (for
example, <switch.ndcp>).
Note:

It is recommended that you save the session after completing the tasks on each tab.

Note:

The planner module currently supports Cisco or Brocade fabrics.

Note:

The saved session files do not work across lower NDCP versions.

DTA
In the DTA tab, the user has to provide details related to the Data Transfer Appliance (DTA).
To add Data Transfer Appliance (DTA), complete the following steps:
1. After adding the fabrics in the Fabrics tab, click the DTA tab. Click Add DTA.

2. In the DTA Properties window, enter the properties of the DTA, and click OK. The WWPN of FC1
VPG1 is obtained using the DTA Manager.
Note:

All fields are mandatory and cannot be left blank. However, after you enter the details, you can
edit them in the DTA tab.

3. For each DTA blade, enter Migration Fabric Port Number for FC3 and FC4 ports. This is a mandatory
field. This is shown for physical server host type only.
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Figure 109) DTA tab for physical server online migration.

Figure 110) DTA tab for virtual server online migration.

Note:
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FC1 of both blades should be connected to Production Fabric A.



FC2 of both blades should be connected to Production Fabric B.



FC3 of both blades should be connected to Migration Fabric A (physical server online migration
only).



FC4 of both blades should be connected to Migration Fabric B (physical server online migration
only).

Storage Arrays
In the Storage Arrays tab, the user has to provide details of the source storage arrays (contains LUNs to
be migrated) and the destination storage arrays (to which LUNs are migrated).

Adding Storage and Destination Arrays or Vservers
1. After adding the DTA, click the Storage Arrays tab.
2. Click the Add Array button.
Figure 111) Adding a source storage array.

3. For source arrays:
a. Enter the name of the source array.
b. Select SRC from the Type list.
c.

Click OK.

4. For destination arrays:
a. Enter the name of the array or the Vserver depending on your Data ONTAP operating system.
b. Select DST or SRC+DST from the Type list.
5. From the ONTAP Mode:
a. Select 7 mode, if the destination is an array in Data ONTAP operating in 7-Mode.
b. Select clustered Data ONTAP, if the destination is a Vserver in clustered Data ONTAP.
Figure 112) Adding a destination storage array.
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6. Repeat steps 2 through 4 to add all the source and destination arrays or Vservers.
7. To delete an array/Vserver, select the array/Vserver and click Delete.
Note:

You cannot delete arrays after you add a migration job that uses LUNs associated with these
arrays.

Adding a Controller for Source Arrays and 7-Mode Destination Arrays
1. After adding the source and destination arrays, click the Add Controller button.
Figure 113) Adding a controller.

2. Select an array from the Parent Array list, and type the name of the controller for that array.
3. Click OK.
4. Similarly, enter the controller names for each of the storage and destination arrays.
Note:

In clustered Data ONTAP, storage controllers are presented and managed as cluster nodes.
Therefore, when a Vserver is added using the Add Array button, a controller is automatically
added for the Vserver without using the Add Controller functionality.

Adding a Port for Source And Destination Arrays
After you add the arrays and their respective controllers, provide details such as WWPN and WWNN of
the ports available on each controller.
1. Select a controller in the bottom pane and click the Add Port button.
Figure 114) Adding a controller port.

2. In the Provide Port Details window, enter the WWNN, WWPN, and Port Name fields for the selected
array. All these fields are mandatory.
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3. Select the Fabric Name from the list, and click OK.
4. Repeat steps 1 to 3 to add additional ports for each controller.
Note:

A maximum of two ports can be added to a controller.

Adding a LIF for a Destination Vserver
For setting up destination Vservers in clustered Data ONTAP, LIFs need to be added for the Vserver.
1. After adding a destination Vserver , select the Vserver in the bottom pane and click Add LIF.
Figure 115) Adding a LIF for a Vserver.

2. In the Provide LIF Details window, enter the WWPN, WWNN, and LIF Name for the selected Vserver.
3. Select the Fabric Name from the list, and then click OK.
4. Repeat steps 1 through 3 to add additional LIFs for each Vserver.
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Figure 116) Storage Arrays tab (virtual host).

Destination LUN
In the Destination LUN tab, the user has to provide the details of the destination LUNs on the destination
storage array. To add destination LUNs, complete the following steps:
1. Click the Destination LUN tab.
2. Click Add Destination LUN.

3. In the LUN Details window, select an array from the Storage Array list and its corresponding
controller.
Note:

The Storage Array list displays only the arrays of type SRC+DST or DST. These arrays were
added in the Storage Arrays tab.

4. Enter the PG83 serial number or the serial number for the destination LUNs. For each destination
LUN, it is mandatory to provide either the PG83 serial number or the serial number.
5. Click OK.
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6. Repeat steps 1 through 5 to enter the pg83 serial number or the serial number for all destination
LUNs.
Host
In the Host tab, the user has to provide details of the hosts, which contain source LUNs that need to be
migrated.
If the parsed nSANity files do not contain host information, you need to add a host using the Add Host
function. To add a host, complete the following steps:
1. Click the Host tab.
2. Click Add Host.

3. Enter a host name and click OK.
The host names are displayed in the Production Fabric table.
Add HBA
To add an HBA, complete the following steps:
1. After you add the hosts, select a host in the Production Fabric table and click Add HBA.

2. For the selected host, enter the WWPN for HBA1.
3. Select the production fabric from the list.
4. Enter the port number (production) and click OK. The HBA details are displayed in the Production
Fabric and Migration Fabric tables for physical server online migration.
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5. The HBAs added to the host appear in the Production Fabric and Migration Fabric tables. For each
HBA, specify the migration port number to which it is connected by editing the corresponding cell.
Add a Parsed Host
If the parsed nSANity files contain host information, add hosts using the Add Parsed button. To add a
parsed host, complete the following steps:
1. Click Add Parsed Host.

2. From the Host list, select the host that is being migrated.
3. From the Source Storage list, select the name of the source storage on which the selected host has
its LUNs.
4. Click OK. The Choose Fabric for HBA window is displayed.

5. From the HBA WWPN list, select the WWPN for HBA1.
6. Select the name of the fabric to which the HBA1 is connected.
7. Enter the corresponding port number (for example, fc4/38).
8. Click OK.
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9. Repeat steps 6 through 9 to select the WWPN, fabric name, and port number for HBA2.
Add Source LUN
To add a source LUN, complete the following steps:
1. Click Add Source LUN.

2. Select the host and source storage of the LUN.
3. Enter the PG83 serial number or the serial number of the LUN.
Note:

For adding a source LUN, the host LUN ID and the PG83 serial number or the serial number are
mandatory.

4. Enter the host LUN ID.
5. If the LUN is a controller LUN or a pseudo LUN, select the Pseudo LUN checkbox.
6. Click OK. The added source LUN properties are displayed in the LUN table (below the Migration
Fabric table).
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Figure 117) Host tab for physical server online migration.

Figure 118) Host tab for virtual server online migration.

In the LUN table, the Clustered/Shared LUN column indicates if a LUN is clustered or not. Two or more
LUNs are said to be in a cluster if they meet the following criteria:


They are from the same source storage.



They have the same pg83 serial number.
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In absence of the pg83 serial numbers, the LUNs have the same pg80 serial number.

The Clustered/Shared LUN column is updated automatically for each LUN when LUNs are added or
deleted.
Note:

For a successful physical server online migration, it is required that one of the HBAs of the host is
connected to Production Fabric A and the other HBA is connected to Production Fabric B. During
migration the HBA that is connected to Production Fabric A should be connected to Migration
Fabric A and the HBA that is connected to Production Fabric B should be connected to Migration
Fabric B.

Note:

All production and migration ports should be specified for physical server online migration.

Note:

When a parsed host is added, all valid LUNs of the host are displayed in the LUN table. A LUN is
considered valid if it has a LUN ID and either a pg83 or a pg80 serial number. The source storage
for each LUN is taken as the same source storage that was entered when adding a parsed host.
The source storage of a LUN in the LUN table can be changed by editing the column ―Source
Storage‖ in the LUN table.

Zones
The Zones tab (Figure 119 and Figure 120) displays all the zones that will be created based on the
mappings that were previously specified. The following zone types will be created:




Production fabric:


DTA ports (FC1, FC2) to storage arrays (Zones 1 through 4 in migration plan)



Host(s) to destination storage arrays (Zones 9, 10 in migration plan)



DTA ports (FC1, FC2) PT WWPN to host(s) (Zones 5, 6 in migration plan) (for virtual server
online migration)

Migration fabric (for physical server online migration):
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Figure 119) Zones tab for physical server online migration.
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Figure 120) Zones tab for virtual server online migration.

To export zone information as Excel files, complete the following steps:
1. Right-click the table.
2. Click Export table to xls.

3. Enter a filename, and then click Save.
Presented Target
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The Presented Target tab (Figure 121 and Figure 122) shows the mapping between the source storage
port and the corresponding blade port in the DTA. This tab is automatically populated based on
information entered in previous tabs.
Figure 121) Presented target tab for physical server online migration.

Figure 122) Presented target tab for virtual server online migration.

Igroup
The Igroup tab (Figure 123) displays the initiators (by WWPN) that share the same LUN mappings. A
single initiator is created for each enabled VPG.
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Figure 123) Igroup tab.

Job
In the Job tab (Figure 124), you can select the source and destination LUNs and create a migration job
that will be run on the DTA.
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Figure 124) Job tab.

To add a migration job, complete the following steps:
1. Click the Job tab. Select the Add Migration Job button.

2. Select the DTA blade number through which migration will be executed.
3. Select the source host from which data has to be migrated.
4. Select the destination array to which the data will be migrated.
5. Click Next. The Select Source and Destination LUN window is displayed.
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6. Select a source LUN. If a LUN is clustered, the Source LUN table in the selection window shows the
members of the cluster. The members of the cluster are the hosts on which the source LUN is visible.
7. Select a destination LUN to which the data will be migrated.
8. After you select a source LUN and a destination LUN that are not part of the migration job, the Add
Migration Job button is available. Click Add Migration Job. The job is added for migration, and the
details are displayed in the Job tab.
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Note:

The source and destination LUNs that are already part of another migration job will be
unavailable for selection. These LUNs are displayed in red and have the status ―Part of Migration
Job.‖

Note:

A clustered LUN can be selected to be a part of a migration job only once from any of the cluster
members.

Plan
The Plan tab (Figure 125) generates step-by-step instructions to perform an online migration.
Figure 125) Plan tab.

The generated plan can be exported as an HTML file or can be copied and pasted in a text editor.
To search for specific information in the plan, complete the following steps:
1. Right-click the plan and then select Find.

2. Type a search string you want to locate in the plan and click Find What.
Save and Load a Planner Session
The current state of the Planner can be saved in a session file (Figure 126). The saved session file
contains inputs the user has provided. The planner is populated with inputs from the loaded file when the
saved session file is later loaded in the same session or when a new planner is invoked.
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Figure 126) Save and Load planner session.

DTA Configuration (Physical and Virtual Server Online Migration Only)
To configure DTA, follow the steps provided in NDCP Planner output.
Create Host Initiator Record
To create a host initiator record, complete the following steps:
1. To create a host initiator record for each host that is being migrated, use DTA Remote CLI (RCLI)
commands generated in the NDCP online planner.
2. For HP-UX hosts use -ostype as hpux.
rcli add initiator -wwpn=21:00:00:24:ff:30:14:c5
blade=1 -ip=10.61.187.103
rcli add initiator -wwpn=21:00:00:24:ff:30:14:c4
blade=1 -ip=10.61.187.103
rcli add initiator -wwpn=21:00:00:24:ff:30:14:c5
blade=2 -ip=10.61.187.103
rcli add initiator -wwpn=21:00:00:24:ff:30:14:c4
blade=2 -ip=10.61.187.103
rcli add initiator -wwpn=21:00:00:24:ff:30:04:85
blade=1 -ip=10.61.187.103
rcli add initiator -wwpn=21:00:00:24:ff:30:04:84
blade=1 -ip=10.61.187.103
rcli add initiator -wwpn=21:00:00:24:ff:30:04:85
blade=2 -ip=10.61.187.103
rcli add initiator -wwpn=21:00:00:24:ff:30:04:84
blade=2 -ip=10.61.187.103

-wwnn=00:00:00:00:00:00:00:00 -ostype=win2k3 -wwnn=00:00:00:00:00:00:00:00 -ostype=win2k3 -wwnn=00:00:00:00:00:00:00:00 -ostype=win2k3 -wwnn=00:00:00:00:00:00:00:00 -ostype=win2k3 -wwnn=00:00:00:00:00:00:00:00 -ostype=win2k3 -wwnn=00:00:00:00:00:00:00:00 -ostype=win2k3 -wwnn=00:00:00:00:00:00:00:00 -ostype=win2k3 -wwnn=00:00:00:00:00:00:00:00 -ostype=win2k3 -

3. Verify initiator record creation.
rcli list initiator -blade=1 -ip=10.61.187.103
rcli list initiator -blade=2 -ip=10.61.187.103

4. Verify the initiators were created in the DTA Manager.
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Initiators Creation Support Note


Initiator on DTA will be shown as logged out.



Verify initiators on both the blades.



For HP-UX host type, use –ostype as hpux.

Create LUN Mask for Each LUN
To present the source array LUNs to the initiator in DTA, use the –remap_lun_number option to map
the LUN to the same ID that is being used in the host.
When a global presented target is used, you must map the LUNs using the –remap_lun_number option.
To create a LUN mask, complete the following steps:
1. Create pseudo LUN mask.
The following commands are required for hosts utilizing an MPIO configuration that requires a
"pseudo" or "controller" LUN. It is typically not required to mask the pseudo LUN if there is a LUN
present at LUN ID 0.
Note:

These commands should never be used for NetApp source arrays.

rcli add lunmask -fc_target=50:00:1f:e1:50:0b:85:d8 -fc_initiator=21:00:00:24:ff:30:04:85 vpgindex=1 -lun_number=0 -remap_lun_number=0 -blade=1 -ip=10.61.187.103
rcli add lunmask -fc_target=50:00:1f:e1:50:0b:85:d8 -fc_initiator=21:00:00:24:ff:30:04:84 vpgindex=1 -lun_number=0 -remap_lun_number=0 -blade=1 -ip=10.61.187.103
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rcli add lunmask -fc_target=50:00:1f:e1:50:0b:85:d8 -fc_initiator=21:00:00:24:ff:30:04:85 vpgindex=1 -lun_number=0 -remap_lun_number=0 -blade=2 -ip=10.61.187.103
rcli add lunmask -fc_target=50:00:1f:e1:50:0b:85:d8 -fc_initiator=21:00:00:24:ff:30:04:84 vpgindex=1 -lun_number=0 -remap_lun_number=0 -blade=2 -ip=10.61.187.103
rcli add lunmask -fc_target=50:00:1f:e1:50:0b:85:d8 -fc_initiator=21:00:00:24:ff:30:14:c5
vpgindex=1 -lun_number=0 -remap_lun_number=0 -blade=1 -ip=10.61.187.103
rcli add lunmask -fc_target=50:00:1f:e1:50:0b:85:d8 -fc_initiator=21:00:00:24:ff:30:14:c4
vpgindex=1 -lun_number=0 -remap_lun_number=0 -blade=1 -ip=10.61.187.103
rcli add lunmask -fc_target=50:00:1f:e1:50:0b:85:d8 -fc_initiator=21:00:00:24:ff:30:14:c5
vpgindex=1 -lun_number=0 -remap_lun_number=0 -blade=2 -ip=10.61.187.103
rcli add lunmask -fc_target=50:00:1f:e1:50:0b:85:d8 -fc_initiator=21:00:00:24:ff:30:14:c4
vpgindex=1 -lun_number=0 -remap_lun_number=0 -blade=2 -ip=10.61.187.103

-

2. Mask the boot and data LUNs to the initiator.
rcli add lunmask -fc_initiator=21:00:00:24:ff:30:04:85 lun_any_wwuln=600508b400068ba80000a00000a60000 -remap_lun_number=1
rcli add lunmask -fc_initiator=21:00:00:24:ff:30:04:84 lun_any_wwuln=600508b400068ba80000a00000a60000 -remap_lun_number=1
rcli add lunmask -fc_initiator=21:00:00:24:ff:30:04:85 lun_any_wwuln=600508b400068ba80000a00000a60000 -remap_lun_number=1
rcli add lunmask -fc_initiator=21:00:00:24:ff:30:04:84 lun_any_wwuln=600508b400068ba80000a00000a60000 -remap_lun_number=1
rcli add lunmask -fc_initiator=21:00:00:24:ff:30:04:85 lun_any_wwuln=600508b400068ba80000a00008bc0000 -remap_lun_number=2
rcli add lunmask -fc_initiator=21:00:00:24:ff:30:04:84 lun_any_wwuln=600508b400068ba80000a00008bc0000 -remap_lun_number=2
rcli add lunmask -fc_initiator=21:00:00:24:ff:30:04:85 lun_any_wwuln=600508b400068ba80000a00008bc0000 -remap_lun_number=2
rcli add lunmask -fc_initiator=21:00:00:24:ff:30:04:84 lun_any_wwuln=600508b400068ba80000a00008bc0000 -remap_lun_number=2

3. Verify LUN mask creation.
rcli show lunmask -blade=1 -ip=10.61.187.103
rcli show lunmask -blade=2 -ip=10.61.187.103

4. Verify using DTA Manager.
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-blade=1 -ip=10.61.187.103
-blade=1 -ip=10.61.187.103
-blade=2 -ip=10.61.187.103
-blade=2 -ip=10.61.187.103
-blade=1 -ip=10.61.187.103
-blade=1 -ip=10.61.187.103
-blade=2 -ip=10.61.187.103
-blade=2 -ip=10.61.187.103

LUN Mask Creation Support Note


Make sure the mapped ID is same as the LUN ID mapped on the host from source storage.



Verify LUN is masked with all target paths in both the blades.

Create Presented Targets
To create presented targets, complete the following steps:


Presented Target for Physical Server Online Migration

1. Create a global presented target for each source array target port on DTA FC3 and FC4 ports that
are connected to the migration fabric. Presented target port WWPN should be the same as the
source target port WWPN. –vpgindex=none indicates it is a global presented target.
When a global presented target is created, all hosts can use the same presented target instead of
creating individual presented target per each VPG and each host.
BL1 FC3 <-> Source Storage Ctrl1 0a
BL1 FC4 <-> Source Storage Ctrl2 0b
BL2 FC3 <-> Source Storage Ctrl2 0a
BL2 FC4 <-> Source Storage Ctrl1 0b
At this point, the DTA will advertise the source storage on the migration fabric.
rcli map target -fc_target=50:00:1f:e1:50:0b:85:d8 -fc_port=3 -vpgindex=none wwnn=50:00:1f:e1:50:0b:85:d0 -wwpn=50:00:1f:e1:50:0b:85:d8 -blade=1 -ip=10.61.187.103
rcli map target -fc_target=50:00:1f:e1:50:0b:85:dd -fc_port=4 -vpgindex=none wwnn=50:00:1f:e1:50:0b:85:d0 -wwpn=50:00:1f:e1:50:0b:85:dd -blade=1 -ip=10.61.187.103
rcli map target -fc_target=50:00:1f:e1:50:0b:85:dc -fc_port=3 -vpgindex=none wwnn=50:00:1f:e1:50:0b:85:d0 -wwpn=50:00:1f:e1:50:0b:85:dc -blade=2 -ip=10.61.187.103
rcli map target -fc_target=50:00:1f:e1:50:0b:85:d9 -fc_port=4 -vpgindex=none wwnn=50:00:1f:e1:50:0b:85:d0 -wwpn=50:00:1f:e1:50:0b:85:d9 -blade=2 -ip=10.61.187.103



Presented Target for Virtual Server Online Migration
1. Create a global presented target for each source array target port on DTA FC1 and FC2 ports
that are connected to the production fabric. Presented target port WWPN should be same as
corresponding DTA FC WWPN on which it is being created with second octet being 64. vpgindex=none indicates it is a global presented target. Second octet 64 is used to avoid
conflict with presented targets that may be created using DTA Manager and to identify the
presented targets created by NDCP. If another source storage is used at same time, use 65 as
second octet for second source storage.
When global presented target is created, all hosts can use the same presented target instead of
creating individual presented target per each VPG and each host.
BL1 FC1 <-> Source Storage Ctrl1 0a
BL1 FC2 <-> Source Storage Ctrl2 0b
BL2 FC1 <-> Source Storage Ctrl2 0a
BL2 FC2 <-> Source Storage Ctrl1 0b

2. At this point, the DTA will advertise the source storage on the migration fabric.
rcli map target -fc_target=50:00:1f:e1:50:0b:85:d8 -fc_port=1 -vpgindex=none wwnn=20:64:00:c0:dd:19:4c:2e -wwpn=21:64:00:c0:dd:19:4c:2e -blade=1 -ip=10.61.187.103
rcli map target -fc_target=50:00:1f:e1:50:0b:85:dd -fc_port=2 -vpgindex=none wwnn=20:64:00:c0:dd:19:4c:2f -wwpn=21:64:00:c0:dd:19:4c:2f -blade=1 -ip=10.61.187.103
rcli map target -fc_target=50:00:1f:e1:50:0b:85:dc -fc_port=1 -vpgindex=none wwnn=20:64:00:c0:dd:19:4c:38 -wwpn=21:64:00:c0:dd:19:4c:38 -blade=2 -ip=10.61.187.103
rcli map target -fc_target=50:00:1f:e1:50:0b:85:d9 -fc_port=2 -vpgindex=none wwnn=20:64:00:c0:dd:19:4c:39 -wwpn=21:64:00:c0:dd:19:4c:39 -blade=2 -ip=10.61.187.103

3. Verify if presented targets have been created.
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rcli list presented -blade=1 -ip=10.61.187.103
rcli list presented -blade=2 -ip=10.61.187.103

Presented Target Creation Support Note


Validate the DTA to source storage spoofing by checking flogi login on switches.



Verify presented targets using DTA Manager.

Create DTA Presented Target to Host Zoning


Physical Server Online Migration Zoning

1. Create the host to DTA port zones in migration fabric for DTA insertion as shown in Figure 127.
Note:
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Figure 127) DTA and host zoning in migration fabric for physical server online migration.

DTA10_BL1_FC3_Migration_Fabric_A
Port 1 (DTA10 BL1 FC3 in Migration Fabric A)
Port 5 (DM-RX200S6-25 HBA0 in Migration Fabric A)

DTA10_BL2_FC3_Migration_Fabric_A
Port 2 (DTA10 BL2 FC3 in Migration Fabric A)
Port 5 (DM-RX200S6-25 HBA0 in Migration Fabric A)

DTA10_BL1_FC4_Migration_Fabric_B
Port 1 (DTA10 BL1 FC4 in Migration Fabric B)
Port 5 (DM-RX200S6-25 HBA1 in Migration Fabric B)

DTA10_BL2_FC4_Migration_Fabric_B
Port 2 (DTA10 BL2 FC4 in Migration Fabric B)
Port 5 (DM-RX200S6-25 HBA1 in Migration Fabric B)
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Brocade Fabric

a. Create the zone and add it to the zoneconfig in migration fabric A.
zoneCreate "DTA10_BL1_FC3_Migration_Fabric_A","1,1"
zoneAdd "DTA10_BL1_FC3_Migration_Fabric_A","1,5"
zoneCreate "DTA10_BL2_FC3_Migration_Fabric_A","1,2"
zoneAdd "DTA10_BL2_FC3_Migration_Fabric_A","1,5"
cfgAdd "MIG_LEFT", "DTA10_BL1_FC3_Migration_Fabric_A"
cfgAdd "MIG_LEFT", "DTA10_BL2_FC3_Migration_Fabric_A"

b. Activate the zoneset in migration fabric A.
cfgEnable "MIG_LEFT"
cfgSave

c.

Create the zone and add it to the zoneconfig in migration fabric B.

zoneCreate "DTA10_BL1_FC4_Migration_Fabric_B","1,1"
zoneAdd "DTA10_BL1_FC4_Migration_Fabric_B","1,6"
zoneCreate "DTA10_BL2_FC4_Migration_Fabric_B","1,2"
zoneAdd "DTA10_BL2_FC4_Migration_Fabric_B","1,6"
cfgAdd "MIG_RIGHT", "DTA10_BL1_FC4_Migration_Fabric_B"
cfgAdd "MIG_RIGHT", "DTA10_BL2_FC4_Migration_Fabric_B"

d. Activate the zoneconfig in migration fabric B.
cfgEnable "MIG_RIGHT"
cfgSave



Cisco Fabric

a. Create the zone and add it to the zoneset in migration fabric A.
conf t
zone name DTA10_BL1_FC3_Migration_Fabric_A vsan 55
member interface fc3/1
member interface fc3/5
zone name DTA10_BL2_FC3_Migration_Fabric_A vsan 55
member interface fc3/2
member interface fc3/5
zoneset name MIG_LEFT vsan 55
member DTA10_BL1_FC3_Migration_Fabric_A
member DTA10_BL2_FC3_Migration_Fabric_A
exit

b. Activate the zoneset in migration fabric A.
zoneset activate name MIG_LEFT vsan 55
end
copy running-config startup-config

c.

Create the zone and add it to the zoneset in migration fabric B.

conf t
zone name DTA10_BL1_FC4_Migration_Fabric_B vsan 55
member interface fc3/1
member interface fc3/6
zone name DTA10_BL2_FC4_Migration_Fabric_B vsan 55
member interface fc3/2
member interface fc3/6
zoneset name MIG_RIGHT vsan 55
member DTA10_BL1_FC4_Migration_Fabric_B
member DTA10_BL2_FC4_Migration_Fabric_B
exit

d. Activate the zoneset in migration fabric B.
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zoneset activate name MIG_RIGHT vsan 55
end
copy running-config startup-config



Virtual Server Online Migration Zoning

1. Create the host to DTA port zones in production fabric for DTA insertion as shown in Figure 128.
Figure 128) DTA and host zoning in production fabric for virtual server online migration.

DTA10_DM-RX200S6-25_Production_Fabric_A
21:64:00:c0:dd:19:4c:2e (DTA10 BL1 FC1 PT WWPN in Production Fabric A)
21:64:00:c0:dd:19:4c:38 (DTA10 BL2 FC1 PT WWPN in Production Fabric A)
21:00:00:24:ff:30:04:85 (DM-RX200S6-25 HBA0 WWPN in Production Fabric A)

DTA10_DM-RX200S6-25_Production_Fabric_B
21:64:00:c0:dd:19:4c:2f (DTA10 BL1 FC2 PT WWPN in Production Fabric B)
21:64:00:c0:dd:19:4c:39 (DTA10 BL2 FC2 PT WWPN in Production Fabric B)
21:00:00:24:ff:30:04:84 (DM-RX200S6-25 HBA1 WWPN in Production Fabric B)


Brocade Fabric

a. Create the zone and add it to the zoneconfig in production fabric A.
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zoneCreate "DTA02_DM-RX200S6-25", "21:00:00:24:ff:30:04:85"
zoneAdd "DTA02_DM-RX200S6-25", "21:64:00:c0:dd:19:4c:2e"
zoneAdd "DTA02_DM-RX200S6-25", "21:64:00:c0:dd:19:4c:38"
cfgAdd "PROD_LEFT", "DTA02_DM-RX200S6-25"

b. Activate the zoneset in production fabric A.
cfgEnable "PROD_LEFT"
cfgSave

c.

Create the zone and add it to the zoneconfig in production fabric B.

zoneCreate "DTA02_DM-RX200S6-25", "21:00:00:24:ff:30:04:84"
zoneAdd "DTA02_DM-RX200S6-25", "21:64:00:c0:dd:19:4c:2f"
zoneAdd "DTA02_DM-RX200S6-25", "21:64:00:c0:dd:19:4c:39"
cfgAdd "PROD_RIGHT", "DTA02_DM-RX200S6-25"

d. Activate the config in production fabric B.
cfgEnable "PROD_RIGHT"
cfgSave



Cisco Fabric

a. Create the zone and add it to the zoneset in production fabric A.
conf t
zone name DTA02_DM-RX200S6-25 vsan 10
member pwwn 21:00:00:24:ff:30:04:85
member pwwn 21:64:00:c0:dd:19:4c:2e
member pwwn 21:64:00:c0:dd:19:4c:38
zoneset name PROD_LEFT vsan 10
member DTA02_DM-RX200S6-25
exit

b. Activate the zoneset in production fabric A.
zoneset activate name PROD_LEFT vsan 10
end
copy running-config startup-config

c.

Create the zone and add it to the zoneset in production fabric B.

conf t
zone name DTA02_DM-RX200S6-25 vsan 10
member pwwn 21:00:00:24:ff:30:04:84
member pwwn 21:64:00:c0:dd:19:4c:2f
member pwwn 21:64:00:c0:dd:19:4c:39
zoneset name PROD_RIGHT vsan 10
member DTA02_DM-RX200S6-25
exit

d. Activate the zoneset in production fabric B.
zoneset activate name PROD_RIGHT vsan 55
end
copy running-config startup-config

Virtual Server Online Migration Support Note
Initiator on DTA will be shown as logged in.
After activating DTA presented target to host zones, rescan devices on host.
Host will now see additional paths, including four direct paths from source storage and four paths from
DTA.
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Offline Migration
Migration begins with the preparation and shutdown of migration hosts. After the migration host is down,
the source LUNs are presented to the DTA, and migration jobs are created and executed. After the
migration jobs are complete, the source and destination LUNs are removed from the DTA, and the source
LUNs are removed from the host.

Prepare Host
To prepare the host, complete the following steps:


Windows Host
a. Stop all services and applications (such as Microsoft Exchange Server, database, and backup)
that are dependent on external storage and set services to Disabled.



Linux Host
On a Linux host, to verify DM-MP multipath is configured and functioning correctly, do the following:
a. Stop all running I/O and applications that are dependent on external storage and disable
application startup scripts.
b. Make a copy of existing /etc/fstab. Comment the file systems dependent on external
storage in /etc/fstab; exclude boot LUN file systems if SAN boot.

cp /etc/fstab /etc/fstab_pre_mig
vi /etc/fstab
The modified /etc/vfstab appears as follows:
/dev/VolGroup00/LogVol00
/
ext3
defaults 1 1
LABEL=/boot
/boot
ext3
defaults 1 2
tmpfs
/dev/shm
tmpfs
defaults
0 0
devpts
/dev/pts
devpts gid=5,mode=620 0 0
sysfs
/sys
sysfs
defaults
0 0
proc
/proc
proc
defaults
0 0
/dev/VolGroup00/LogVol01
swap
swap
defaults 0 0
#/dev/mapper/mpath1
/fs1
ext3
defaults
1
#/dev/dmvg1/dmlvol1
/fs2
ext3
defaults
1 2

c.

Unmount file systems dependent on external storage. Exclude boot LUN file systems if
applicable.

umount /fs1
umount /fs2

d. Find the wwid of NetApp LUNs in the LUN Details tab in the HeSAN Site Survey and Plan
document (see Figure 106).
e. Make a copy of existing /etc/multipath.conf. Update /etc/multipath.conf with
NetApp wwid entries in blacklist_exceptions and the NetApp definitions.
Note:

The addition of the NetApp definitions before LUNs are present will allow the LUN proper path
priorities at boot time.

cp /etc/multipath.conf /etc/multipath.conf_pre_mig
vi /etc/multipath.conf

Existing:
defaults {
user_friendly_names yes
}
blacklist {
devnode "^(ram|raw|loop|fd|md|dm-|sr|scd|st)[0-9]*"
devnode "^(hd|xvd|vd)[a-z]*"
wwid "*"
}
# Make sure our multipath devices are enabled.
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blacklist_exceptions {
wwid "60060160ee851100af26248cae8adf11"
wwid "60060160ee851100d7f855b41e34e011"
wwid "60060160ee8511001bef0e472034e011"
}

Modified:
defaults {
user_friendly_names yes
}
blacklist {
devnode "^(ram|raw|loop|fd|md|dm-|sr|scd|st)[0-9]*"
devnode "^(hd|xvd|vd)[a-z]*"
wwid "*"
}
# Make sure our multipath devices are enabled.
blacklist_exceptions {
wwid "60060160ee851100af26248cae8adf11"
wwid "60060160ee851100d7f855b41e34e011"
wwid "60060160ee8511001bef0e472034e011"
wwid "60a98000486e64504334647166755352"
wwid "60a98000486e64504334647167384731"
wwid "60a98000486e64504334647167424c73"
}
devices
{
device
{
vendor
product
getuid_callout
prio_callout
features
hardware_handler
path_grouping_policy
failback
rr_weight
rr_min_io
path_checker
flush_on_last_del
}
}

"NETAPP"
"LUN"
"/sbin/scsi_id -g -u -s /block/%n"
"/sbin/mpath_prio_alua /dev/%n"
"1 queue_if_no_path"
"0"
group_by_prio
immediate
uniform
128
directio
yes

Support Note
The most current settings are found in the Linux Host Utilities Kit available on the NetApp Support site.
f.

Comment out the mpath entries in /var/lib/multipath/bindings.

vi /var/lib/multipath/bindings

Modified:
Multipath bindings, Version : 1.0
# NOTE: this file is automatically maintained by the multipath program.
# You should not need to edit this file in normal circumstances.
#
# This file was automatically generated by anaconda.
#
# Format:
# alias wwid
#
#mpath0 360060160ee851100af26248cae8adf11
#mpath1 360060160ee851100d7f855b41e34e011
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#mpath2 360060160ee8511001bef0e472034e011

g. If LABELs used in /etc/fstab, rename the /etc/blkid/blkid.tab file.
mv /etc/blkid/blkid.tab /etc/blkid/blkid.tab_pre_mig

h. Recreate the kernel initial RAM disk (initrd) to update WWN if SAN boot.


Determine existing initrd.

cat grub.conf
# grub.conf generated by anaconda
#
# Note that you do not have to rerun grub after making changes to this file
# NOTICE: You have a /boot partition. This means that
#
all kernel and initrd paths are relative to /boot/, eg.
#
root (hd0,0)
#
kernel /vmlinuz-version ro root=/dev/VolGroup00/LogVol00
#
initrd /initrd-version.img
#boot=/dev/mapper/mpath0
default=0
timeout=5
splashimage=(hd0,0)/grub/splash.xpm.gz
hiddenmenu
title Red Hat Enterprise Linux Server (2.6.18-194.el5)
root (hd0,0)
kernel /vmlinuz-2.6.18-194.el5 ro root=/dev/VolGroup00/LogVol00 rhgb quiet
initrd /initrd-2.6.18-194.el5.img



Make a copy of existing initrd.

cd /boot
cp initrd-2.6.18-194.el5.img initrd-2.6.18-194.el5.img.mig_bak



Recreate existing initrd.

mkinitrd -v -f initrd-2.6.18-194.el5.img 2.6.18-194.el5

2. Solaris Host
i.

Stop all running I/O and applications that are dependent on external storage and disable application
startup scripts.
j.

Make a copy of existing /etc/vfstab. Comment file systems dependent on external storage in
/etc/vfstab; exclude boot LUN file systems if SAN boot.

cp /etc/vfstab /etc/vfstab_pre_mig
vi /etc/vfstab

The modified /etc/vfstab appears as follows:
#device
device
mount
fsck
point
type
pass
at
#
fd
/dev/fd fd
no
/dev/dsk/emcpower0b
swap
/dev/rdsk/emcpower0a
/
ufs
1
comment file systems on boot LUN /devices
sharefs /etc/dfs/sharetab
sharefs
ctfs
/system/contract
ctfs
objfs
/system/object objfs
swap
/tmp
tmpfs
yes
#/dev/dsk/emcpower1c
/dev/rdsk/emcpower1c
#/dev/dsk/emcpower2c
/dev/rdsk/emcpower2c

k.

- /proc
no
no
/fs1
/fs2

mount

-

/proc

mount #to mount
proc

-

to
no

no
- /dev/dsk/emcpower0a
===> Root on SANBoot LUN. Do not
/devices
devfs
no
no
no
-

-

ufs
ufs

1
1

yes
yes

-

Unmount file systems dependent on external storage; exclude boot LUN file systems if SAN boot.

umount /fs1
umount /fs2
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Shut Down Host
To shut down host, complete the following steps:
1. Windows Host
Shut down all the open programs.


In Windows 2008, at the command prompt, type:

shutdown –s –t 0



Windows 2003, at the command prompt, type:

shutdown /s /t:0

2. Linux Host
/sbin/shutdown –h now

3. Solaris Host
/usr/sbin/shutdown –i0 –g0 -y

Configure Source Array
Best Practice
Present the LUNs to the DTA using the same LUN ID, if possible, as used for the server. If multiple
servers are being migrated at the same time with the same DTA2800, group each server‘s LUNs into
different multiples of 10:
Server1: LUN IDs 0–9, Server2: LUN IDs 10–19, Server3: LUN IDs 20–29, and so on.
To configure the source array, complete the following steps:
1. Present the source LUNs to the DTA.
2. To add all source LUNs for the migration host to the DTA storage group entity:
a. Expand Storage Groups. Right-click the DTA storage group and select ―Select LUNs‖ to view a
list of available LUNs (see Figure 81).
b. From the Show LUNs drop-down list, select All. In the Available LUNs pane expand the default
owner SP and click the checkbox next to each LUN to be assigned for data migration jobs. In the
Selected LUNs pane, select each LUN to be assigned for data migration jobs and set the host ID.
When complete, click OK.
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3. Verify the mapping of source LUNs to DTA.
a. Rescan the storage array to force LUN path discovery. Expand FC Discovered Targets, right-click
the WWPN of the destination storage array, and select Rescan (see Figure 86).
b. Refresh the DTA Manager to force configuration change discovery. Right-click the DTA and
select Refresh (see Figure 84).
Note:

In the DTA CLI, to view a list of all LUNs without details, execute show luns. To display all
DTA2800 LUNs, sizes, and path information, connect to a blade and execute show luninfo.

DTA2800 <1> (miguser) #> show luninfo
DTA2800 (miguser) #> show luns

Support Note
Verify that the LUN is visible on both blades. If it is only available on one blade, make sure the initiator
ports from both blades are in the initiator record.
c.

Verify source array exists in Arrays, array type is set to Source, LUN assignment is correct, and
all paths are available (see Figure 85).

Configure Offline Migration Job
To configure an offline migration job, complete the following steps:
1. Clear migration logs on DTA. From the left pane of the DTA Manager, right-click one of the blades.
Select View Logs and then select Data Migration Logs from the drop-down menu. Click OK.
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2. In the Router Log window, click Clear > OK.

3. Create the migration job.
a. Start the data migration wizard using the Wizards menu and select Configure Migration Jobs. At
the prompt, enter the data migration user password in the Data Migration Security dialog box
(default password is migration) and click OK (see Figure 89).
b. Open the Services window, and right-click the Data Migration jobs node. Select Configure
Migration Jobs (see Figure 90).
4. Select the source and destination LUNs for the migration job. The Create Data Migration Job dialog
box displays arrays, configured with a type (Source, Destination, or Src+Dest), in the right pane.
These are the arrays available to be used in creating migration jobs.
a. Expand a source array and a VPGROUP, click the source LUN for the data migration, drag the
LUN from the right pane into the left pane, and then drop the LUN onto the source LUN.
b. Expand a destination array and a VPGROUP, click the destination LUN for the data migration,
drag the LUN from the right pane into the left pane, and then drop the LUN onto the destination
LUN.
Note:
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Support Note
NetApp DTA Manager will not allow a LUN from a source array in the right pane to be dropped onto a
destination LUN in the left pane.
If a LUN of a smaller size from a source array in the right pane is dropped onto a destination LUN in
the left pane, the size discrepancy will produce an error message.
5. Configure the migration job.
a. Select Migration Type ―Offline (Local/Remote)‖ to schedule a data migration job in which the
servers affected by the migration jobs are down/offline.
b. Select Scheduling Type of ―Configure Only‖ to configure the migration job without any start time
or priority.
c.

Click Apply > OK > Close (see Figure 92).

Support Note


Start Now: To start migration job immediately after configuration is complete.



Schedule for later: To start migration jobs at a designated start time and start date.



Serial Schedule Jobs: To start migration jobs based on job priority; all jobs in a priority must
complete before next priority starts.



Configure Only: To start jobs manually after configuration is complete.
d. In the TP settings pane, select ―Yes, and no TP Validation‖ to verify thin-provisioned bits on the
source LUN contain a zero on the destination LUN.

Support Note
After running SRU:
1. Select TP Validation in the Data Migration Job Options dialog box if you are uncertain about the
data on the destination LUN, or if the destination LUN was used earlier for storing any other data.
Enabling validation makes sure that no corruption exists because of stale data in the destination
LUN. Enabling validation provides additional processing overhead. Typically, validation is not
required for a LUN newly created for data migration.
2. Do not select TP Validation in the Data Migration Job Options dialog box when the destination LUN
is known to be thin-provisioned storage and is newly created.
e. Select Verify Data after Migration Finished to perform a block-level byte-for-byte comparison of
the source and destination LUNs after the copy.
Best Practice
Run a verify job with every migration job.

Start Migration Job
To start a migration job, complete the following steps:
1. In the Services window, from the left pane select Data Migration Jobs. From the right pane, click the
Active Data Migration Jobs tab. Right-click the data migration job and select Start Job (Figure 93).
2. Select Start Now as Scheduling Type, and select Apply to start the migration job immediately. At the
prompt, enter the data migration user password in the Data Migration Security Check dialog box
(default password is migration) and click OK (see Figure 94).
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Monitor Migration Job Status
To monitor migration job status, complete the following steps:
1. In the Services window, from the left pane select Data Migration Jobs. From the right pane, select the
Active Data Migration Jobs tab. The Status and % Completed columns are automatically updated as
the job runs (see Figure 95).
Note:

To see details of an active or a completed migration job (Status, Migration State, Migration
Performance, Delta Time), from the left pane of the Services window expand Data Migration Jobs
and expand Group, then select the data migration job. The details will be displayed in the right
pane.

Acknowledge Offline Migration Job
To acknowledge an offline migration job, complete the following steps:
1. In the Services window, from the left pane, select Data Migration Jobs. From the right pane, select
the Completed Data Migration Jobs tab.
Note:

Notice the Status column shows Completed and % Completed column shows 100%.

2. Select the migration job, right-click and select "Acknowledge Completed Data Migration."
3. At the prompt, enter the data migration user password in the Data Migration Security Check dialog
box (default password is migration) and click OK (see Figure 96).

Remove LUNs from DTA
To remove LUNs from DTA, complete the following steps:
1. Log in to Navisphere as an administrator.
2. Expand the frame, expand Storage Groups, right-click the DTA Migration storage group, and select
―Select LUNs‖ (see Figure 81).
3. In the Selected LUNs pane, select the LUNs assigned for the data migration jobs. Click Remove > OK
(see Figure 97).
4. Remove the NetApp LUNs from the DTA.
B9CModeCluster::> lun unmap -vserver vserverdm1 -path /vol/DM_RX200S6_25/dm25_data1_lun -igroup
DM-RX200S6-25

Remove Source LUNs from Host
To remove source LUNs from the host, complete the following steps:
1. Log in to Navisphere as an administrator.
2. Expand the frame, expand Storage Groups, right-click the Host storage group, and select ―Select
LUNs‖ (see Figure 81).
3. In the Selected LUNs pane, select the LUNs assigned for the data migration jobs. Click Remove > OK
(see Figure 97).

Remove Source Storage and Host Zone
To remove source storage and host zone, complete the following steps:
ZNE_RX25_CX700_P0
ZNE_RX25_CX700_P1
1. Brocade Fabric
a. Remove the zone from the zoneset in fabric A.
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cfgDelete "PROD_LEFT", "RX25_CX700"
zoneDelete "RX25_CX700"

b. Activate the zoneset in fabric A.
cfgEnable "PROD_LEFT"
cfgSave

c.

Remove the zone from the zoneset in fabric B.

cfgDelete "PROD_RIGHT", "RX25_CX700"
zoneDelete "RX25_CX700"

d. Activate the zoneset in fabric B.
cfgEnable "PROD_RIGHT"
cfgSave

2. Cisco Fabric
a. Remove the zone from the zoneset in fabric A.
conf t
zoneset name PROD_LEFT vsan 10
no member RX25_CX700
no zone name RX25_CX700 vsan 10
exit

b. Activate the zoneset in fabric A.
zoneset activate name PROD_LEFT vsan 10
end
copy running-config startup-config

c.

Remove the zone from the zoneset in fabric B.

conf t
zoneset name PROD_RIGHT vsan 10
no member RX25_CX700
no zone name RX25_CX700 vsan 10
exit

d. Activate the zoneset in fabric B.
zoneset activate name PROD_RIGHT vsan 10
end
copy running-config startup-config

Online Migration
For online migration, complete the steps provided in NDCP Planner output.

Insert the DTA in the Server Data Path
For online migration, we must insert the DTA into the data path between the servers and source storage
array. Servers that are part of the data migration must access the LUNs provisioned to them through the
DTA, and we must eliminate direct access from the servers to the source storage array.
Note:

Make sure that multipathing software is configured for the host and all paths are healthy.

Physical Server Online Migration
We move the host HBA cables physically from production fabric to migration fabric or logically into a
VSAN/virtual fabric.
When using different switches for migration fabric, you will move the host cable physically. When using
same switch and a separate VSAN, you will logically move the port from the production VSAN to the
migration VSAN.
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1. Move host connection from Production Fabric A to Migration Fabric A or Migration VSAN A.
Move connection for host dm-rx200s6-25 from Production_Fabric A VSAN 1 port fc3/25 to
Migration_Fabric A VSAN 55 port fc3/25



Cisco fabric if using different VSAN in same switch.

DM-Cisco9506-1# conf t
Enter configuration commands, one per line. End with CNTL/Z.
DM-Cisco9506-1(config)# vsan database
DM-Cisco9506-1(config-vsan-db)# vsan 55
DM-Cisco9506-1(config-vsan-db)# vsan 55 name MIG_LEFT
DM-Cisco9506-1(config-vsan-db)# vsan 55 interface fc3/25
DM-Cisco9506-1(config-vsan-db)# exit
DM-Cisco9506-1(config)#exit



Verify the paths are active and healthy.

2. Move host connection from Production Fabric B to Migration Fabric B or Migration VSAN B.
Move connection for host dm-rx200s6-25 from Production_Fabric B VSAN 1 port fc3/25 to
Migration_Fabric B VSAN 55 port fc3/25



Cisco fabric if using different VSAN in same switch.

DM-Cisco9506-2# conf t
Enter configuration commands, one per line. End with CNTL/Z.
DM-Cisco9506-2(config)# vsan database
DM-Cisco9506-2(config-vsan-db)# vsan 55
DM-Cisco9506-2(config-vsan-db)# vsan 55 name MIG_RIGHT
DM-Cisco9506-2(config-vsan-db)# vsan 55 interface fc3/25
DM-Cisco9506-2(config-vsan-db)# exit
DM-Cisco9506-2(config)#exit



Verify the paths are active and healthy.

3. After moving the host ports, verify initiators are logged in on both blades of the DTA.
Host is now in migration fabric and accessing LUNs through DTA.
Virtual Server Online Migration
1. Remove direct path access from host to source storage by unzoning the host to source storage zones
in production fabric.


Unzone Host to Source Storage in Production Fabric A
a. Remove the zone from the zoneset in fabric A.

conf t
zoneset name PROD_LEFT vsan 10
no member dm-rx200s6-25_CX700
exit

b. Activate the zoneset in fabric A.
zoneset activate name PROD_LEFT vsan 10
end
copy running-config startup-config





Rescan paths on host.



Verify direct paths are in failed state and remaining paths are active and healthy.

Unzone Host to Source Storage in Production Fabric B
a. Remove the zone from the zoneset in fabric B.

conf t
zoneset name PROD_RIGHT vsan 10
no member dm-rx200s6-25_CX700
exit

b. Activate the zoneset in fabric B.
zoneset activate name PROD_RIGHT vsan 10
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end
copy running-config startup-config

2. Rescan paths on host.
a. Verify direct paths are in failed state and remaining paths in migration fabric are active and
healthy.
Best Practice
After DTA insertion, make sure all I/O is through DTA and no direct access.
Make sure host initiator is shown as logged in DTA for both the blades.

Remove LUN Maps on Source Storage for the Host
As a precaution, NetApp recommends removing the LUN maps on the source storage for the host.

Create Online Migration Jobs
Execute the commands from NDCP Planner output.
rcli add migration -dm_type=online -tp_dest -lun_any_wwuln='600508b400068ba80000a00008f20000' dmdest_lun_serial='1ka93$-hJ1pb' -blade=1 -ip=10.61.187.103
rcli add migration -dm_type=online -tp_dest -lun_any_wwuln='600508b400068ba80000a00008f80000' dmdest_lun_serial='1ka93$-hJ1pc' -blade=1 -ip=10.61.187.103

Execute Online Migration Jobs
Execute and monitor the migration jobs from the DTA Manager GUI.
Support Note
Do NOT acknowledge the job at this time. The host can remain up and active perpetually in the
completed state. All new incoming data will be split (mirrored) between the source and destination
storage.
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Cutover Operations
Prepare Host
During cutover time/outage, prepare host for shutdown. To prepare host for shutdown, complete the
following steps:
1. Windows Host
Stop all services and applications (such as Microsoft Exchange Server, database, and backup)
dependent on external storage and set services to Disabled.
2. Linux Host
On a Linux host, to verify DM-MP multipath is configured and functioning correctly, do the following:
a. Stop all running I/O and applications that are dependent on external storage and disable
application startup scripts.
b. Make a copy of existing /etc/fstab. Comment the file systems dependent on external storage
in /etc/fstab; exclude boot LUN file systems if SAN boot.
cp /etc/fstab /etc/fstab_pre_mig
vi /etc/fstab

The modified /etc/vfstab appears as follows:
/dev/VolGroup00/LogVol00
/
LABEL=/boot
/boot
tmpfs
/dev/shm
devpts
/dev/pts
sysfs
/sys
proc
/proc
/dev/VolGroup00/LogVol01
swap
#/dev/mapper/mpath1
/fs1
#/dev/dmvg1/dmlvol1
/fs2
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defaults 1 1
defaults 1 2
tmpfs
defaults
0 0
devpts gid=5,mode=620 0 0
sysfs
defaults
0 0
proc
defaults
0 0
defaults 0 0
ext3
defaults
1
ext3
defaults
1 2

c.

Unmount file systems dependent on external storage. Exclude boot LUN file systems if
applicable.

umount /fs1
umount /fs2

d. Find the wwid of NetApp LUNs in the LUN Details tab in the HeSAN Site Survey and Plan
document (see Figure 106).
e. Make a copy of existing /etc/multipath.conf. Update /etc/multipath.conf with NetApp
wwid entries in blacklist_exceptions and the NetApp definitions.
Note:

The addition of the NetApp definitions before LUNs are present will allow the LUN proper path
priorities at boot time.

cp /etc/multipath.conf /etc/multipath.conf_pre_mig
vi /etc/multipath.conf
Existing:
defaults {
user_friendly_names yes
}
blacklist {
devnode "^(ram|raw|loop|fd|md|dm-|sr|scd|st)[0-9]*"
devnode "^(hd|xvd|vd)[a-z]*"
wwid "*"
}
# Make sure our multipath devices are enabled.
blacklist_exceptions {
wwid "60060160ee851100af26248cae8adf11"
wwid "60060160ee851100d7f855b41e34e011"
wwid "60060160ee8511001bef0e472034e011"
}
Modified:
defaults {
user_friendly_names yes
}
blacklist {
devnode "^(ram|raw|loop|fd|md|dm-|sr|scd|st)[0-9]*"
devnode "^(hd|xvd|vd)[a-z]*"
wwid "*"
}
# Make sure our multipath devices are enabled.
blacklist_exceptions {
wwid "60060160ee851100af26248cae8adf11"
wwid "60060160ee851100d7f855b41e34e011"
wwid "60060160ee8511001bef0e472034e011"
wwid "60a98000486e64504334647166755352"
wwid "60a98000486e64504334647167384731"
wwid "60a98000486e64504334647167424c73"
}
devices
{
device
{
vendor
product
getuid_callout
prio_callout
features
hardware_handler
path_grouping_policy
failback
rr_weight
rr_min_io
path_checker
flush_on_last_del
}
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"NETAPP"
"LUN"
"/sbin/scsi_id -g -u -s /block/%n"
"/sbin/mpath_prio_alua /dev/%n"
"1 queue_if_no_path"
"0"
group_by_prio
immediate
uniform
128
directio
yes
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}

Support Note
The most current settings are found in the Linux Host Utilities Kit available on the NetApp Support site.
f.

Comment out the mpath entries in /var/lib/multipath/bindings.

vi /var/lib/multipath/bindings

Modified:
Multipath bindings, Version : 1.0
# NOTE: this file is automatically maintained by the multipath program.
# You should not need to edit this file in normal circumstances.
#
# This file was automatically generated by anaconda.
#
# Format:
# alias wwid
#
#mpath0 360060160ee851100af26248cae8adf11
#mpath1 360060160ee851100d7f855b41e34e011
#mpath2 360060160ee8511001bef0e472034e011

g. If LABELs used in /etc/fstab, rename the /etc/blkid/blkid.tab file.
mv /etc/blkid/blkid.tab /etc/blkid/blkid.tab_pre_mig

h. Recreate the kernel initial RAM disk (initrd) to update WWN if SAN boot.


Determine existing initrd.

cat grub.conf
# grub.conf generated by anaconda
#
# Note that you do not have to rerun grub after making changes to this file
# NOTICE: You have a /boot partition. This means that
#
all kernel and initrd paths are relative to /boot/, eg.
#
root (hd0,0)
#
kernel /vmlinuz-version ro root=/dev/VolGroup00/LogVol00
#
initrd /initrd-version.img
#boot=/dev/mapper/mpath0
default=0
timeout=5
splashimage=(hd0,0)/grub/splash.xpm.gz
hiddenmenu
title Red Hat Enterprise Linux Server (2.6.18-194.el5)
root (hd0,0)
kernel /vmlinuz-2.6.18-194.el5 ro root=/dev/VolGroup00/LogVol00 rhgb quiet
initrd /initrd-2.6.18-194.el5.img



Make a copy of existing initrd.

cd /boot
cp initrd-2.6.18-194.el5.img initrd-2.6.18-194.el5.img.mig_bak



Recreate existing initrd.

mkinitrd -v -f initrd-2.6.18-194.el5.img 2.6.18-194.el5

3. Solaris Host
a. Stop all running I/O and applications that are dependent on external storage and disable
application startup scripts.
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b. Make a copy of existing /etc/vfstab. Comment file systems dependent on external storage in
/etc/vfstab; exclude boot LUN file systems if SAN boot.
cp /etc/vfstab /etc/vfstab_pre_mig
vi /etc/vfstab

The modified /etc/vfstab appears as follows:
#device
device
mount
fsck
point
type
pass
at
#
fd
/dev/fd fd
no
/dev/dsk/emcpower0b
swap
/dev/rdsk/emcpower0a
/
ufs
1
comment file systems on boot LUN /devices
sharefs /etc/dfs/sharetab
sharefs
ctfs
/system/contract
ctfs
objfs
/system/object objfs
swap
/tmp
tmpfs
yes
#/dev/dsk/emcpower1c
/dev/rdsk/emcpower1c
#/dev/dsk/emcpower2c
/dev/rdsk/emcpower2c

c.

FS
fsck
boot options
- /proc
no
no
/fs1
/fs2

mount

-

/proc

mount #to mount
proc

-

to
no

no
- /dev/dsk/emcpower0a
===> Root on SANBoot LUN. Do not
/devices
devfs
no
no
no
-

-

ufs
ufs

1
1

yes
yes

-

Unmount file systems dependent on external storage; exclude boot LUN file systems if SAN boot.

umount /fs1
umount /fs2

Shut Down Host
To shut down host, complete the following steps:
1. Windows Host
a. Shut down all of your open programs.


In Windows 2008, at the command prompt, type:

shutdown –s –t 0



Windows 2003, at the command prompt, type:

shutdown /s /t:0

2. Linux Host
/sbin/shutdown –h now

3. Solaris Host
/usr/sbin/shutdown –i0 –g0 -y

Remove LUN Masks to the Initiator in DTA
To remove LUN masks to the initiator in DTA, complete the following steps:
1. Remove pseudo LUN mask.
The following commands are required for hosts utilizing an MPIO configuration that requires a
"pseudo" or "controller" LUN. It is typically not required to unmask the pseudo LUN if there is a LUN
present at LUN ID 0.
Note:

These commands should never be used for NetApp source arrays.

rcli remove lunmask -fc_target=50:00:1f:e1:50:0b:85:d8 -fc_initiator=21:00:00:24:ff:30:04:85 vpgindex=1 -lun_number=0 -blade=1 -ip=10.61.187.103
rcli remove lunmask -fc_target=50:00:1f:e1:50:0b:85:d8 -fc_initiator=21:00:00:24:ff:30:04:84 vpgindex=1 -lun_number=0 -blade=1 -ip=10.61.187.103
rcli remove lunmask -fc_target=50:00:1f:e1:50:0b:85:d8 -fc_initiator=21:00:00:24:ff:30:04:85 vpgindex=1 -lun_number=0 -blade=2 -ip=10.61.187.103
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rcli remove lunmask -fc_target=50:00:1f:e1:50:0b:85:d8
vpgindex=1 -lun_number=0 -blade=2 -ip=10.61.187.103
rcli remove lunmask -fc_target=50:00:1f:e1:50:0b:85:d8
vpgindex=1 -lun_number=0 -blade=1 -ip=10.61.187.103
rcli remove lunmask -fc_target=50:00:1f:e1:50:0b:85:d8
vpgindex=1 -lun_number=0 -blade=1 -ip=10.61.187.103
rcli remove lunmask -fc_target=50:00:1f:e1:50:0b:85:d8
vpgindex=1 -lun_number=0 -blade=2 -ip=10.61.187.103
rcli remove lunmask -fc_target=50:00:1f:e1:50:0b:85:d8
vpgindex=1 -lun_number=0 -blade=2 -ip=10.61.187.103

-fc_initiator=21:00:00:24:ff:30:04:84 -fc_initiator=21:00:00:24:ff:30:14:c5 -fc_initiator=21:00:00:24:ff:30:14:c4 -fc_initiator=21:00:00:24:ff:30:14:c5 -fc_initiator=21:00:00:24:ff:30:14:c4 -

2. Remove LUN masks for boot and data LUNs.
rcli remove lunmask -fc_initiator=21:00:00:24:ff:30:04:85 lun_any_wwuln=600508b400068ba80000a00000a60000 -blade=1 -ip=10.61.187.103
rcli remove lunmask -fc_initiator=21:00:00:24:ff:30:04:84 lun_any_wwuln=600508b400068ba80000a00000a60000 -blade=1 -ip=10.61.187.103
rcli remove lunmask -fc_initiator=21:00:00:24:ff:30:04:85 lun_any_wwuln=600508b400068ba80000a00000a60000 -blade=2 -ip=10.61.187.103
rcli remove lunmask -fc_initiator=21:00:00:24:ff:30:04:84 lun_any_wwuln=600508b400068ba80000a00000a60000 -blade=2 -ip=10.61.187.103
rcli remove lunmask -fc_initiator=21:00:00:24:ff:30:04:85 lun_any_wwuln=600508b400068ba80000a00008bc0000 -blade=1 -ip=10.61.187.103
rcli remove lunmask -fc_initiator=21:00:00:24:ff:30:04:84 lun_any_wwuln=600508b400068ba80000a00008bc0000 -blade=1 -ip=10.61.187.103
rcli remove lunmask -fc_initiator=21:00:00:24:ff:30:04:85 lun_any_wwuln=600508b400068ba80000a00008bc0000 -blade=2 -ip=10.61.187.103
rcli remove lunmask -fc_initiator=21:00:00:24:ff:30:04:84 lun_any_wwuln=600508b400068ba80000a00008bc0000 -blade=2 -ip=10.61.187.103

3. Verify LUNs are not presented to the initiator (host).
Note:

If "No LUN Mask found" is not returned for a specific host, do not proceed. Remove all LUN
masks for the desired hosts before proceeding.

rcli show lunmask -blade=1 -ip=10.61.187.103
rcli show lunmask -blade=2 -ip=10.61.187.103

Support Note


If "No LUN Mask found" is not returned for a specific host, do not proceed.



Remove all LUN masks for the desired hosts before proceeding.

Verify Job Is in Completed State
To verify job is in a completed state, complete the following steps using DTA Manager:

179

DTA Migrations Using NetApp DTA2800 Methodology

Acknowledge Migration Jobs
To acknowledge migration jobs, complete the following step using DTA Manager:
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Remove Access from Host to Source Storage Through DTA
To remove access from host to source storage through DTA, complete the following steps:
Physical Server Online Migration
To move host connections from migration fabric to production fabric, complete the following steps:
1. Move host connection from Migration Fabric A to Production Fabric A or Production VSAN A.


After migration of the host is complete move the cables back to production fabric from migration
fabric.

Move connection for host dm-rx200s6-25 from Migration_Fabric A VSAN 55 port fc3/25 to
Production_Fabric A VSAN 1 port fc3/25



Cisco fabric if using different VSAN in same switch.

DM-Cisco9506-1# conf t
Enter configuration commands, one per line. End with CNTL/Z.
DM-Cisco9506-1(config)# vsan database
DM-Cisco9506-1(config-vsan-db)# vsan 1
DM-Cisco9506-1(config-vsan-db)# vsan 1 name PROD_LEFT
DM-Cisco9506-1(config-vsan-db)# vsan 1 interface fc3/25
DM-Cisco9506-1(config-vsan-db)# exit
DM-Cisco9506-1(config)#exit
Verify the paths are active and healthy.

2. Move host connection from Migration Fabric B to Production Fabric B or Production VSAN B.
Move connection for host dm-rx200s6-25 from Migration_Fabric B VSAN 55 port fc3/25 to
Production_Fabric B VSAN 1 port fc3/25



Cisco fabric if using different VSAN in same switch.

DM-Cisco9506-2# conf t
Enter configuration commands, one per line. End with CNTL/Z.
DM-Cisco9506-2(config)# vsan database
DM-Cisco9506-2(config-vsan-db)# vsan 1
DM-Cisco9506-2(config-vsan-db)# vsan 1 name PROD_RIGHT
DM-Cisco9506-2(config-vsan-db)# vsan 1 interface fc3/25
DM-Cisco9506-2(config-vsan-db)# exit
DM-Cisco9506-2(config)#exit
Verify the paths are active and healthy.

Virtual Server Online Migration
To unzone host to DTA presented targets, complete the following steps:
1. Brocade Fabric
a. Remove the zone from the zoneset in fabric A.
cfgDelete "PROD_LEFT", "DTA10_DM-RX200S6-25"
zoneDelete "DTA10_DM-RX200S6-25"

a. Activate the zoneset in fabric A.
cfgEnable "PROD_LEFT"
cfgSave

b. Remove the zone from the zoneset in fabric B.
cfgDelete "PROD_RIGHT", "DTA10_DM-RX200S6-25"
zoneDelete "DTA10_DM-RX200S6-25"

c.

Activate the zoneset in fabric B.

cfgEnable "PROD_RIGHT"
cfgSave

2. Cisco Fabric
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a. Remove the zone from the zoneset in fabric A.
conf t
zoneset name PROD_LEFT vsan 10
no member DTA10_DM-RX200S6-25_CX700
no zone name DTA10_DM-RX200S6-25 vsan 10
exit

b. Activate the zoneset in fabric A.
zoneset activate name PROD_LEFT vsan 10
end
copy running-config startup-config

c.

Remove the zone from the zoneset in fabric B.

conf t
zoneset name PROD_RIGHT vsan 10
no member DTA10_DM-RX200S6-25
no zone name DTA10_DM-RX200S6-25 vsan 10
exit

d. Activate the zoneset in fabric B.
zoneset activate name PROD_RIGHT vsan 10
end
copy running-config startup-config

Remove LUNs from DTA
To remove LUNs from DTA, complete the following steps:
1. Log in to Navisphere as an administrator.
2. Expand the frame, expand Storage Groups, right-click the DTA Migration storage group, and select
―Select LUNs‖ (see Figure 81).
3. In the Selected LUNs pane, select the LUNs assigned for the data migration jobs. Click Remove > OK
(see Figure 97).
4. Remove the NetApp LUNs from the DTA.
B9CModeCluster::> lun unmap -vserver vserverdm1 -path /vol/DM_RX200S6_25/dm25_data1_lun -igroup
DM-RX200S6-25

5. For physical server online migration, remove source storage and host zone.
Note:

For virtual server online migration, source storage to host zones are removed from
zoneset/zoneconfig during DTA insertion.

DM_RX200S6_25_CX700 in fab A
DM_RX200S6_25_CX700 in fab B
Brocade Fabric
a. Remove the zone from the zoneset in fabric A.
cfgDelete "PROD_LEFT", "DM_RX200S6_25_CX700"
zoneDelete "DM_RX200S6_25_CX700"

b. Activate the zoneset in fabric A.
cfgEnable "PROD_LEFT"
cfgSave

c.

Remove the zone from the zoneset in fabric B.

cfgDelete "PROD_RIGHT", "DM_RX200S6_25_CX700"
zoneDelete "DM_RX200S6_25_CX700"

d. Activate the zoneset in fabric B.
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cfgEnable "PROD_RIGHT"
cfgSave

Cisco Fabric
a. Remove the zone from the zoneset in fabric A.
conf t
zoneset name PROD_LEFT vsan 10
no member DM_RX200S6_25_CX700
no zone name DM_RX200S6_25_CX700 vsan 10
exit

b. Activate the zoneset in fabric A.
zoneset activate name PROD_LEFT vsan 10
end
copy running-config startup-config

c.

Remove the zone from the zoneset in fabric B.

conf t
zoneset name PROD_RIGHT vsan 10
no member DM_RX200S6_25_CX700
no zone name DM_RX200S6_25_CX700 vsan 10
exit

d. Activate the zoneset in fabric B.
zoneset activate name PROD_RIGHT vsan 10
end
copy running-config startup-config

Remove Initiator Records from the DTA
To remove initiator records from the DTA, complete the following steps:
1. Remove the initiator records on the DTA by running RCLI commands generated in the planner output.
rcli
rcli
rcli
rcli
rcli
rcli
rcli
rcli

remove
remove
remove
remove
remove
remove
remove
remove

initiator
initiator
initiator
initiator
initiator
initiator
initiator
initiator

-fc_initiator=21:00:00:24:ff:30:14:c5
-fc_initiator=21:00:00:24:ff:30:14:c4
-fc_initiator=21:00:00:24:ff:30:14:c5
-fc_initiator=21:00:00:24:ff:30:14:c4
-fc_initiator=21:00:00:24:ff:30:04:85
-fc_initiator=21:00:00:24:ff:30:04:84
-fc_initiator=21:00:00:24:ff:30:04:85
-fc_initiator=21:00:00:24:ff:30:04:84

-blade=1
-blade=1
-blade=2
-blade=2
-blade=1
-blade=1
-blade=2
-blade=2

-ip=10.61.187.103
-ip=10.61.187.103
-ip=10.61.187.103
-ip=10.61.187.103
-ip=10.61.187.103
-ip=10.61.187.103
-ip=10.61.187.103
-ip=10.61.187.103

2. Verify initiator record deletion.
rcli list initiator -blade=1 -ip=10.61.187.103
rcli list initiator -blade=2 -ip=10.61.187.103

Remove Presented Targets on the DTA
To remove presented targets on the DTA, complete the following steps:
After all host migrations are complete from the source array, remove presented targets for that array on
the DTA.
1. Use RCLI commands generated in the planner output.
rcli
rcli
rcli
rcli

unmap
unmap
unmap
unmap

target
target
target
target

-fc_target=50:00:1f:e1:50:0b:85:d8
-fc_target=50:00:1f:e1:50:0b:85:dd
-fc_target=50:00:1f:e1:50:0b:85:dc
-fc_target=50:00:1f:e1:50:0b:85:d9

2. Verify presented targets are removed from the DTA.
rcli list presented -blade=1 -ip=10.61.187.103
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-fc_port=3
-fc_port=4
-fc_port=3
-fc_port=4

-blade=1
-blade=1
-blade=2
-blade=2

-ip=10.61.187.103
-ip=10.61.187.103
-ip=10.61.187.103
-ip=10.61.187.103

rcli list presented -blade=2 -ip=10.61.187.103

Postmigration Tasks
All server remediation is performed during postmigration. The third-party software is removed, NetApp
software is installed and configured, and then the host is brought up accessing the LUNs on NetApp.
1. Create a postmigration Snapshot copy:
B9CModeCluster::*> snap create -vserver vserverdm1 -volume DM_RX200S6_25 -snapshot post-migration

2. Create the host to destination zones.
Figure 129) Host and destination storage zoning.

RX25_FAS6080 in Production Fabric A
21:00:00:24:ff:30:16:ce (RX25 HBA 0 in Production Fabric A)
50:0a:09:85:87:39:a5:80 (FAS6080 C1 0b in Production Fabric A)
50:0a:09:85:97:39:a5:80 (FAS6080 C2 0b in Production Fabric A)

RX25_FAS6080 in Production Fabric B
21:00:00:24:ff:30:16:cf (RX25 HBA 1 in Production Fabric B)
50:0a:09:83:87:39:a5:80 (FAS6080 C1 0d in Production Fabric B)
50:0a:09:83:97:39:a5:80 (FAS6080 C2 0d in Production Fabric B)
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a. Create the zone in production fabric A.
zoneCreate "RX25_FAS6080", "21:00:00:24:ff:30:16:ce"
zoneAdd "RX25_FAS6080", "50:0a:09:85:87:39:a5:80"
zoneAdd "RX25_FAS6080", "50:0a:09:85:97:39:a5:80"

b. Create the zone in production fabric B.
zoneCreate "RX25_FAS6080", "21:00:00:24:ff:30:16:cf"
zoneAdd "RX25_FAS6080", "50:0a:09:83:87:39:a5:80"
zoneAdd "RX25_FAS6080", "50:0a:09:83:97:39:a5:80"



Cisco Fabric
a. Create the zone in production fabric A.

conf t
zone name RX25_FAS6080 vsan 10
member pwwn 21:00:00:24:ff:30:16:ce
member pwwn 50:0a:09:85:87:39:a5:80
member pwwn 50:0a:09:85:97:39:a5:80
exit
end

b. Create the zone in production fabric B.
conf t
zone name RX25_FAS6080 vsan 10
member pwwn 21:00:00:24:ff:30:16:cf
member pwwn 50:0a:09:83:87:39:a5:80
member pwwn 50:0a:09:83:97:39:a5:80
exit
end

Activate Destination Storage and Host Zone
To activate destination storage and host zone, complete the following tasks:
RX25_FAS6080 in Fab A
RX25_FAS6080 in Fab B
1. Brocade Fabric
a. Add the zone to the zoneset in fabric A.
cfgAdd "PROD_LEFT", "RX25_FAS6080"

b. Activate the zoneset in fabric A.
cfgEnable "PROD_LEFT"
cfgSave

c.

Add the zone to the zoneset in fabric B.

cfgAdd "PROD_RIGHT", "RX25_FAS6080"

d. Activate the zoneset in fabric B.
cfgEnable "PROD_RIGHT"
cfgSave

2. Cisco Fabric
a. Add the zone to the zoneset in fabric A.
conf t
zoneset name PROD_LEFT vsan 10
member RX25_FAS6080
exit

b. Activate the zoneset in fabric A.
zoneset activate name PROD_LEFT vsan 10
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end
copy running-config startup-config

c.

Add the zone to the zoneset in fabric B.

conf t
zoneset name PROD_RIGHT vsan 10
member RX25_FAS6080
exit

d. Activate the zoneset in fabric B.
zoneset activate name PROD_RIGHT vsan 10
end
copy running-config startup-config

Local Boot Process
1. Power cycle the server and allow the boot process to complete.

SAN Boot Process
To create and bind portset, map boot LUN from NetApp and boot server, complete the following steps:
1. Create a portset containing a single NetApp target port.
B9CModeCluster::*> portset create -vserver vserverdm1 -portset mig_single_path -port-name dmlif1

Support Note
Create the portset on the NetApp storage that is the primary controller of the boot LUN to access the
boot LUN through a primary path.
2. Bind portset to create a single path to NetApp target.
B9CModeCluster::*> igroup bind -vserver vserverdm1 -igroup DM_RX200S6_25 -portset mig_single_path

3. Map NetApp boot LUN to host.
B9CModeCluster::> lun map -vserver vserverdm1 -path /vol/DM_RX200S6_25/dm25_boot_lun -igroup
DM_RX200S6_25 -lun-id 0

Solaris Host
Note:

The host boots from the EMC LUN to modify new NetApp LUN contents by editing of files and
running of commands.

1. Log into Navisphere as administrator.
2. Expand Storage Groups. Right-click the host storage group and select ―Select LUNs‖ to view a list of
available LUNs.
3. From the Show LUNs drop-down list, click Select All. In the Available LUNs pane, expand the default
owner SP and select the checkbox next to boot LUN of the host. In the Selected LUNs pane, select
the boot LUN and set the host ID to 0. When complete, click "OK."
4. Zone single path to the EMC boot LUN and Solaris host.
ZONE_RX25_CX700_P0
50:06:01:60:30:60:0e:b6 (CX700 SPA P0 in Fabric A)
21:00:00:24:ff:30:16:ce (RX25 HBA 0 in Fabric A)


Brocade Fabric
a. Create the zone in fabric A.
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zoneCreate "RX25_CX700_mig_single_path", "21:00:00:24:ff:30:16:ce"
zoneAdd "RX25_CX700_mig_single_path", "50:06:01:60:30:60:0e:b6"
cfgAdd "PROD_LEFT", "RX25_CX700_mig_single_path"

b. Activate the zoneset in fabric A.
cfgEnable "PROD_LEFT"
cfgSave



Cisco Fabric
a. Create the zone in fabric A.

conf t
zone name RX25_CX700_mig_single_path vsan 10
member pwwn 21:00:00:24:ff:30:16:ce
member pwwn 50:06:01:60:30:60:0e:b6
zoneset name PROD_LEFT vsan 10
member RX25_CX700_mig_single_path
exit

b. Active the zoneset in fabric A.
zoneset activate name PROD_LEFT vsan 10
end
copy running-config startup-config

5. Bring up the host on the EMC boot LUN.
6. Confirm that EMC and NetApp LUNs are present in a single path.
cfgadm –al
Ap_Id
c4
c4::5006016030600eb6
c4::500a09858739a580
c7
pcie1
usb2/1
usb2/2
usb3/1
usb3/2
usb4/1
usb4/2
<snip>

Type
fc-fabric
disk
disk
fc-fabric
vga/hp
unknown
unknown
unknown
unknown
usb-device
unknown

Receptacle
connected
connected
connected
connected
connected
empty
empty
empty
empty
connected
empty

Occupant
configured
configured
configured
unconfigured
configured
unconfigured
unconfigured
unconfigured
unconfigured
configured
unconfigured

Condition
unknown
unknown
unknown
unknown
ok
ok
ok
ok
ok
ok
ok

7. Rescan and build new devices.
cfgadm -c configure c4
devfsadm

8. Verify both LUNs are present and ASCII label of NetApp LUN.
format
Searching for disks...done
AVAILABLE DISK SELECTIONS:
0. c4t500A09858739A580d0 <DEFAULT cyl 2607 alt 2 hd 255 sec 63>
/pci@0,0/pci8086,3410@9/pci1077,15d@0,1/fp@0,0/disk@w500a09858739a580,0
1. c4t5006016030600EB6d0 <DEFAULT cyl 2607 alt 2 hd 255 sec 63>
/pci@0,0/pci8086,3410@9/pci1077,15d@0,1/fp@0,0/disk@w5006016030600eb6,0
2. emcpower0a <DEFAULT cyl 2607 alt 2 hd 255 sec 63> /pseudo/emcp@0
Specify disk (enter its number):
(hit ctrl-c)

9. Verify file system integrity by running fsck on new NetApp LUN.
fsck /dev/rdsk/c4t500A09858739A580d0s0

10. Mount root partition on NetApp LUN.
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mount /dev/dsk/c4t500A09858739A580d0s0 /mnt

Best Practice
To modify new NetApp LUN contents while booted from EMC LUN, editing of files and running of
commands will be against /mnt mount point. Be sure to use the /mnt file system, or the files will be
modified on the EMC LUN.
11. Replace the MPIO device used in /mnt/etc/vfstab with a single system path.
Assume:
emcpower0a -> s0
emcpower0b -> s1
emcpower0c -> s3
emcpower0d -> s4
Support Note
Powermt display only shows slice0 (emcpower0a).
12. Make a copy of existing /mnt/etc/vfstab. Update /mnt/etc/vfstab to replace EMC devices
with NetApp devices.
cp /mnt/etc/vfstab /mnt/etc/vfstab_post_mig
vi /mnt/etc/vfstab

Existing:
#device
device
mount
#to mount
to fsck
point
#
fd
/dev/fd fd
no
/proc
/proc
proc
no
/dev/dsk/emcpower0b
swap
/dev/dsk/emcpower0a
/dev/rdsk/emcpower0a
/devices
/devices
devfs
sharefs /etc/dfs/sharetab
sharefs
ctfs
/system/contract
ctfs
objfs
/system/object objfs
swap
/tmp
tmpfs
yes
#/dev/dsk/emcpower1c
/dev/rdsk/emcpower1c
#/dev/dsk/emcpower2c
/dev/rdsk/emcpower2c

FS
type
/
no
/fs1
/fs2

fsck
pass

mount
mount
at boot options

no
ufs
no
no
no
-

1
-

ufs
ufs

1
1

no

-

yes
yes

-

Modified:
#device
device
mount
FS
fsck
mount
mount
#to mount
to fsck
point
type
pass
at boot options
#
fd
/dev/fd fd
no
/proc
/proc
proc
no
/dev/dsk/c4t500A09858739A580d0s1
swap
no
/dev/dsk/c4t500A09858739A580d0s0
/dev/rdsk/c4t500A09858739A580d0s0
no
/devices
/devices
devfs
no
sharefs /etc/dfs/sharetab
sharefs no
ctfs
/system/contract
ctfs
no
objfs
/system/object objfs
no
swap
/tmp
tmpfs
yes
#/dev/dsk/emcpower1c
/dev/rdsk/emcpower1c
/fs1
ufs
1
yes
#/dev/dsk/emcpower2c
/dev/rdsk/emcpower2c
/fs2
ufs
1
yes
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/

-

ufs

1

13. Make a copy of existing /mnt/etc/system. Update /mnt/etc/system file and remove rootdev
entry pointing to EMC device.
cp /mnt/etc/system /mnt/etc/system_post_mig
vi /mnt/etc/system

Existing:
*** Begin EMCpower added lines *** DO NOT EDIT BELOW THIS LINE ***
forceload: drv/sd
forceload: drv/emcp
rootdev: /pseudo/emcp@0:a,blk
forceload: misc/emcpmpx
forceload: misc/emcpsapi
forceload: misc/emcpcg
forceload: misc/emcpgpx
forceload: misc/emcpdm
forceload: misc/emcpioc
set emcp:bPxEnableInit=1
set
set
set
***

default_stksize=0x5000
lwp_default_stksize=0x5000
rpcmod:svc_default_stksize=0x5000
End EMCpower added lines *** DO NOT EDIT ABOVE THIS LINE ***

Modified:
*** Begin EMCpower added lines *** DO NOT EDIT BELOW THIS LINE ***
forceload: drv/sd
forceload: drv/emcp
forceload: misc/emcpmpx
forceload: misc/emcpsapi
forceload: misc/emcpcg
forceload: misc/emcpgpx
forceload: misc/emcpdm
forceload: misc/emcpioc
set emcp:bPxEnableInit=1
set default_stksize=0x5000
set lwp_default_stksize=0x5000
set rpcmod:svc_default_stksize=0x5000
*** End EMCpower added lines *** DO NOT EDIT ABOVE THIS LINE ***

14. Move /mnt/etc/path_to_inst.
mv /mnt/etc/path_to_inst /mnt/etc/path_to_inst_post_mig

15. Create NetApp device file in /mnt/dev tree.
devfsadm -C -r /mnt

16. Verify new disk entries in /mnt/dev/rdsk.
ls /mnt/dev/rdsk | grep t500A09858739A580

17. Make a copy of existing /mnt/boot/solaris/bootenv.rc.
cp /mnt/boot/solaris/bootenv.rc /mnt/boot/solaris/bootenv.rc_post_mig

18. Get new hardware path of NetApp boot LUN using "format."
format
Searching for disks...done
AVAILABLE DISK SELECTIONS:
0. c4t500A09858739A580d0 <DEFAULT cyl 2607 alt 2 hd 255 sec 63>
/pci@0,0/pci8086,3410@9/pci1077,15d@0,1/fp@0,0/disk@w500a09858739a580,0
1. c4t5006016030600EB6d0 <DEFAULT cyl 2607 alt 2 hd 255 sec 63>
/pci@0,0/pci8086,3410@9/pci1077,15d@0,1/fp@0,0/disk@w5006016030600eb6,0
2. emcpower0a <DEFAULT cyl 2607 alt 2 hd 255 sec 63>
/pseudo/emcp@0
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Specify disk (enter its number):
(hit Ctrl-C to cancel)

19. Make a copy of existing /mnt/boot/solaris/bootenv.rc. Update
/mnt/boot/solaris/bootenv.rc with value of bootpath parameter.
Existing:
#
# Copyright 2007 Sun Microsystems, Inc. All rights reserved.
# Use is subject to license terms.
#
#ident "@(#)bootenv.rc 1.33
07/03/03 SMI"
#
#
bootenv.rc -- boot "environment variables"
#
setprop ata-dma-enabled 1
setprop atapi-cd-dma-enabled 0
setprop ttyb-rts-dtr-off false
setprop ttyb-ignore-cd true
setprop ttya-rts-dtr-off false
setprop ttya-ignore-cd true
setprop ttyb-mode 9600,8,n,1,setprop ttya-mode 9600,8,n,1,setprop lba-access-ok 1
setprop prealloc-chunk-size 0x2000
setprop bootpath /pci@0,0/pci8086,3410@9/pci1077,15d@0,1/fp@0,0/disk@w5006016030600eb6,0:a
setprop keyboard-layout 'US-English'
setprop console 'text'

Modified:
#
# Copyright 2007 Sun Microsystems, Inc. All rights reserved.
# Use is subject to license terms.
#
#ident "@(#)bootenv.rc 1.33
07/03/03 SMI"
#
#
bootenv.rc -- boot "environment variables"
#
setprop ata-dma-enabled 1
setprop atapi-cd-dma-enabled 0
setprop ttyb-rts-dtr-off false
setprop ttyb-ignore-cd true
setprop ttya-rts-dtr-off false
setprop ttya-ignore-cd true
setprop ttyb-mode 9600,8,n,1,setprop ttya-mode 9600,8,n,1,setprop lba-access-ok 1
setprop prealloc-chunk-size 0x2000
setprop bootpath /pci@0,0/pci8086,3410@9/pci1077,15d@0,1/fp@0,0/disk@w500a09858739a580,0:a
setprop keyboard-layout 'US-English'
setprop console 'text'

20. Update boot archive information.
bootadm update-archive -R /mnt
Creating boot_archive for /mnt
updating /mnt/platform/i86pc/boot_archive

21. Rename PowerPath startup scripts.
mv /mnt/lib/svc/method/powerconfigcgs /mnt/lib/svc/method/powerconfigcgs.old
mv /mnt/lib/svc/method/powershift /mnt/lib/svc/method/powershift.old
mv /mnt/lib/svc/method/powerstartup /mnt/lib/svc/method/powerstartup.old

22. Trigger a "reconfiguration boot" when NetApp LUN boots.
touch /mnt/reconfigure
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Note:

Use touch /mnt/reconfigure, NOT /reconfigure.

23. Unmount the NetApp LUN.
umount /mnt

24. Shut down the host.
/usr/sbin/shutdown –i0 –g0 –y

25. Remove zoning single path to the EMC boot LUN for the Solaris host.
RX25_CX700_mig_single_path
50:06:01:60:30:60:0e:b6 (CX700 SPA P0 in Fabric A)
21:00:00:24:ff:30:16:ce (RX25 HBA 0 in Fabric A)


Brocade Fabric
a. Create the zone in fabric A.

cfgDelete "PROD_LEFT", "RX25_CX700_mig_single_path"
zoneDelete "RX25_CX700_mig_single_path”

b. Activate the zoneset in fabric A.
cfgEnable "PROD_LEFT"
cfgSave



Cisco Fabric
a. Create the zone in fabric A.

conf t
zoneset name PROD_LEFT vsan 10
no member RX25_CX700_mig_single_path
no zone name RX25_CX700 vsan 10
exit

b. Active the zoneset in fabric A.
zoneset activate name PROD_LEFT vsan 10
end
copy running-config startup-config

26. Boot system on NetApp LUN.
Boot into the FC HBA BIOS.
To boot the system on the NetApp LUN, first boot into the FC HBA BIOS and set NetApp LUN as the
boot device. The Qlogic and Emulex examples are shown in the following sections.


QLogic HBA
a. Press Ctrl+Q or Alt+Q during system startup.
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Figure 130) Qlogic interface, boot settings.



Emulex HBA
a. Press Alt+E or Crtl+E during system startup.

Figure 131) Emulex interface, boot devices.

Uninstall Source Storage Software
To uninstall source storage software, complete the following steps:
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Uninstall EMC PowerPath: Windows Host
On a Windows host, uninstall both PowerPath and Navisphere Agent as follows:
1. Click Start > Control Panel > Add or Remove Programs.
Figure 132) EMC software removal from Windows host using add or remove programs.

2. Reboot to verify that the system boots without PowerPath installed.
Uninstall EMC PowerPath: Linux Host
1. Identify installed packages.
rpm -qa | grep navi
naviagentcli-6.22.20.0.94-1
navicli-6.22.20.0.94-1

2. Uninstall Navisphere packages.
rpm -e naviagentcli-6.22.20.0.94-1 navicli-6.22.20.0.94-1
Shutting down Naviagent: [ OK ]

Uninstall EMC PowerPath: Solaris
1. Rename PowerPath startup scripts to original names.
mv /mnt/lib/svc/method/powerconfigcgs.old /mnt/lib/svc/method/powerconfigcgs
mv /mnt/lib/svc/method/powershift.old /mnt/lib/svc/method/powershift
mv /mnt/lib/svc/method/powerstartup.old /mnt/lib/svc/method/powerstartup

2. Identify installed PowerPath package names.
pkginfo | grep -i emc
system

EMCpower

EMC PowerPath

3. Uninstall PowerPath.
pkgrm EMCpower
The following package is currently installed:
EMCpower EMC PowerPath
(i386) 5.0.0_b141
Do you want to remove this package? [y,n,?,q] y

4. Identify installed Naviagent package names.
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pkginfo | grep -i navi
application NAVIAGENT
application NAVICLI
application NAVISCLI

Navisphere Disk Array Management Tool (AGENT)
Navisphere Disk Array Management Tool (CLI)
Navisphere Disk Array Management Tool (CLI)

5. Uninstall Naviagent packages.
pkgrm NAVIAGENT NAVICLI NAVISCLI

Reboot (After Software Removal)
To reboot, complete the following steps:
1. Shut down all the open programs.
2. Reboot the host.
3. Review logs for errors.


Windows Host


In Windows 2008, at the command prompt, type:

shutdown –r –t 0
eventvwr



In Windows 2003, at the command prompt, type:

shutdown /r /t:0
eventvwr



Linux Host

/sbin/shutdown –r
more /var/logs/messages



Solaris Host

/usr/sbin/shutdown –r
more /var/adm/messages

Create NetApp Snapshot Copy (SAN Boot Only)
To create NetApp Snapshot copy, use the following command:
B9CModeCluster::*> snap create -vserver vserverdm1 -volume DM_RX200S6_25 -snapshot post-mpio

Install NetApp Supported Software and Drivers
To install NetApp supported software and drivers, complete the following steps:


Windows Host
a. Install supported HBA drivers and firmware.
b. Install the required Microsoft hot fixes for NetApp HUK, DSM, and SnapDrive.

Note:
c.
Note:

Create a NetApp Snapshot copy of boot LUN before continuing (SAN boot only).
Install NetApp FCP Windows Host Utilities.
Select Yes to enable support for multipathing during installation.

d. Install NetApp DSM. If SAN boot, verify that DSM is operating properly. Verify that boot LUN is
under DSM management. Click Start > Administrative Tools > Server Manager > Storage > Data
ONTAP DSM Management > Virtual Disks. Select the boot volume (C:\).
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Figure 133) Data ONTAP DSM Management, single path.



Linux Host


DM-MP

a. Install supported HBA drivers and firmware.
b. Install NetApp HUK.
Note:


Refer to the Linux Host Utilities Installation and Setup Guide for details about HBA and MPIO
setup.

Solaris Host


MPxIO

a. Install supported HBA drivers and firmware.
b. Install NetApp HUK.
Note:
c.

Refer to the Solaris Host Utilities Installation and Setup Guide for details about HBA and MPIO
setup.
Configure MPxIO boot.

Support Note
When prompted to reboot, select yes.

stmsboot –e
WARNING: stmsboot operates on each supported multipath-capable controller
detected in a host. In your system, these controllers are
/pci@0,0/pci8086,3410@9/pci1077,15d@0,1/fp@0,0
/pci@0,0/pci8086,3410@9/pci1077,15d@0/fp@0,0
If you do NOT wish to operate on these controllers, please quit stmsboot
and re-invoke with -D { fp | mpt | mpt_sas} to specify which controllers you wish
to modify your multipathing configuration for.
Do you wish to continue? [y/n] (default: y) y
WARNING: This operation will require a reboot.
Do you want to continue ? [y/n] (default: y) y
updating /platform/i86pc/boot_archive
The changes will come into effect after rebooting the system.
Reboot the system now ? [y/n] (default: y) y

Note:

A copy of fp.conf and vfstab will be saved automatically in /etc/mpxio directory.

d. Verify that the hardware path is by scsi_vhci.
format
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Searching for disks...done
AVAILABLE DISK SELECTIONS:
0. c0t60A98000486E644F5734617244496A36d0 <DEFAULT cyl 2607 alt 2 hd 255 sec 63>
/scsi_vhci/disk@g60a98000486e644f5734617244496a36
Specify disk (enter its number):

e. Verify that the root and swap file systems are using MPxIO devices (cXt60xxxxx).
cat /etc/vfstab
#device
device
mount
FS
#to mount
to fsck
point
type
#
fd
/dev/fd fd
no
/proc
/proc
proc
no
/dev/dsk/c0t60A98000486E644F5734617244496A36d0s1
/dev/dsk/c0t60A98000486E644F5734617244496A36d0s0
/dev/rdsk/c0t60A98000486E644F5734617244496A36d0s0
/devices
/devices
devfs
sharefs /etc/dfs/sharetab
sharefs ctfs
/system/contract
ctfs
objfs
/system/object objfs
no
swap
/tmp
tmpfs
yes
#/dev/dsk/emcpower1c
/dev/rdsk/emcpower1c
/fs1
#/dev/dsk/emcpower2c
/dev/rdsk/emcpower2c
/fs2

f.

fsck
pass

mount
mount
at boot options

-

-

swap

-

no

/
no
no
no
-

ufs
-

1

no

-

ufs
ufs

1
1

yes
yes

-

Verify that /kernel/drv/fp.conf is configured for MPxIO.

cat /kernel/drv/fp.conf
<snip>
mpxio-disable="no";

g. Verify that NetApp entries (timeout values) exist.
cat /kernel/drv/ssd.conf
<snip>
sd-config-list="NETAPP LUN", "netapp-sd-config";
netapp-sd-config=1,0x9c01,64,0,0,0,0,0,0,0,0,0,300,30,30,0,0,8,0,0;
#
#
# sd-config-list entries created by basic_config script Sat Feb 5 04:30:33 2011

h. Record MPxIO to native path mappings.
stmsboot -L
non-STMS device name
STMS device name
-----------------------------------------------------------------/dev/rdsk/c4t500A09859739A580d0 /dev/rdsk/c0t60A98000486E644F5734617244496A36d0

Create Final Snapshot Copy
To create a final Snapshot copy, use the following command.
B9CModeCluster::*> snap create -vserver vserverdm1 -volume DM_RX200S6_25 -snapshot migrationcomplete

Provide All Paths (SAN Boot Only)
To provide all paths for SAN boot, complete the following steps:
1. Unbind portset to create a single path to NetApp target.
B9CModeCluster::*> igroup unbind -vserver vserverdm1 -igroup DM-RX200S6-25

2. Remove the portset.
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-

B9CModeCluster::*> portset destroy -vserver vserverdm1 -portset mig_single_path

Solaris Host
1. Rescan for new paths.
cfgadm -al
Ap_Id
c4
c4::500a09858739a580
c4::500a09859739a580
c7
c7::500a09838739a580
c7::500a09839739a580
pcie1
usb2/1
usb2/2
usb3/1
usb3/2
usb4/1
usb4/2
usb5/1
<snip>

Type
fc-fabric
disk
disk
fc-fabric
disk
disk
vga/hp
unknown
unknown
unknown
unknown
usb-device
unknown
unknown

Receptacle
connected
connected
connected
connected
connected
connected
connected
empty
empty
empty
empty
connected
empty
empty

Occupant
configured
configured
configured
configured
configured
configured
configured
unconfigured
unconfigured
unconfigured
unconfigured
configured
unconfigured
unconfigured

Condition
unknown
unknown
unknown
unknown
unknown
unknown
ok
ok
ok
ok
ok
ok
ok
ok

2. Build new device entries for new paths.
cfgadm -c configure c4
cfgadm -c configure c7

3. Verify new paths with luxadm.
luxadm probe
Found Fibre Channel device(s):
Node WWN:500a09808739a580 Device Type:Disk device
Logical Path:/dev/rdsk/c0t60A98000486E644F5734617244496A36d0s2

Verify Additional Paths Are Present (SAN Boot Only)
To verify that additional paths are present for SAN boot, complete the following steps:


Windows Host
a. Click Start > Administrative Tools > Server Manager > Storage > Data ONTAP DSM
Management > Virtual Disks and select the boot volume (C:\).

Figure 134) Data ONTAP DSM Management, multipath.
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a. On a Linux host, do as follows:
multipath -ll
mpath0 (360a98000486e64504334647166755352) dm-0 NETAPP,LUN
[size=10G][features=1 queue_if_no_path][hwhandler=0][rw]
\_ round-robin 0 [prio=100][active]
\_ 0:0:1:0 sdd 8:48 [active][ready]
\_ 1:0:1:0 sdj 8:144 [active][ready]
\_ round-robin 0 [prio=20][enabled]
\_ 0:0:0:0 sda 8:0
[active][ready]
\_ 1:0:0:0 sdg 8:96 [active][ready]



Solaris Host
a. On a Solaris host, do as follows:

luxadm display /dev/rdsk/c0t60A98000486E6450433464716754426Bd0s2
DEVICE PROPERTIES for disk: /dev/rdsk/c0t60A98000486E6450433464716754426Bd0s2
Vendor:
NETAPP
Product ID:
LUN
Revision:
7330
Serial Num:
HndOW4arDIj6
Unformatted capacity: 20480.000 MBytes
Read Cache:
Enabled
Minimum prefetch:
0x0
Maximum prefetch:
0x0
Device Type:
Disk device
Path(s):
/dev/rdsk/c0t60A98000486E6450433464716754426Bd0s2
/devices/scsi_vhci/disk@g60a98000486e6450433464716754426b:c,raw
Controller
/dev/cfg/c7
Device Address
500a09838739a580,0
Host controller port WWN
21000024ff3004b2
Class
secondary
State
ONLINE
Controller
/dev/cfg/c7
Device Address
500a09839739a580,0
Host controller port WWN
21000024ff3004b2
Class
primary
State
ONLINE
Controller
/dev/cfg/c4
Device Address
500a09858739a580,0
Host controller port WWN
21000024ff3004b3
Class
secondary
State
ONLINE
Controller
/dev/cfg/c4
Device Address
500a09859739a580,0
Host controller port WWN
21000024ff3004b3
Class
primary
State
ONLINE

Map Data LUNs
To map data LUNs, use the following command:
B9CModeCluster::> lun
DM_RX200S6_25 -lun-id
B9CModeCluster::> lun
DM_RX200S6_25 -lun-id



map -vserver vserverdm1 -path /vol/DM_RX200S6_25/dm25_data1_lun -igroup
1
map -vserver vserverdm1 -path /vol/DM_RX200S6_25/dm25_data2_lun -igroup
2

Windows Host
To verify that multipathing with NetApp DSM is configured and functioning correctly on a Windows
host, complete the following steps:
a. Verify devices and paths.
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b. Start > Administrative Tools > Server Manager > Storage > Data ONTAP DSM Management >
Virtual Disks and select each volume (see Figure 134).


Linux Host
To verify DM-MP multipath is configured and functioning correctly on a Linux host, complete the
following step:
a. Verify devices and paths.

multipath -ll
mpath0 (360a98000486e64504334647166755352) dm-0 NETAPP,LUN
[size=10G][features=1 queue_if_no_path][hwhandler=0][rw]
\_ round-robin 0 [prio=100][active]
\_ 0:0:1:0 sdd 8:48 [active][ready]
\_ 1:0:1:0 sdj 8:144 [active][ready]
\_ round-robin 0 [prio=20][enabled]
\_ 0:0:0:0 sda 8:0
[active][ready]
\_ 1:0:0:0 sdg 8:96 [active][ready]
mpath1 (360a98000486e64504334647167384731) dm-1 NETAPP,LUN
[size=2.0G][features=1 queue_if_no_path][hwhandler=0][rw]
\_ round-robin 0 [prio=100][active]
\_ 0:0:1:1 sde 8:64 [active][ready]
\_ 1:0:1:1 sdk 8:160 [active][ready]
\_ round-robin 0 [prio=20][enabled]
\_ 0:0:0:1 sdb 8:16 [active][ready]
\_ 1:0:0:1 sdh 8:112 [active][ready]
mpath2 (360a98000486e64504334647167424c73) dm-2 NETAPP,LUN
[size=3.0G][features=1 queue_if_no_path][hwhandler=0][rw]
\_ round-robin 0 [prio=100][active]
\_ 0:0:1:2 sdf 8:80 [active][ready]
\_ 1:0:1:2 sdl 8:176 [active][ready]
\_ round-robin 0 [prio=20][enabled]
\_ 0:0:0:2 sdc 8:32 [active][ready]
\_ 1:0:0:2 sdi 8:128 [active][ready]



Solaris Host
To verify that multipathing with MPxIO is configured and functioning correctly on a Solaris host,
complete the following steps:
a. Build new device entries for new paths.

cfgadm -c configure c4
cfgadm -c configure c7
devfsadm

b. Verify new paths with luxadm.
luxadm probe
Found Fibre Channel device(s):
Node WWN:500a09808739a580 Device Type:Disk device
Logical Path:/dev/rdsk/c0t60A98000486E6450433464716754426Bd0s2
Node WWN:500a09808739a580 Device Type:Disk device
Logical Path:/dev/rdsk/c0t60A98000486E64504334647167554B55d0s2
Node WWN:500a09808739a580 Device Type:Disk device
Logical Path:/dev/rdsk/c0t60A98000486E6450433464716755716Dd0s2

c.

Verify configuration with NetApp sanlun.

/opt/NTAP/SANToolkit/bin/sanlun lun show -p
ONTAP_PATH: DataMig-6080-1:/vol/DM_RX200S6_27/dm27_boot_lun
LUN: 0
LUN Size:
20g (21474836480)
Host Device: /dev/rdsk/c0t60A98000486E6450433464716754426Bd0s2
LUN State: GOOD Controller_CF_State: Cluster Enabled Controller Partner: DataMig-6080-2
Multipath_Policy: Native Multipath-provider: Sun Microsystems
TPGS flag: 0x10 Controller Status: TARGET PORT GROUP SUPPORT ENABLED
Target Port Group : 0x0
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Target Port Group State: Active/optimized
Vendor unique Identifier : 0x0 (Other FC)
Target Port Count: 0x8
Target Port ID : 0x101
Target Port ID : 0x102
Target Port ID : 0x103
Target Port ID : 0x104
Target Port ID : 0x105
Target Port ID : 0x106
Target Port ID : 0x107
Target Port ID : 0x108
Target Port Group : 0x1
Target Port Group State: Active/non-optimized
Vendor unique Identifier : 0x0 (Other FC)
Target Port Count: 0x8
Target Port ID : 0x1
Target Port ID : 0x2
Target Port ID : 0x3
Target Port ID : 0x4
Target Port ID : 0x5
Target Port ID : 0x6
Target Port ID : 0x7
Target Port ID : 0x8
ONTAP_PATH: DataMig-6080-1:/vol/DM_RX200S6_27/dm27_data1_lun
LUN: 1
LUN Size:
1g (1073741824)
Host Device: /dev/rdsk/c0t60A98000486E64504334647167554B55d0s2
LUN State: GOOD Controller_CF_State: Cluster Enabled Controller Partner: DataMig-6080-2
Multipath_Policy: Native Multipath-provider: Sun Microsystems
TPGS flag: 0x10 Controller Status: TARGET PORT GROUP SUPPORT ENABLED
Target Port Group : 0x0
Target Port Group State: Active/optimized
Vendor unique Identifier : 0x0 (Other FC)
Target Port Count: 0x8
Target Port ID : 0x101
Target Port ID : 0x102
Target Port ID : 0x103
Target Port ID : 0x104
Target Port ID : 0x105
Target Port ID : 0x106
Target Port ID : 0x107
Target Port ID : 0x108
Target
Target
Vendor
Target

Port Group : 0x1
Port Group State: Active/non-optimized
unique Identifier : 0x0 (Other FC)
Port Count: 0x8
Target Port ID : 0x1
Target Port ID : 0x2
Target Port ID : 0x3
Target Port ID : 0x4
Target Port ID : 0x5
Target Port ID : 0x6
Target Port ID : 0x7
Target Port ID : 0x8

ONTAP_PATH: DataMig-6080-1:/vol/DM_RX200S6_27/dm27_data2_lun
LUN: 2
LUN Size:
2g (2147483648)
Host Device: /dev/rdsk/c0t60A98000486E6450433464716755716Dd0s2
LUN State: GOOD Controller_CF_State: Cluster Enabled Controller Partner: DataMig-6080-2
Multipath_Policy: Native Multipath-provider: Sun Microsystems
TPGS flag: 0x10 Controller Status: TARGET PORT GROUP SUPPORT ENABLED
Target Port Group : 0x0
Target Port Group State: Active/optimized
Vendor unique Identifier : 0x0 (Other FC)
Target Port Count: 0x8
Target Port ID : 0x101
Target Port ID : 0x102
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Target Port ID : 0x103
Target Port ID : 0x104
Target
Target
Target
Target
Target
Target
Vendor
Target

Port
Port
Port
Port

ID
ID
ID
ID

:
:
:
:

0x105
0x106
0x107
0x108

Port Group : 0x1
Port Group State: Active/non-optimized
unique Identifier : 0x0 (Other FC)
Port Count: 0x8
Target Port ID : 0x1
Target Port ID : 0x2
Target Port ID : 0x3
Target Port ID : 0x4
Target Port ID : 0x5
Target Port ID : 0x6
Target Port ID : 0x7
Target Port ID : 0x8

Mount File Systems on Data LUNs
To mount file systems on data LUNs, complete the following steps:


Linux Host
a. Update storage device entries in /etc/fstab, if necessary.

/dev/VolGroup00/LogVol00
/
LABEL=/boot
/boot
tmpfs
/dev/shm
devpts
/dev/pts
sysfs
/sys
proc
/proc
/dev/VolGroup00/LogVol01
swap
/dev/mapper/mpath1
/fs1
/dev/dmvg1/dmlvol1
/fs2

ext3
ext3

swap

defaults 1 1
defaults 1 2
tmpfs
defaults
0 0
devpts gid=5,mode=620 0 0
sysfs
defaults
0 0
proc
defaults
0 0
defaults 0 0
ext3
defaults
1
ext3
defaults
1 2

b. Mount additional file systems.
mount /fs1
mount /fs2



Solaris Host
a. Update storage device entries in /etc/vfstab, if necessary.
The modified /etc/vfstab appears as follows:

#device
device
mount
FS
fsck
mount
mount
#to mount
to fsck
point
type
pass
at boot options
#
fd
/dev/fd fd
no
/proc
/proc
proc
no
/dev/dsk/c4t500A09858739A580d0s1
swap
no
/dev/dsk/c4t500A09858739A580d0s0
/dev/rdsk/c4t500A09858739A580d0s0
/
no
/devices
/devices
devfs
no
sharefs /etc/dfs/sharetab
sharefs no
ctfs
/system/contract
ctfs
no
objfs
/system/object objfs
no
swap
/tmp
tmpfs
yes
/dev/dsk/c0t60A98000486E64504334647167554B55d0s2
/dev/rdsk/c0t60A98000486E64504334647167554B55d0s2
/fs1
ufs
1
yes
/dev/dsk/c0t60A98000486E6450433464716755716Dd0s2
/dev/rdsk/c0t60A98000486E6450433464716755716Dd0s2
/fs2
ufs
1
yes

b. Mount additional file systems.
mount /fs1
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ufs

-

1

mount /fs2

Reenable All Services
To reenable all services, complete the following steps:


Windows Host
a. Start all services and applications dependent on external storage (Exchange, database, and
backup) and set service to Automatic.



Linux Host
a. Enable application startup scripts to allow application script startup during bootup.



Solaris Host
a. Enable application startup scripts to allow application script startup during bootup.

Reboot (Final Validation Reboot)
To verify that the server configuration is persistent across reboots, complete the following steps:
1. Shut down all of your open programs.
2. Reboot the host.
3. Review the logs for errors.


Windows Host

a. In Windows 2008, at the command prompt, type:
shutdown –r –t 0
eventvwr

b. In Windows 2003, at the command prompt, type:
shutdown /r /t:0
eventvwr



Linux Host

/sbin/shutdown –r
more /var/logs/messages



Solaris Host

/usr/sbin/shutdown –r
more /var/adm/messages

Add Second SAN Boot Path
To add a second SAN boot path, complete the following steps:
1. QLogic HBA:
Press Ctrl+Q or Alt+Q during system startup (see Figure 130).
2. Emulex HBA:
Press Alt+E or Crtl+E during system startup (see Figure 131).

7.5

Clean Up and Verify

In clean-up phase, DTA logs are collected, and the host initiator records and LUNs are removed from the
source storage. As required, DTA migration zones are deleted, and destination zones are modified.
Verification is the point where the accuracy of the migration plan execution is determined.
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Collect Migration Report from DTA
To save the data migration job information for the blades to a report (these steps must be performed
separately for both blades), complete the following steps:
1. From the left pane, click the Services tab. Select the blade on which the report is to be generated.
2. In the Data Migration Info tab, select the Data Migration Report checkbox.
Figure 135) DTA Manager data migration info tab.

3. To upload the report to a server, enter http://66.150.174.148:443/digest in the URL and click Set
URL. Enter the data migration admin password (default password is config) at the prompt. Click
Upload Report to transfer the report.
4. To save the report to the DTA FTP folder:
a. Click Save Report (default file name is Migration_Report.tar.gz). At the prompt, enter the
data migration miguser password (default password is migration).
b. Retrieve the report from the DTA with FTP using the credentials username: ftp, password: ftp.
C:\>ftp 10.61.187.119
Connected to 10.61.187.119.
220 (vsFTPd 2.0.5)
User (10.61.187.119:(none)): ftp
331 Please specify the password.
Password:
230 Login successful.
ftp> get Migration_Report.tar.gz
200 PORT command successful. Consider using PASV.
150 Opening BINARY mode data connection for Migration_Report.tar.gz (25355 bytes).
226 File send OK.
ftp: 25355 bytes received in 0.22Seconds 115.78Kbytes/sec.
ftp> quit

Clear Migration Report from DTA
To clear data migration job information for the blade, complete the following steps:
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1. Click Clear Report.
2. At the prompt, enter the data migration miguser password (default password is migration) (see
Figure 135).
Support Note
The migration report should be cleared to remove existing data migration information before beginning
new data migration jobs. If the reports are not cleared, the new data migration job information is
appended to the existing data migration information when the next report is generated.

Unzone Source and Destination Arrays from DTA
To unzone source and destination arrays from the DTA, complete the following steps:
Support Note
Perform this procedure at the end of the engagement.
1. Remove the source storage to DTA zone from both fabrics (see Figure 66).


Brocade Fabric
a. Remove the zone from the zoneset in fabric A.

cfgDelete "PROD_LEFT", "DTA10_VPG1_CX700"
zoneDelete "DTA10_VPG1_CX700"

b. Activate the zonesets in fabric A.
cfgEnable "PROD_LEFT"
cfgSave

c.

Remove the zone from the zoneset in fabric B.

cfgDelete "PROD_RIGHT", "DTA10_VPG1_CX700"
zoneDelete "DTA10_VPG1_CX700"

d. Activate the zonesets in fabric B.
cfgEnable "PROD_RIGHT"
cfgSave



Cisco Fabric
a. Remove the zone from the zoneset in fabric A.

conf t
zoneset name PROD_LEFT vsan 10
no member DTA10_VPG1_CX700
no zone name DTA10_VPG1_CX700 vsan 10
exit

b. Activate the zonesets in fabric A.
zoneset activate name PROD_LEFT vsan 10
end
copy running-config startup-config

c.

Remove the zone from the zoneset in fabric B.

conf t
zoneset name PROD_RIGHT vsan 10
no member DTA10_VPG1_CX700
no zone name DTA10_VPG1_CX700 vsan 10
exit

d. Activate the zonesets in fabric B.
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zoneset activate name PROD_RIGHT vsan 10
end
Copy running-config startup-config

2. Remove destination storage and DTA zone (see Figure 67).


Brocade Fabric
a. Remove the zone from zoneset in fabric A.

cfgDelete "PROD_LEFT", "DTA10_VPG1_FAS6080"
zoneDelete "DTA10_VPG1_FAS6080"

b. Activate the zonesets in fabric A.
cfgEnable "PROD_LEFT"
cfgSave

c.

Remove the zone from the zoneset in fabric B.

cfgDelete "PROD_RIGHT", "DTA10_VPG1_FAS6080"
zoneDelete "DTA10_VPG1_FAS6080"

d. Activate the zonesets in fabric B.
cfgEnable "PROD_RIGHT"
cfgSave



Cisco Fabric
a. Remove the zone from the zoneset in fabric A.

conf t
zoneset name PROD_LEFT vsan 10
no member DTA10_VPG1_FAS6080
no zone name DTA10_VPG1_FAS6080 vsan 10
exit

b. Activate the zonesets in fabric A.
zoneset activate name PROD_LEFT vsan 10
end
copy running-config startup-config

c.

Remove the zone from the zoneset in fabric B.

conf t
zoneset name PROD_RIGHT vsan 10
no member DTA10_VPG1_FAS6080
no zone name DTA10_VPG1_FAS6080 vsan 10
exit

d. Activate the zonesets in fabric B.
zoneset activate name PROD_RIGHT vsan 10
end
copy running-config startup-config

Remove Host to DTA Zones from the Migration Fabrics
To remove host to DTA zones, complete the following steps:
1. Remove DTA to host zones in migration fabric for physical server online migration.


Brocade Fabric
a. Remove the zone from zoneset in migration fabric A.

cfgDelete "MIG_LEFT", "DTA10_BL1_FC3_Migration_Fabric_A"
cfgDelete “MIG_LEFT”, “DTA10_BL2_FC3_Migration_Fabric_A”
zoneDelete "DTA10_BL1_FC3_Migration_Fabric_A”
zoneDelete “DTA10_BL2_FC3_Migration_Fabric_A”
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b. Activate the zoneset in migration fabric A.
cfgEnable "MIG_LEFT"
cfgSave

c.

Remove the zone from the zoneset in migration fabric B.

cfgDelete "MIG_RIGHT", "DTA10_BL1_FC4_Migration_Fabric_B”
cfgDelete “MIG_RIGHT”, “DTA10_BL2_FC4_Migration_Fabric_B”
zoneDelete "DTA10_BL1_FC4_Migration_Fabric_B”
zoneDelete “DTA10_BL2_FC4_Migration_Fabric_B”

d. Activate the zoneset in migration fabric B.
cfgEnable "MIG_RIGHT"
cfgSave



Cisco Fabric
a. Remove the zone from the zoneset in migration fabric A.

conf t
zoneset name MIG_LEFT vsan 55
no member DTA10_BL1_FC3_Migration_Fabric_A
no member DTA10_BL2_FC3_Migration_Fabric_A
no zone name DTA10_BL1_FC3_Migration_Fabric_A vsan 55
no zone name DTA10_BL2_FC3_Migration_Fabric_A vsan 55
exit

b. Activate the zoneset in migration fabric A.
zoneset activate name MIG_LEFT vsan 55
end
copy running-config startup-config

c.

Remove the zone from the zoneset in migration fabric B.

conf t
zoneset name MIG_RIGHT vsan 55
no member DTA10_BL1_FC4_Migration_Fabric_B
no member DTA10_BL2_FC4_Migration_Fabric_B
no zone name DTA10_BL1_FC4_Migration_Fabric_B vsan 55
no zone name DTA10_BL2_FC4_Migration_Fabric_B vsan 55
exit

d. Activate the zoneset in migration fabric B.
zoneset activate name MIG_RIGHT vsan 55
end
copy running-config startup-config

2. Remove DTA to host zones in production fabric for virtual server online migration.


Brocade Fabric
a. Remove the zone from zoneset in production fabric A.

cfgDelete "PROD_LEFT", "DTA10_DM-RX200S6-25"
zoneDelete "DTA10_DM-RX200S6-25”

b. Activate the zoneset in production fabric A.
cfgEnable "PROD_LEFT"
cfgSave

c.

Remove the zone from the zoneset in production fabric B.

cfgDelete "PROD_RIGHT", "DTA10_DM-RX200S6-25”
zoneDelete "DTA10_DM-RX200S6-25”

d. Activate the zoneset in production fabric B.
cfgEnable "PROD_RIGHT"
cfgSave
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Cisco Fabric
a. Remove the zone from the zoneset in production fabric A.

conf t
zoneset name PROD_LEFT vsan 10
no member DTA10_DM-RX200S6-25
no zone name DTA10_DM-RX200S6-25 vsan 10
exit

b. Activate the zoneset in production fabric A.
zoneset activate name PROD_LEFT vsan 10
end
copy running-config startup-config

c.

Remove the zone from the zoneset in production fabric B.

conf t
zoneset name PROD_RIGHT vsan 10
no member DTA10_DM-RX200S6-25
no zone name DTA10_DM-RX200S6-25 vsan 10
exit

d. Activate the zoneset in production fabric B.
zoneset activate name PROD_RIGHT vsan 55
end
copy running-config startup-config

Remove Offline Arrays from DTA
To remove offline arrays from DTA, complete the following steps:
1. Verify that targets are offline in DTA Manager; offline arrays will appear gray in the DTA Manager. An
array appears offline after it is unzoned from all array target ports.
2. From the left pane of NetApp DTA Manager, click the Device tab. Expand Arrays, right-click the name
of the offline array you want to remove, and select Remove Offline Array. Enter the data migration
miguser password (default password is migration) at the prompt.
Figure 136) DTA Manager, remove offline array.

3. If array is licensed, click NO at the prompt to leave the array license on the DTA.
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Support Note
The array license should not be removed. After being removed, the license is rendered worthless, and
a new license will need to be acquired to relicense the array.
Remove the array license only when you are 100% sure you will no longer use it on this DTA.
Figure 137) DTA Manager, remove offline array, remove array license.

4. At the prompt, click Yes to remove the physical targets for the array that is removed.
Figure 138) DTA Manager, remove offline array, remove physical targets.

Remove Source Array Configuration
To remove a source array configuration, complete the following steps:
Note:

Verify that all LUNs are removed from the migration host‘s storage group container.

1. Log in to Navisphere as an administrator.
2. Expand the frame and then expand Storage Groups. Right-click the DTA Migration storage group and
select LUNs.
3. From the Show LUNs drop-down list, select All to view a list of all LUNs assigned to that storage
group (see Figure 81).
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Figure 139) Navisphere, storage group properties, no LUNs.

4. Remove the host from the storage group:
a. Expand the frame and then expand Storage Groups. Right-click the migration host‘s storage
group and select Connect Hosts (see Figure 73).
b. In the Hosts tab, under Hosts to be Connected, select the migration host and click the left arrow
to move the migration host to Available Hosts. Click OK.
Figure 140) Navisphere, storage group properties, remove host connection.

5. Remove the migration host‘s storage group entity:
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6. Expand Storage Groups, right-click the migration host‘s storage group, and select Destroy. This will
remove the migration host storage group.
Figure 141) Navisphere, storage groups, destroy.

7. Deregister the migration host initiators:
a. Select the appropriate storage array, right-click the array name, and select Connectivity Status
(see Figure 68).
b. Select the Server Name column to sort, select all WWPNs associated with the migration host,
and click Deregister.
Figure 142) Navisphere, connectivity status, deregister.

Remove Destination Array Configuration
To remove destination array configuration, complete the following steps:
1. Verify that all LUNs are unmapped from the DTA initiator group. If all LUNs are unmapped, the DTA
initiator group will not show in the Mapped To column of the output.
B9CModeCluster::*> lun show -m -vserver vserverdm1

2. Remove the DTA initiator group.
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B9CModeCluster::*> igroup destroy -vserver vserverdm1 -igroup DTA10_VPG1

3. View all migration Snapshot copies.
B9CModeCluster::*> snap show -vserver vserverdm1 -volume DM_RX200S6_25

4. Remove all migration Snapshot copies.
B9CModeCluster::*> snap delete -vserver vserverdm1 -volume DM_RX200S6_25 post-migration
B9CModeCluster::*> snap delete -vserver vserverdm1 -volume DM_RX200S6_25 post-mpio
B9CModeCluster::*> snap delete -vserver vserverdm1 -volume DM_RX200S6_25 migration-complete

Verify LUN Alignment in 7-Mode Storage
Note:

For clustered Data ONTAP, use equivalent commands to identify alignment.

This step is required to verify that the destination LUNs are properly aligned. The LUN stats must be
cleared due to the fact that the DTA uses I/O patterns during the copy process that can provide false
positives. Resetting the LUN stats makes sure that the statistics were derived from host I/O.
1. Clear LUN stats.
rsh 10.61.187.127 -l root:migrate lun stats –z /vol/DM_RX200S6_25/dm25_data1_lun
rsh 10.61.187.127 -l root:migrate lun stats –z /vol/DM_RX200S6_25/dm25_data2_lun

Support Note
The -z option resets statics on all LUNs or a specific LUN by including the LUN path.
2. Generate I/O through normal use of the host during application validation testing performed by
customer.
3. Validate by inspecting the buckets of the read and write align histogram. Review the output for the
appropriate LUNs. Aligned LUNs will have majority percentage of reads and write in the 0 ―bucket."
“priv set diag; stats show lun”
…
lun:/vol/DM_RX200S6_25/dm25_data1_lun-HndPC4dgiqvD:read_align_histo.0:100%
lun:/vol/DM_RX200S6_25/dm25_data1_lun-HndPC4dgiqvD:read_align_histo.1:0%
lun:/vol/DM_RX200S6_25/dm25_data1_lun-HndPC4dgiqvD:read_align_histo.2:0%
lun:/vol/DM_RX200S6_25/dm25_data1_lun-HndPC4dgiqvD:read_align_histo.3:0%
lun:/vol/DM_RX200S6_25/dm25_data1_lun-HndPC4dgiqvD:read_align_histo.4:0%
lun:/vol/DM_RX200S6_25/dm25_data1_lun-HndPC4dgiqvD:read_align_histo.5:0%
lun:/vol/DM_RX200S6_25/dm25_data1_lun-HndPC4dgiqvD:read_align_histo.6:0%
lun:/vol/DM_RX200S6_25/dm25_data1_lun-HndPC4dgiqvD:read_align_histo.7:0%
lun:/vol/DM_RX200S6_25/dm25_data1_lun-HndPC4dgiqvD:write_align_histo.0:100%
lun:/vol/DM_RX200S6_25/dm25_data1_lun-HndPC4dgiqvD:write_align_histo.1:0%
lun:/vol/DM_RX200S6_25/dm25_data1_lun-HndPC4dgiqvD:write_align_histo.2:0%
lun:/vol/DM_RX200S6_25/dm25_data1_lun-HndPC4dgiqvD:write_align_histo.3:0%
lun:/vol/DM_RX200S6_25/dm25_data1_lun-HndPC4dgiqvD:write_align_histo.4:0%
lun:/vol/DM_RX200S6_25/dm25_data1_lun-HndPC4dgiqvD:write_align_histo.5:0%
lun:/vol/DM_RX200S6_25/dm25_data1_lun-HndPC4dgiqvD:write_align_histo.6:0%
lun:/vol/DM_RX200S6_25/dm25_data1_lun-HndPC4dgiqvD:write_align_histo.7:0%
...
lun:/vol/DM_RX200S6_25/dm25_data2_lun-HndPC4dgit3a:read_align_histo.0:100%
lun:/vol/DM_RX200S6_25/dm25_data2_lun-HndPC4dgit3a:read_align_histo.1:0%
lun:/vol/DM_RX200S6_25/dm25_data2_lun-HndPC4dgit3a:read_align_histo.2:0%
lun:/vol/DM_RX200S6_25/dm25_data2_lun-HndPC4dgit3a:read_align_histo.3:0%
lun:/vol/DM_RX200S6_25/dm25_data2_lun-HndPC4dgit3a:read_align_histo.4:0%
lun:/vol/DM_RX200S6_25/dm25_data2_lun-HndPC4dgit3a:read_align_histo.5:0%
lun:/vol/DM_RX200S6_25/dm25_data2_lun-HndPC4dgit3a:read_align_histo.6:0%
lun:/vol/DM_RX200S6_25/dm25_data2_lun-HndPC4dgit3a:read_align_histo.7:0%
lun:/vol/DM_RX200S6_25/dm25_data2_lun-HndPC4dgit3a:write_align_histo.0:100%
lun:/vol/DM_RX200S6_25/dm25_data2_lun-HndPC4dgit3a:write_align_histo.1:0%
lun:/vol/DM_RX200S6_25/dm25_data2_lun-HndPC4dgit3a:write_align_histo.2:0%
lun:/vol/DM_RX200S6_25/dm25_data2_lun-HndPC4dgit3a:write_align_histo.3:0%
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lun:/vol/DM_RX200S6_25/dm25_data2_lun-HndPC4dgit3a:write_align_histo.4:0%
lun:/vol/DM_RX200S6_25/dm25_data2_lun-HndPC4dgit3a:write_align_histo.5:0%
lun:/vol/DM_RX200S6_25/dm25_data2_lun-HndPC4dgit3a:write_align_histo.6:0%
lun:/vol/DM_RX200S6_25/dm25_data2_lun-HndPC4dgit3a:write_align_histo.7:0%
…

Reset DTA
To restore the device configuration parameters to the factory default values, run the following command:
Figure 143) Resetting factory defaults using DTA CLI.

Document Customer Environment
To document customer environment, complete the following steps:
1. Issue an AutoSupport command to document the final configuration.
B9CModeCluster::*> autosupport invoke -node B9CModeCluster-01 -type all –message “migrationfinal”

2. Use Synergy SDS to produce the configuration documentation.
3. Provide the customer with as-built documentation.

Appendix: Migration Variants
MPIO Stacks
Windows Host with HP MPIO DSM
Premigration Tasks
Before migration, verify the following:
1. Host LUN path verification:
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In Windows 2003:
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a. Click Start > All Programs > Hewlett-Packard > MPIO DSM Manager > Management Console.
b. Expand HP DSM MPIO Manager and then expand Array.
Figure 144) Hewlett-Packard MPIO DSM Manager, Windows 2003.



In Windows 2008:

c.

Click Start > Programs > Hewlett-Packard > MPIO DSM Manager > Management Console.

d. Expand HP DSM MPIO Manager and then expand Array.

Postmigration Tasks
After migration, complete the following steps:
1. Uninstall HP Multipath software, both the HP MPIO DSM and HP MPIO DSM Manager.


In Windows 2003, click Start > Control Panel > Add or Remove Programs.

Figure 145) Remove Hewlett-Packard software, Windows 2003.
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In Windows 2008, click Start > Control Panel > Programs and Features.
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Figure 146) Remove Hewlett-Packard software, Windows 2008.

Windows Host with Microsoft MPIO DSM
Windows 2008
1. Premigration tasks:
Click Start > Server Manager > Storage > Disk Management > Right-click Disk > Properties > MPIO
Tab. Verify the host LUN path before beginning the migration.
Figure 147) Microsoft MPIO DSM integrated with disk management.

2. Postmigration tasks:
a. Verify NetApp LUN under Microsoft MPIO Management.
b. Install NetApp FCP Windows Host Utilities.
c.

Verify NetApp LUN under Microsoft MPIO Management.

d. Click Start > Control Panel > MPIO > MPIO-ed Devices. Verify NetApp Vendor and Product ID
under MPIO-ed devices.
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Figure 148) Microsoft MPIO properties.

3. To verify the host LUN path, repeat step 2 for each LUN.

Linux RHEL5 Host with EMC PowerPath
Premigration Tasks
1. Host LUN path verification:
powermt display dev=all
Pseudo name=emcpowera
CLARiiON ID=APM00044302045 [SG_dm-rx200s6-25]
Logical device ID=60060160EE85110008BC97EBB1FCDF11 [bootlun_rhel5u5_emc_ppath_master]
state=alive; policy=CLAROpt; priority=0; queued-IOs=0
Owner: default=SP A, current=SP A
Array failover mode: 1
==============================================================================
---------------- Host --------------- Stor -- I/O Path - -- Stats --### HW Path
I/O Paths
Interf.
Mode
State Q-IOs Errors
==============================================================================
0 qla2xxx
sda
SP A0
active alive
0
0
0 qla2xxx
sdb
SP B0
active alive
0
0
1 qla2xxx
sdc
SP A1
active alive
0
0
1 qla2xxx
sdd
SP B1
active alive
0
0
Pseudo name=emcpowerc
CLARiiON ID=APM00044302045 [SG_dm-rx200s6-25]
Logical device ID=60060160EE8511007E555F4B2408E011 [linux_ppath_datalun1]
state=alive; policy=CLAROpt; priority=0; queued-IOs=0
Owner: default=SP A, current=SP A
Array failover mode: 1
==============================================================================
---------------- Host --------------- Stor -- I/O Path - -- Stats --### HW Path
I/O Paths
Interf.
Mode
State Q-IOs Errors
==============================================================================
0 qla2xxx
sde
SP A0
active alive
0
0
0 qla2xxx
sdg
SP B0
active alive
0
0
1 qla2xxx
sdi
SP A1
active alive
0
0
1 qla2xxx
sdk
SP B1
active alive
0
0
Pseudo name=emcpowerb
CLARiiON ID=APM00044302045 [SG_dm-rx200s6-25]
Logical device ID=60060160EE851100E4F08F5A2408E011 [linux_ppath_datalun2]
state=alive; policy=CLAROpt; priority=0; queued-IOs=0
Owner: default=SP A, current=SP A
Array failover mode: 1
==============================================================================
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---------------- Host ---------------

- Stor -

-- I/O Path -

-- Stats ---

### HW Path
I/O Paths
Interf.
Mode
State Q-IOs Errors
==============================================================================
0
0
1
1

qla2xxx
qla2xxx
qla2xxx
qla2xxx

sdf
sdh
sdj
sdl

SP
SP
SP
SP

A0
B0
A1
B1

active
active
active
active

alive
alive
alive
alive

0
0
0
0

0
0
0
0

2. Create a copy of existing /etc/fstab, and then comment file systems dependent on external
storage in /etc/fstab.
cp /etc/fstab /etc/fstab_bef_migration
vi /etc/fstab
/dev/VolGroup00/LogVol00
/
ext3
defaults 1 1
on SAN boot LUN LABEL=/boot
/boot
ext3
defaults 1 2
tmpfs
/dev/shm
tmpfs
defaults
0 0
devpts
/dev/pts
devpts gid=5,mode=620 0 0
sysfs
/sys
sysfs
defaults
0 0
proc
/proc
proc
defaults
0 0
/dev/VolGroup00/LogVol01
swap
swap
defaults 0 0
#/dev/mapper/mpath1
/fs1
ext3
defaults
1 2
file systems
#/dev/dmvg1/dmlvol1
/fs2
ext3
defaults
1 2
file systems

==> Root

==> Comment data
==> Comment data

3. Unmount file systems dependent on external storage; exclude boot LUN file systems if applicable.
4. Replace reference to PowerPath pseudo (emcpower) device with disk (/dev/sd*) path in /etc/fstab file
for boot LUN.
5. Rename Navisphere agent and PowerPath scripts so that it does not start during boot from NetApp
LUN postmigration.
mv
mv
mv
mv

/etc/init.d/naviagent /etc/init.d/naviagent_pre_mig
/etc/init.d/PowerPath /etc/init.d/PowerPath_pre_mig
/etc/init.d/PowerIscsi /etc/init.d/PowerIscsi_pre_mig
/etc/init.d/PowerMig /etc/init.d/PowerMig_pre_mig

Postmigration Tasks
1. Uninstall EMC Navisphere and PowerPath software. Discover the installed EMC software, uninstall
the EMC software, and verify the EMC software is no longer installed.
rpm -qa | grep -i naviagent
naviagentcli-6.22.20.0.94-1
rpm -qa | grep -i emc
EMCpower.LINUX-5.1.2.00.00-021
rpm -e naviagentcli-6.22.20.0.94-1
rpm -e EMCpower.LINUX-5.1.2.00.00-021
rpm -qa | grep -i naviagent
rpm -qa | grep -i emc

Host Cluster
Windows 2003 MSCS
Premigration Tasks
The following steps are performed after all services dependent on external storage (Exchange, database,
and backup) are stopped and set to "Disabled" on all nodes of the cluster.
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1. On all secondary nodes, stop Cluster Service and set it to Disabled.
Figure 149) Windows 2003 cluster service properties, disabled.

2. In Cluster Administrator, verify that the secondary node is down and all resources are moved to
primary node.
Figure 150) Windows 2003 cluster administrator.

3. Stop Cluster Service and set it to Disabled on the primary node (see Figure 149).
4. Provide single path access to the boot LUN, if SAN boot, and reboot the server.
Note:

Data corruption is possible if multiple paths remain on the system after MPIO has been removed.

5. Shut down all nodes of the cluster.
6. Unmap all data LUNs, including quorum LUN from all cluster nodes.
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Postmigration Tasks
After installing NetApp software and prior to enabling application services on all nodes of the cluster,
complete the following steps:
1. Shut down all nodes except the primary node.
2. Map all data LUNs, including quorum LUN, to the primary node on NetApp storage. Rescan LUNs on
primary node and verify all paths for each LUN.
Support Note
There is no need to change the serial number of the destination LUNs to match those of the source LUNs.

3. Verify the file system or disk by running the disk utility command (chkdsk) on all data and quorum
disks.
4. Set Cluster Service to "Automatic" and start it on the primary node.
Figure 151) Windows 2003 cluster service properties, automatic.

5. Open Cluster Administrator and verify all cluster resources are online (see Figure 150).
6. Map all data LUNs, including quorum LUN, to the secondary nodes and bring up secondary nodes
one at a time.
7. On all secondary nodes, set Cluster Service to Automatic and start it (see Figure 151).
8. Test cluster resources by moving them between the nodes of the cluster.

Windows 2008 FCS
Premigration Tasks
After all services that are dependent on external storage (Exchange, database, and backup) are stopped
and set to "Disabled" on all nodes of the cluster, complete the following steps:
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1. On all secondary nodes, stop Cluster Service and set it to Disabled.
Figure 152) Windows 2008 cluster service properties, disabled.

2. Verify in Failover Cluster Management that the secondary node is down and all resources have been
moved to the primary node.
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Figure 153) Windows 2008 failover cluster management.

3. Stop Cluster Service and set it to Disabled on the primary node (see Figure 152).
4. Provide single path access to the boot LUN, if SAN boot, and reboot the server.
Note:

Data corruption is possible if multiple paths remain on the system after MPIO has been removed.

5. Shut down all nodes of the cluster.
6. Unmap all data LUNs, including quorum LUN, from all cluster nodes.

Postmigration Tasks
After installing NetApp software and prior to enabling application services on all nodes of the cluster,
complete the following steps:
1. Shut down all nodes, except the primary node.
2. Map all data LUNs, including the quorum LUN, to the primary node on NetApp storage. Rescan LUNs
on primary node and verify all paths for each LUN.
Support Note
There is no need to change the serial number of the destination LUNs to match those of the source LUNs.

3. Verify the file system or disk by running the disk utility command (chkdsk) on all data and quorum
disks.
4. Set Cluster Service to Automatic and start it on the primary node.
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Figure 154) Windows 2008 cluster service properties, automatic.

5. Open Failover Cluster Management and verify that all cluster resources are online (see Figure 153).
6. Map all data LUNs, including quorum LUN, to the secondary nodes and bring up secondary nodes
one at a time.
7. On all secondary nodes, set Cluster Service to Automatic and start it (see Figure 154).
8. Test cluster resources by moving them between the nodes of the cluster.

Virtualization
ESX Host Raw Device Mapping (RDM)
Premigration Tasks
1. Perform discovery and analyze phases for the virtual machine using nSANity and NDCP.
2. Identify Raw Device Mapping LUNs to be migrated. To map RDM to LUN, do as follows:
find /vmfs/volumes -name **-rdm**
/vmfs/volumes/4ca83403-0f6f72a2-2964-00262d04ac28/Win2k3/Win2k3-rdmp.vmdk
/vmfs/volumes/4ca83403-0f6f72a2-2964-00262d04ac28/Win2k3/Win2k3_1-rdm.vmdk

3. Remove -rdmp and -rdm from the preceding output and run the vmkfstools command to find vml
mapping and RDM type.
vmkfstools -q /vmfs/volumes/4ca83403-0f6f72a2-2964-00262d04ac28/Win2k3/Win2k3.vmdk
Disk /vmfs/volumes/4ca83403-0f6f72a2-2964-00262d04ac28/Win2k3/Win2k3.vmdk is a Passthrough Raw
Device Mapping
Maps to: vml.02000200006006016001240f002c8cb7c393f1e011524149442035
====> RDM Physical
vmkfstools -q /vmfs/volumes/4ca83403-0f6f72a2-2964-00262d04ac28/Win2k3/Win2k3_1.vmdk
Disk /vmfs/volumes/4ca83403-0f6f72a2-2964-00262d04ac28/Win2k3/Win2k3_1.vmdk is a Non-passthrough
Raw Device Mapping
Maps to: vml.02000300006006016001240f00327a3fd493f1e011524149442035
====> RDM Virtual
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4. Run the esxcfg-scsidevs -u command to identify the NAA to RDM device mapping.
esxcfg-scsidevs -u | grep vml.02000200006006016001240f002c8cb7c393f1e011524149442035
naa.6006016001240f002c8cb7c393f1e011
vml.02000200006006016001240f002c8cb7c393f1e011524149442035
====> RDM Physical
esxcfg-scsidevs -u | grep vml.02000300006006016001240f00327a3fd493f1e011524149442035
naa.6006016001240f00327a3fd493f1e011
vml.02000300006006016001240f00327a3fd493f1e011524149442035
====> RDM Virtual

5. Using the information in step 4, note down the RDM mapping to device.
Virtual Machine -> Hardware -> NAA -> Compatibility mode
Win2k3 VM -> scsi0:1 -> naa.6006016001240f002c8cb7c393f1e011 -> RDM Physical
Win2k3 VM -> scsi0:2 -> naa.6006016001240f00327a3fd493f1e011 -> RDM Virtual
6. On the virtual machine, stop all running I/O and applications and disable application startup scripts.
7. To shut down the virtual machine, log in to the guest operating system and issue a shutdown
command. Verify with VMware vSphere® Client.
Figure 155) vSphere client.

8. Remove RDM LUNs from the virtual machine.
Note:
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Delete the RDM from the disk when removing it. The LUN contents are not affected.
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Figure 156) Virtual machine properties, remove RDM.
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9. Present both the source and destination LUNs to the DTA.
10. Configure the offline migration job.
11. Execute and monitor the migration job status.
12. Acknowledge the migration job.
13. Configure data migration verify job.
14. Execute and monitor verify job.
15. Acknowledge verify job.

Postmigration Tasks
1. Unmap source and LUNs from VMware® ESX® server and DTA.
2. Unmap destination LUNs from the DTA and map it to the ESX server.
3. Rescan NetApp LUNs on the ESX server.
Figure 157) vSphere client, scan for new storage devices.

4. Verify new devices and paths.
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Figure 158) vSphere client, manage paths.

5. Using information from the migration, note down the RDM mapping to device.
Go to Virtual Machine > Hardware > NAA > Compatibility mode.
Win2k3 VM > scsi0:1 > naa.60a98000486e6450433466686d55734e > RDM Physical
Win2k3 VM > scsi0:2 > naa.60a98000486e6450433466686d566758 > RDM Virtual
6. Add the RDM devices to the corresponding virtual machine using the information from the RDM
mapping to device as shown in the following screenshots.
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Figure 159) vSphere Client, add hardware > hard disk.

7. Power on the virtual machine and verify the virtual machine RDM devices.
8. Enable all applications, reboot, and perform a final verification of the virtual machine.

Feedback
We continually try to improve the quality and usefulness of NetApp documentation. If you have any
corrections, feedbacks, or requests for additional documentation, send an e-mail message to dl-ngs-pseng-tw@netapp.com.

Version History
Version

Date

Document Version History

Version 1.0

May 2012

Initial release

Version 2.0

May 2013

 Licensing, features, and addition of physical server and virtual server online
migration
 Support for clustered Data ONTAP and E-Series

232

DTA Migrations Using NetApp DTA2800 Methodology

Refer to the Interoperability Matrix Tool (IMT) on the NetApp Support site to validate that the exact product
and feature versions described in this document are supported for your specific environment. The NetApp
IMT defines the product components and versions that can be used to construct configurations that are
supported by NetApp. Specific results depend on each customer's installation in accordance with published
specifications.

NetApp provides no representations or warranties regarding the accuracy, reliability, or serviceability of any
information or recommendations provided in this publication, or with respect to any results that may be
obtained by the use of the information or observance of any recommendations provided herein. The
information in this document is distributed AS IS, and the use of this information or the implementation of
any recommendations or techniques herein is a customer‘s responsibility and depends on the customer‘s
ability to evaluate and integrate them into the customer‘s operational environment. This document and the
information contained herein may be used solely in connection with the NetApp products discussed in this
document.
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